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Updated Information

This vSphere Virtual Machine Administration Guide is updated with each release of the product or when necessary.

This table provides the update history of the vSphere Virtual Machine Administration Guide.
Revision Description

EN-000312-03 The topic “Understanding Snapshots,” on page 144 now reflects that VMware does not support snapshots
of virtual machines configured with bus-sharing.

EN-000312-02 The topic “VMware Tools Components,” on page 117 now reflects that you can use the command-line
interface of the VMware Tools configuration utility in the guest operating system to modify VMware Tools
settings, shrink virtual disks, and connect and disconnect virtual devices.

EN-000312-01 n The topic “Setting Up Physical USB Connections on an ESX/ESXi Host,” on page 107 now reflects that
the host treats USB DVD/CD-ROM devices as SCSI devices for which hot adding and removing is not
supported.

n The topic “Add a DVD or CD-ROM Drive to a Virtual Machine,” on page 100 now includes a
prerequisite to verify that the host is powered off before you add USB CD/DVD-ROM devices.

n The topic “Configure a Host Device Type for the DVD/CD-ROM Drive,” on page 99 now includes a
prerequisite to verify that the host is powered off before you add USB CD/DVD-ROM devices.

n The topic “Add USB Devices to an ESX/ESXi Host,” on page 108 now reflects that the host treats USB
DVD/CD-ROM devices as SCSI devices and includes a prerequisite to verify that the host is powered
off before you add these devices.

EN-000312-00 Initial release.

VMware, Inc.  7



vSphere Virtual Machine Administration Guide

8  VMware, Inc.



About This Book

vSphere Virtual Machine Administration Guide describes how to create, configure, and manage virtual machines
in the vSphere environment.

In addition, this manual provides brief introductions to the various tasks you can do within the system as well
as cross-references to the documentation that describes the tasks in detail.

vSphere Virtual Machine Administration Guide covers ESX, ESXi, and vCenter Server.

Intended Audience
The information presented is for experienced Windows or Linux system administrators who are familiar with
virtualization.

VMware Technical Publications Glossary
VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For definitions
of terms as they are used in VMware technical documentation, go to http://www.vmware.com/support/pubs.

Document Feedback
VMware welcomes your suggestions for improving our documentation. If you have comments, send your
feedback to docfeedback@vmware.com.

VMware vSphere Documentation
The vSphere documentation consists of the combined VMware vCenter Server and ESX/ESXi documentation
set.
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Technical Support and Education Resources
The following technical support resources are available to you. To access the current version of this book and
other books, go to http://www.vmware.com/support/pubs.

Online and Telephone
Support

To use online support to submit technical support requests, view your product
and contract information, and register your products, go to 
http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support
for priority 1 issues. Go to 
http://www.vmware.com/support/phone_support.html.

Support Offerings To find out how VMware support offerings can help meet your business needs,
go to http://www.vmware.com/support/services.

VMware Professional
Services

VMware Education Services courses offer extensive hands-on labs, case study
examples, and course materials designed to be used as on-the-job reference
tools. Courses are available onsite, in the classroom, and live online. For onsite
pilot programs and implementation best practices, VMware Consulting
Services provides offerings to help you assess, plan, build, and manage your
virtual environment. To access information about education classes,
certification programs, and consulting services, go to 
http://www.vmware.com/services.
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Introduction to VMware vSphere
Virtual Machines 1

This information introduces the concept of virtual machines and how they function in the infrastructure
environment with vSphere. You will find information about what constitutes a virtual machine and the features
available for managing them.

This chapter includes the following topics:

n “What Is a Virtual Machine?,” on page 11

n “Virtual Machines and the Virtual Infrastructure,” on page 12

n “Virtual Machine Lifecycle,” on page 12

n “Virtual Machine Components,” on page 13

n “Virtual Machine Options and Resources,” on page 13

n “Where to Go From Here,” on page 14

What Is a Virtual Machine?
A virtual machine is a software computer that, like a physical computer, runs an operating system and
applications. The virtual machine is comprised of a set of specification and configuration files and is backed
by the physical resources of a host. Every virtual machine has virtual devices that provide the same
functionality as physical hardware, and have additional benefits in terms of portability, manageability, and
security.

A virtual machine consists of several types of files that you store on a supported storage device. The key files
that make up a virtual machine are the configuration file, virtual disk file, NVRAM setting file, and the log file.
You configure virtual machine settings through the vSphere Client and should not need to touch these files.

Table 1-1 lists the complete set of files that make up a virtual machine. A virtual machine can have more files
if one or more snapshots exist or if you add Raw Device Mappings (RDMs).

CAUTION   Do not change, move, or delete these files without instructions from a VMware Technical Support
Representative.

Table 1-1.  Virtual Machine Files

File Usage Description

.vmx vmname.vmx Virtual machine configuration file

.vmxf vmname.vmxf Additional virtual machine configuration files

.vmdk vmname.vmdk Virtual disk characteristics

-flat.vmdk vmname-flat.vmdk Preallocated virtual disk

.nvram vmname.nvram or nvram Virtual machine BIOS
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Table 1-1.  Virtual Machine Files (Continued)

File Usage Description

.vmsd vmname.vmsd Virtual machine snapshots

.vmsn vmname.vmsn Virtual machine snapshot data file

.vswp vmname.vswp Virtual machine swap file

.vmss vmname.vmss Virtual machine suspend file

.log vmware.log Current virtual machine log file

-#.log vmware-#.log (where # is a number starting
with 1)

Old virtual machine log entries

Virtual Machines and the Virtual Infrastructure
The infrastructure that supports virtual machines consists of at least two software layers, virtualization and
management. In vSphere, ESX/ESXi provides the virtualization capabilities that aggregate and present the host
hardware to virtual machines as a normalized set of resources. Virtual machines can run on an isolated
ESX/ESXi host or on ESX/ESXi hosts that vCenter Server manages.

vCenter Server lets you pool and manage the resources of multiple hosts and lets you effectively monitor and
manage your physical and virtual infrastructure. You can manage resources for virtual machines, provision
virtual machines, schedule tasks, collect statistics logs, create templates, and more. vCenter Server also
provides VMware vMotion, VMware Storage vMotion, VMware Distributed Resources Management (DRS),
VMware HA, and Fault Tolerance. These services enable efficient and automated resource management and
high availability for virtual machines.

The VMware vSphere Client is the interface to vCenter Server, ESX/ESXi hosts, and virtual machines. With the
vSphere Client, you can connect remotely to vCenter Server or ESX/ESXi from any Windows system. The
vSphere Client is the primary interface for managing all aspects of the vSphere environment. It also provides
console access to virtual machines.

The vSphere Client presents the organizational hierarchy of managed objects in inventory views. Inventories
are the hierarchal structure used by vCenter Server or the host to organize managed objects. This hierarchy
includes all of the monitored objects in vCenter Server.

In the vCenter Server hierarchy, a datacenter is the primary container of ESX/ESXi hosts, folders, clusters,
resource pools, vApps, virtual machines, and so on. Datastores are virtual representations of underlying
physical storage resources in the datacenter. A datastore is the storage location (for example, a physical disk
or LUN on a RAID, or a SAN) for virtual machine files. Datastores hide the idiosyncrasies of the underlying
physical storage and present a uniform model for the storage resources required by virtual machines.

Virtual Machine Lifecycle
You create and deploy virtual machines into your datacenter in a variety of ways. You can create a single virtual
machine and install a guest operating system and VMware Tools in it. You can clone or create a template from
an existing virtual machine, convert physical systems to virtual machines, or deploy OVF templates.

The vSphere Client New Virtual Machine wizard and Virtual Machine Properties editor let you add, configure,
or remove most of the virtual machine's hardware, options, and resources. You monitor CPU, memory, disk,
network, and storage metrics using the performance charts in vSphere Client. VMware Snapshots let you
capture the entire state of the virtual machine, including the virtual machine memory, settings, and virtual
disks. You can roll back to the previous virtual machine state when needed.
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With VMware vApp, you can manage multi-tiered applications. You use vCenter Update Manager to perform
orchestrated upgrades to upgrade the virtual hardware and VMware Tools of virtual machines in the inventory
at the same time.

When a virtual machine is no longer needed, you can remove it from the inventory without deleting it from
the datastore, or you can delete the virtual machine and all its files.

Virtual Machine Components
Virtual machines typically have an operating system, VMware Tools, and virtual resources and hardware that
you manage in much the same way as you would manage a physical computer.

You install a guest operating system on a virtual machine essentially the same way as you install an operating
system on a physical computer. You must have a CD/DVD-ROM or ISO image containing the installation files
from an operating system vendor.

VMware Tools is a suite of utilities that enhances the performance of the virtual machine's guest operating
system and improves management of the virtual machine. With VMware Tools, you have much more control
over the virtual machine interface.

All virtual machines have a hardware version. The hardware version indicates virtual hardware features
supported by the virtual machine, such as BIOS, number of virtual slots, maximum number of CPUs, maximum
memory configuration, and other characteristics typical to hardware. The hardware version of a virtual
machine is determined by the version of ESX/ESXi on which the virtual machine is created.

The hardware devices listed in the Virtual Machine Properties editor complete the virtual machine. Not all
devices are configurable. Some hardware devices are part of the virtual motherboard and appear in the
expanded device list of the Virtual Machine Properties editor, but you cannot modify or remove them. For a
complete list of hardware devices and their functions, see “Virtual Machine Hardware, Options, and Resources
Available to vSphere Virtual Machines,” on page 72.

Access to a virtual machine is controlled by the Sphere administrator. For detailed information about Privileges,
see the VMware vSphere Datacenter Administration Guide.

Virtual Machine Options and Resources
Each virtual device performs the same function for the virtual machine as hardware on a physical computer
does.

A virtual machine might be running in any of several locations, such as ESX/ESXi hosts, datacenters, clusters,
or resource pools. Many of the options and resources you configure have dependencies on and relationships
with these objects.

Every virtual machine has CPU, memory, and disk resources. CPU virtualization emphasizes performance
and runs directly on the virtual machine processor whenever possible. The underlying physical resources are
used whenever possible and the virtualization layer runs instructions only as needed to make virtual machines
operate as if they were running directly on a physical machine.

All recent operating systems provide support for virtual memory, allowing software to use more memory than
the machine physically has. Similarly, the ESX/ESXi hypervisor provides support for overcommitting virtual
machine memory, where the amount of guest memory configured for all virtual machines might be larger than
the amount of the host's physical memory.

You can add virtual disks and add more space to existing disks, even when the virtual machine is running.
You can also change the device node and allocate shares of disk bandwidth to the virtual machine.

Chapter 1 Introduction to VMware vSphere Virtual Machines
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VMware virtual machines have the following options:

General Options View or modify the virtual machine name, check the location of the
configuration file and the working location of the virtual machine, or change
the guest operating system type.

vApp Options Enable or disable vApp functionality. When vApp is enabled, you can select
an IP allocation policy and other configurations particular to vApps.

VMware Tools Manage the power controls for the virtual machine and run VMware Tools
scripts. You can also upgrade VMware Tools during power cycling and
synchronize guest time with the host.

General Advanced
Options

Disable acceleration and enable logging, debugging, and statistics. Add
configuration parameters.

Power Management Manage guest power options. Suspend the virtual machine or leave the virtual
machine powered on when you put the guest operating system into standby.

CPUID Mask Hide or expose the NX/XD flag. Hiding the NX/XD flag increases vMotion
compatibility between hosts.

Memory/CPU Hotplug Disable or enable CPU and memory hotplug. You can disable Memory or CPU
hotplug if you do not want to add memory or processors accidentally while
the virtual machine is running.

Boot Options Set the boot delay when powering on virtual machines or to force BIOS setup
and configure failed boot recovery.

Fibre Channel NPIV Control virtual machine access to LUNs on a per-virtual machine basis. N-port
ID virtualization (NPIV) provides the ability to share a single physical Fibre
Channel HBA port among multiple virtual ports, each with unique identifiers.

Where to Go From Here
You must create, provision, and deploy your virtual machines before you can manage them.

To begin provisioning virtual machines, determine whether to create a single virtual machine and install an
operating system and VMware tools, work with templates and clones, deploy OVF templates, or convert
physical systems to virtual machines.

After you provision and deploy virtual machines into the vSphere infrastructure, you can configure and
manage them. Determine whether you want to configure existing virtual machines by modifying or adding
hardware or install or upgrade VMware Tools. You might need to manage multitiered applications with
VMware vApps or change virtual machine startup and shutdown settings, use snapshots, work with virtual
disks, or add, remove, or delete virtual machines from the inventory.

vSphere Virtual Machine Administration Guide
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Provisioning Virtual Machines
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How to Provision Virtual Machines 2
VMware provides several methods to provision vSphere virtual machines. The optimal method for your
environment depends on factors such as the size and type of your infrastructure and the goals you are trying
to achieve.

Create a single virtual machine if no other virtual machines in your environment have the requirements you
are looking for, such as a particular operating system or hardware configuration. For example, you might need
a virtual machine that is configured only for testing purposes. You can also create a single virtual machine and
install an operating system on it, then use that virtual machine as a template to clone other virtual machines
from. See Chapter 3, “Creating a Virtual Machine,” on page 19.

Deploy and export virtual machines, virtual appliances, and vApps stored in Open Virtual Machine Format
(OVF) to use a preconfigured virtual machine. A virtual appliance is a prebuilt virtual machine that typically
has an operating system and other software already installed. You can deploy virtual machines from local file
systems, such as local disks (such as C:), removable media (such as CDs or USB keychain drives), and shared
network drives. See Chapter 5, “Deploying OVF Templates,” on page 53.

Create a template to deploy multiple virtual machines from. A template is a master copy of a virtual machine
that you can use to create and provision virtual machines. Templates can be a real time saver. If you have a
virtual machine that you want to clone frequently, make that virtual machine a template. See Chapter 4,
“Working with Templates and Clones,” on page 33.

Cloning a virtual machine can save time if you are deploying many similar virtual machines. You can create,
configure, and install software on a single virtual machine and clone it multiple times, rather than creating and
configuring each virtual machine individually. See Chapter 4, “Working with Templates and Clones,” on
page 33.

If you have a smaller IT environment, you can use VMware vCenter Guided Consolidation to convert physical
systems to virtual machines and import them into vSphere. See Chapter 6, “Converting Physical Systems to
Virtual Machines,” on page 57.
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Creating a Virtual Machine 3
Virtual machines are the key component in a virtual infrastructure. You can create a single virtual machine to
add to the vSphere inventory.

When you create a virtual machine, you associate it to a particular datacenter, host, cluster, or resource pool,
and a datastore. After you turn on the virtual machine, it consumes resources dynamically as the workload
increases, or it returns resources dynamically as the workload decreases.

Every virtual machine has virtual devices that provide the same function as physical hardware. A virtual
machine gets CPU and memory, access to storage, and network connectivity from the host it runs on.

This chapter includes the following topics:

n “Start the Virtual Machine Creation Process,” on page 20

n “Select a Configuration Path for the New Virtual Machine,” on page 20

n “Enter a Name and Location for the Virtual Machine,” on page 21

n “Select a Host or Cluster,” on page 21

n “Select a Resource Pool,” on page 22

n “Select a Datastore,” on page 22

n “Select a Virtual Machine Version,” on page 23

n “Select an Operating System,” on page 23

n “Select the Number of Virtual Processors,” on page 24

n “Configure Virtual Memory,” on page 24

n “Configure Networks,” on page 24

n “About VMware Paravirtual SCSI Adapters,” on page 25

n “Select a SCSI Controller,” on page 26

n “Selecting a Virtual Disk Type,” on page 26

n “Complete Virtual Machine Creation,” on page 29

n “Installing a Guest Operating System,” on page 30
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Start the Virtual Machine Creation Process
You use the New Virtual Machine wizard to create a virtual machine to place in the vSphere inventory. You
open the wizard from the vSphere Client.

The selections you make in the New Virtual Machine wizard are not saved until you click Finish on the Ready
to Complete page. If you cancel the wizard without completing all tasks, you cannot resume the wizard where
you left off. You must start a new creation task.

Prerequisites

The vSphere Client must be running.

Procedure

1 Display the inventory objects in the vSphere Client by using the Host and Clusters view or the VM and
Templates view.

2 Right-click one of the following objects:

n Datacenter

n Host

n Cluster

n Resource Pool

n Virtual machine folder

3 Select File > New > Virtual Machine.

The  New Virtual Machine wizard opens.

What to do next

Select a configuration path through the New Virtual Machine wizard.

Select a Configuration Path for the New Virtual Machine
The Typical path shortens the virtual machine creation process by skipping choices that you rarely need to
change from their defaults. The Custom path provides more flexibility and options.

Several relationships effect the information that you must provide during virtual machine creation. These
relationships include the inventory object on which you place the virtual machine, the customization path you
select, the datastore on which the virtual machine and its files reside, and the host or cluster on which it runs.

If you select a Typical configuration, the virtual machine hardware version defaults to that of the host on which
you place the virtual machine. If you select a Custom configuration, you can accept the default or select an
earlier hardware version. This is useful if maintaining compatibility with an earlier version of an ESX/ESXi
host is necessary.

For a Typical configuration, have the following information:

n Virtual machine name and inventory location.

n Location in which to place the virtual machine (cluster, host, resource pool).

n Datastore on which to store the virtual machines files.

n Guest operating system and version.

n Parameters for the virtual disk size and provisioning settings.

vSphere Virtual Machine Administration Guide

20  VMware, Inc.



In addition to the information for a Typical configuration, for a Custom configuration, have the following
information:

n Virtual Machine version.

n Number of CPUs and memory size.

n Number of NICs, network to connect to, and network adapter types.

n SCSI controller type.

n Disk type (new disk, existing disk, RDM, or no disk).

Procedure

1 On the Configuration page of the New Virtual Machine wizard, select a path for creating the virtual
machine.

n Typical

n Custom

2 Click Next.

The Name and Location page appears.

What to do next

Select a name and location for the virtual machine.

Enter a Name and Location for the Virtual Machine
The name you enter is used as the virtual machine’s base name in the inventory. It is also used as the name of
the virtual machine’s files.

The name can be up to 80 characters long. If you are connected to vCenter Server and have folders in your
inventory, names must be unique within the folder. Names are not case-sensitive, so the name my_vm is
identical to My_Vm.

Prerequisites

Verify that you have an appropriate naming strategy in place.

Procedure

1 On the Name and Location page of the New Virtual Machine wizard, type a name.

2 Select a folder or the root of the datacenter.

3 Click Next.

The Host / Cluster or the Resource Pool page opens.

Select a Host or Cluster
You can place the virtual machine on a standalone host or in a cluster.

A cluster is a collection of ESX/ESXi hosts and associated virtual machines with shared resources and a shared
management interface. Grouping hosts into clusters allows you to enable many optional features that enhance
the availability and flexibility of your infrastructure.

Chapter 3 Creating a Virtual Machine
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Procedure

1 On the Host / Cluster page of the New Virtual Machine wizard, select the host or cluster where you want
to run the virtual machine.

2 Click Next.

If resource pools are configured on the host, the Resource Pool page opens. Otherwise, the Datastore page
opens.

What to do next

Select a resource pool or a datastore on which to run the virtual machine.

Select a Resource Pool
Resource pools let you manage your computing resources within a host or cluster by setting them up in a
meaningful hierarchy. Virtual machines and child resource pools share the resources of the parent resource
pool.

The Resource Pool page appears only when resource pools are configured on the host.

Procedure

1 On the Resource Pool page of the New Virtual Machine wizard, navigate to the resource pool where you
want to run the virtual machine.

2 Select the resource pool and click Next.

The virtual machine is placed in the resource pool you selected.

What to do next

Select a datastore in which to store the virtual machine files.

Select a Datastore
Datastores are logical containers that hide specifics of each storage device and provide a uniform model for
storing virtual machine files. You can use datastores to store ISO images, virtual machine templates, and floppy
images.

You can select from datastores already configured on the destination host or cluster.

Procedure

1 On the Datastore page of the New Virtual Machine wizard, select a datastore large enough to hold the
virtual machine and all of its virtual disk files.

2 Click Next.

If you selected a Typical configuration path, the Guest Operating System page appears. If you selected a
Custom configuration path, the Virtual Machine Version page appears.
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Select a Virtual Machine Version
If the host or cluster where you place the virtual machine supports more than one VMware virtual machine
version, you can select a version for the virtual machine.

Procedure

1 On the Virtual Machine Version page of the New Virtual Machine wizard, select a version for the virtual
machine.

Option Description

Virtual machine version 7 Compatible with ESX 4.0 and greater hosts. It provides greater virtual
machine functionality and is recommended for virtual machines that do not
need to migrate to ESX 3.x hosts.

Virtual machine version 4 Compatible with ESX 3.0 and greater hosts. VMware recommends this
option for virtual machines that must run on ESX 3.x hosts and for virtual
machines that must share virtual hard disks with other version 4 virtual
machines.

 
2 Click Next.

The Guest Operating System page opens.

What to do next

Select a guest operating system for the virtual machine.

Select an Operating System
The guest operating system that you select affects the supported devices and number of virtual CPUs available
to the virtual machine.

The New Virtual Machine wizard does not install the guest operating system. The wizard uses this information
to select appropriate default values, such as the amount of memory needed.

Procedure

1 On the Guest Operating System page of the New Virtual Machine wizard, select an operating system
family.

n Microsoft Windows

n Linux

n Novell NetWare

n Solaris

n Other

2 Select an operating system and version from the drop-down menu and click Next.

If you selected a Novell NetWare guest operating system, the Memory page opens. For all other selections,
the CPUs page opens.

What to do next

You can configure CPUs or memory for the virtual machine.

Chapter 3 Creating a Virtual Machine
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Select the Number of Virtual Processors
You can configure a virtual machine to have up to eight virtual processors or CPUs. The number of licensed
CPUs on the host and the number of processors supported by the guest operating system limit the number of
virtual processors that you can create.

VMware Virtual SMP is required to power on multiprocessor virtual machines. The Virtual CPUs page appears
for multiprocessor hosts.

Procedure

1 On the CPUs page of the New Virtual Machine wizard, select the number of virtual processors from the
drop-down menu.

2 Click Next.

The Memory page opens.

What to do next

Select the Memory for the virtual machine.

Configure Virtual Memory
The amount of memory you allocate for a virtual machine is the amount of memory the guest operating system
sees.

Minimum memory size is 4MB. Maximum memory size depends on the host. The memory size must be a
multiple of 4MB. The maximum for best performance represents the threshold above which the host’s physical
memory is insufficient to run the virtual machine at full speed. This value fluctuates as conditions on the host
change, for example, as virtual machines are turned on or off.

Procedure

1 On the Memory page of the New Virtual Machine wizard, select a size in megabytes or gigabytes for the
virtual memory.

You can use the slider or select the number by using the up and down arrows.

2 Click Next.

The Network page opens.

What to do next

Select network adapters for the virtual machine.

Configure Networks
You configure network settings so that the virtual machine can communicate with other hosts and virtual
machines.

CAUTION   Because virtual machines share their physical network hardware with the host, the accidental or
malicious bridging of two networks by a virtual machine can occur. Spanning Tree protocol cannot protect
against these occurrences.

Although hardware version 7 virtual machines support up to ten virtual NICs, during virtual machine creation
you can select only four NICs. You can add more virtual NICs by selecting Edit the virtual machine settings
before completion on the Ready to Complete page of the wizard, or by editing the virtual machine after it is
created.
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Hardware version 4 virtual machines support up to four virtual NICs.

Procedure

1 In the Create Network Connections panel of the Network page, select the number of NICs to connect.

2 For each NIC, select a network and adapter type from the drop-down menus.

3 (Optional) Click Connect at Power On to connect the NIC when the virtual machine is powered on.

4 Click Next.

The SCSI Controller page opens.

What to do next

Select a SCSI Controller for the virtual machine.

About VMware Paravirtual SCSI Adapters
Paravirtual SCSI (PVSCSI) adapters are high performance storage adapters that can result in greater
throughput and lower CPU utilization. PVSCSI adapters are best suited for high performance storage
environments.

PVSCSI adapters are available for virtual machines running hardware version 7 and later. They are supported
on the following guest operating systems:

n Windows Server 2008 R2 (64bit)

n Windows Server 2008 (32bit and 64bit)

n Windows Server 2003 (32bit and 64bit)

n Windows XP (32bit and 64bit)

n Windows Vista (32bit and 64bit)

n Windows 7 (32bit and 64bit)

n Red Hat Linux 5 (32bit and 64bit)

PVSCSI adapters have the following limitations:

n Disks on PVSCSI adapters might not experience performance gains if they have snapshots or if memory
on the ESX host is over committed.

n If you upgrade from RHEL 5 to an unsupported kernel, you might not be able to access data on the disks
attached to a PVSCSI adapter. To regain access to such disks:

a Upgrade the guest kernel but do not restart the guest.

b Run the VMware Tools configuration with the kernel-version parameter and pass the kernel version
within the guest:

vmware-config-tools.pk --kernel-version kernel_version

Run name -r to determine the version of the running kernel.

c Restart the guest.

n MSCS clusters are not supported.

n PVSCSI adapters do not support boot disks (the disk that contains the system software) on Red Hat Linux
5 virtual machines. Attach the boot disk to the virtual machine by using any of the other supported adapter
types.
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Select a SCSI Controller
To access virtual disks, a virtual machine uses virtual SCSI controllers. Each virtual disk that a virtual machine
can access through one of the virtual SCSI controllers resides in the VMware Virtual Machine File System
(VMFS) datastore, NFS-based datastore, or on a raw disk. The choice of SCSI adapter does not affect whether
your virtual disk is an IDE or SCSI disk.

The wizard preselects the correct default controller based on the guest operation system you selected on the
Guest Operating System page.

LSI Logic SAS and VMware Paravirtual controllers are available only for virtual machines with hardware
version 7 or later.

Disks with snapshots might not experience performance gains when used on LSI Logic SAS and LSI Logic
Parallel adapters.

Procedure

1 On the SCSI Controller page of the New Virtual Machine wizard, accept the default or select a SCSI
controller type.

n BusLogic Parallel

n LSI Logic Parallel

n LSI Logic SAS

n VMware Paravirtual

2 Click Next.

The Select a Disk page opens.

What to do next

Select a disk on which to store the guest operating system files and data.

Selecting a Virtual Disk Type
You can create a virtual disk, use an existing virtual disk, or create Raw Device Mappings (RDMs), which give
your virtual disk direct access to SAN. A virtual disk comprises one or more files on the file system that appear
as a single hard disk to the guest operating system. These disks are portable among hosts.

You can add virtual disks to the virtual machine while you create or after you create the virtual machine. To
add disks later, select the Do Not Create Disk option.

You can select from the following options:

n Create a Virtual Disk on page 27
When you create a virtual disk, you can specify disk properties such as size, format, clustering features,
and more.

n Use an Existing Virtual Disk on page 28
You can use an existing disk that is configured with an operating system or other virtual machine data.
This choice allows you to freely move the virtual hard drive from virtual machine to virtual machine.

n Create Raw Device Mappings on page 28
For virtual machines running on an ESX/ESXi host, instead of storing virtual machine data in a virtual
disk file, you can store the data directly on a SAN LUN. This is useful if you are running applications in
your virtual machines that must know the physical characteristics of the storage device. Additionally,
mapping a SAN LUN allows you to use existing SAN commands to manage storage for the disk.

vSphere Virtual Machine Administration Guide

26  VMware, Inc.



Create a Virtual Disk
When you create a virtual disk, you can specify disk properties such as size, format, clustering features, and
more.

Using the default thick virtual disk format does not zero out or eliminate the possibility of recovering deleted
files or restoring old data that might be present on this allocated space. It is not possible to convert a thick disk
to a thin disk.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful to
control the boot order or to have different SCSI controller types. For example, you might want to boot off an
LSI Logic controller and share a data disk with another virtual machine using a BusLogic controller with bus
sharing turned on.

Procedure

1 On the Create a Disk page of the New Virtual Machine wizard, select the disk size in Megabytes, Gigabytes,
or Terabytes.

You can increase the disk size later or add disks in the Virtual Machine Properties dialog box.

2 (Optional) Select a disk allocation in the Disk Provisioning panel.

Option Description

Allocate and commit space on
demand (Thin Provisioning)

Creates a disk in thin format.

Support clustering features such as
Fault Tolerance

Supports the use of clustering features.

 
3 Select a location to store the virtual disk files and click Next.

Option Description

Store with the virtual machine The files are stored with the configuration and other virtual machine files.
This choice makes file management easier.

Specify a datastore Stores the file separately from other virtual machine files.
 
The Advanced Options page opens.

4 Accept the default or select a different virtual device node.

5 (Optional) Select the virtual disk Independent mode and select an option.

Option Description

Persistent The disk operates normally except that changes to the disk are permanent
even if the virtual machine is reverted to a snapshot.

Nonpersistent The disk appears to operate normally, but whenever the virtual machine is
powered off or reverted to a snapshot, the contents of the disk return to their
original state. All later changes are discarded.

 
Independent disks are not affected by snapshots.

6 Click Next.

Your changes are recorded and the Ready to Complete page opens.

What to do next

View the selections for your virtual machine on the Ready to Complete page.
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Use an Existing Virtual Disk
You can use an existing disk that is configured with an operating system or other virtual machine data. This
choice allows you to freely move the virtual hard drive from virtual machine to virtual machine.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful to
control the boot order or to have different SCSI controller types. For example, you might want to boot off an
LSI Logic controller and share a data disk with another virtual machine using a BusLogic controller with bus
sharing turned on.

In most cases, you can accept the default device node. A nondefault device node for a hard disk is useful to
control the boot order or to have different SCSI controller types. For example, you might want to boot off an
LSI Logic controller and share a data disk with another virtual machine using a Buslogic controller with bus
sharing turned on.

Procedure

1 On the Select Existing Disk page of the New Virtual Machine wizard, browse for a virtual disk file, click
OK, and click Next.

2 Accept the default or select a different virtual device node.

3 (Optional) Select the virtual disk Independent mode and select an option.

Option Description

Persistent The disk operates normally except that changes to the disk are permanent
even if the virtual machine is reverted to a snapshot.

Nonpersistent The disk appears to operate normally, but whenever the virtual machine is
powered off or reverted to a snapshot, the contents of the disk return to their
original state. All later changes are discarded.

 
Independent disks are not affected by snapshots.

4 Click Next.

Your changes are recorded and the Ready to Complete page opens.

What to do next

Review the virtual machine configuration.

Create Raw Device Mappings
For virtual machines running on an ESX/ESXi host, instead of storing virtual machine data in a virtual disk
file, you can store the data directly on a SAN LUN. This is useful if you are running applications in your virtual
machines that must know the physical characteristics of the storage device. Additionally, mapping a SAN LUN
allows you to use existing SAN commands to manage storage for the disk.

When you map a LUN to a VMFS volume, vCenter Server creates a Raw Device Mapping (RDM) file that
points to the raw LUN. Encapsulating disk information in a file allows vCenter Server to lock the LUN so that
only one virtual machine can write to it at a time. For details about RDM, see the ESX Configuration Guide or
ESXi Configuration Guide.

The RDM file has a .vmdk extension, but the file contains only disk information that describes the mapping to
the LUN on the ESX/ESXi host. The actual data is stored on the LUN.
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In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful to
control the boot order or to have different SCSI controller types. For example, you might want to boot off an
LSI Logic controller and share a data disk with another virtual machine using a Buslogic controller with bus
sharing turned on.

NOTE   You cannot deploy a virtual machine from a template and store its data on a LUN. You can only store
its data in a virtual disk file.

Procedure

1 Select a target LUN and click Next.

2 Select the datastore on which to store the LUN mapping file.

n Store with the virtual machine files

n Specify datastore

3 Click Next.

The Select Compatibility Mode page opens.

4 Select a compatibility mode and click Next.

Option Description

Physical Allows the guest operating system to access the hardware directly. Taking a
snapshot of this virtual machine will not include this disk.

Virtual Allows the virtual machine to use VMware snapshot and other advanced
functionality.

 
5 Accept the default virtual device node or select a different node.

6 (Optional) Select the virtual disk Independent mode and select an option.

Option Description

Persistent The disk operates normally except that changes to the disk are permanent
even if the virtual machine is reverted to a snapshot.

Nonpersistent The disk appears to operate normally, but whenever the virtual machine is
powered off or reverted to a snapshot, the content of the disk returns to its
original state. All later changes are discarded.

 
Independent disks are not affected by snapshots.

7 Click Next.

Your changes are recorded and the Ready to Complete page opens.

What to do next

Review the virtual machine configuration.

Complete Virtual Machine Creation
The Ready to Complete page lets you review the configuration selections that you made for the virtual machine.
You can change existing settings, configure resources, add hardware, and more.

You can configure additional virtual machine settings before or after completing the wizard.
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Procedure

1 On the Ready to Complete page of the New Virtual Machine wizard, review the configuration settings for
the virtual machine.

2 (Optional) Select Edit the virtual machine settings before completion and click Continue.

The Virtual Machine Properties editor opens. After you complete your changes and click Finish, both the
Virtual Machine Properties editor and the New Virtual Machine wizard close. You cannot go back to
review the wizard settings unless you click Cancel.

3 (Optional) Click Cancel to go back and review the wizard settings.

4 Click Finish to complete the creation task and close the wizard.

The virtual machine appears in the vSphere Client Inventory view.

What to do next

Before you can use the new virtual machine, you must partition and format the virtual drive, install a guest
operating system, and install VMware Tools. Typically, the operating system’s installation program handles
partitioning and formatting the virtual drive.

Installing a Guest Operating System
A virtual machine is not complete until you install the guest operating system and VMware Tools. Installing
a guest operating system in your virtual machine is essentially the same as installing it in a physical computer.

The basic steps for a typical operating system are described in this section. See the Guest Operating System
Installation Guide for more information about individual guest operating systems.

Using PXE with Virtual Machines
You can start a virtual machine from a network device and remotely install a guest operating system using a
Preboot Execution Environment (PXE).

PXE booting is supported for Guest Operating Systems that are listed in the VMware Guest Operating System
Compatibility list and whose operating system vendor supports PXE booting of the operating system.

The virtual machine must meet the following requirements:

n Have a virtual disk without operating system software and with enough free disk space to store the
intended system software.

n Have a network adapter connected to the network where the PXE server resides.

For details about guest operating system installation, see the Guest Operating System Installation Guide.

Install a Guest Operating System from Media
You can install a guest operating system from a CD-ROM or from an ISO image. Installing from an ISO image
is typically faster and more convenient than a CD-ROM installation.

It might be necessary to change the boot order in the virtual machine’s BIOS settings. However, sometimes a
virtual machine’s boot sequence progresses too quickly for a user to open a console to the virtual machine and
enter BIOS setup. If this happens, select Boot Options on the Options tab of the Virtual Machine Properties
dialog box, and select The next time the virtual machine boots, force entry into the BIOS setup screen. The
virtual machine enters the BIOS setup the next time it starts.
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Prerequisites

n Verify that the installation ISO image is present on a VMFS datastore or network file system (NFS) volume
accessible to the ESX/ESXI host.

n Verify that you have the installation instructions provided by the operating system vendor.

Procedure

1 Open the vSphere Client and log into the vCenter Server system or host on which the virtual machine
resides.

2 Select an installation method.

Option Action

CD-ROM Insert the installation CD-ROM for your guest operating system into the CD-
ROM drive of your ESX/ESXi host.

ISO image a Right-click the virtual machine in the inventory list and select Edit
Settings.

b Click the Hardware tab and select CD/DVD Drive.
c In the Device Type panel, select Datastore ISO File and browse for the

ISO image for your guest operating system.
 

3 Right-click the virtual machine and select Power > Power On.

A green right arrow appears next to the virtual machine icon in the inventory list.

4 Follow the installation instructions provided by the operating system vendor.

What to do next

Install VMware Tools.
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Working with Templates and Clones 4
A clone is a copy of a virtual machine. A template is a master copy of a virtual machine that can be used to
create many clones.

When you clone a virtual machine, you create a copy of the entire virtual machine, including its settings, any
configured virtual devices, installed software, and other contents of the virtual machine's disks. You also have
the option to use guest operating system customization to change some of the properties of the clone, such as
the computer name and networking settings.

Cloning a virtual machine can save time if you are deploying many similar virtual machines. You can create,
configure, and install software on a single virtual machine, and then clone it multiple times, rather than creating
and configuring each virtual machine individually.

If you create a virtual machine that you want to clone frequently, make that virtual machine a template. A
template is a master copy of a virtual machine that can be used to create and provision virtual machines.
Templates cannot be powered on or edited, and are more difficult to alter than ordinary virtual machine. A
template offers a more secure way of preserving a virtual machine configuration that you want to deploy many
times.

When you clone a virtual machine or deploy a virtual machine from a template, the resulting cloned virtual
machine is independent of the original virtual machine or template. Changes to the original virtual machine
or template are not reflected in the cloned virtual machine, and changes to the cloned virtual machine are not
reflected in the original virtual machine or template.

This chapter includes the following topics:

n “Clone a Virtual Machine,” on page 34

n “Create a Scheduled Task to Clone a Virtual Machine,” on page 35

n “Create a Template,” on page 36

n “Deploy a Virtual Machine from a Template,” on page 38

n “Change Template Software or Virtual Machine Configuration,” on page 40

n “Change Template Name,” on page 40

n “Deleting Templates,” on page 40

n “Convert a Template to a Virtual Machine,” on page 42

n “Customizing Guest Operating Systems,” on page 42
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Clone a Virtual Machine
Cloning a virtual machine creates a duplicate of the virtual machine with the same configuration and installed
software as the original.

Optionally, you can customize the guest operating system of the clone to change the virtual machine name,
network settings, and other properties. This prevents conflicts that can occur if a virtual machine and a clone
with identical guest operating system settings are deployed simultaneously.

Prerequisites

n You must be connected to vCenter Server in order to clone a virtual machine. You cannot clone virtual
machines if you connect directly to an ESX/ESXi host.

n To customize the guest operating system of the virtual machine, check that your guest operating system
meets the requirements for customization. See “Guest Operating System Customization Requirements,”
on page 42.

n To use a customization specification, you must first create or import the customization specification.

n To use a custom script to generate the host name or IP address for the new virtual machine, configure the
script. See “Configure a Script to Generate Computer Names and IP Addresses During Guest Operating
System Customization,” on page 43.

Procedure

1 Right-click the virtual machine and select Clone.

2 Enter a virtual machine name, select a location, and click Next.

3 Select a host or cluster on which to run the new virtual machine.

Option Description

Run the virtual machine on a
standalone host.

Select the host and click Next.

Run the virtual machine in a cluster
with DRS automatic placement.

Select the cluster and click Next.

Run the virtual machine in a cluster
without DRS automatic placement.

a Select the cluster and click Next.
b Select a host within the cluster and click Next.

 
4 Select a resource pool in which to run the clone and click Next.

5 Select the datastore location where you want to store the virtual machine files and click Next.

Option Description

Store all virtual machine files in the
same location.

Select a datastore and click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, select

a datastore from the drop-down list.
c Click Next.
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6 Select the format for the virtual machine's disks and click Next.

Option Description

Same format as source Use the same format as the source virtual machine.

Thin provisioned format Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.
Only VMFS datastore version 3 and later support virtual disks in the thin
provisioned format.

Thick format The thick virtual disk does not change its size and from the very beginning
occupies the entire datastore space provisioned to it.

 
7 Select a guest operating system customization option.

Option Description

Do not customize Select Do not customize and click Next.
Does not customize any of the guest operating system settings. All settings
remain identical to those of the source virtual machine.

Customize using the Customization
Wizard

Opens the Customization Wizard so that you can select customization
options for the guest operating system.
Select this option and click Next to launch the Customization Wizard.
n To customize a Linux guest operating system, see “Customize Linux

During Cloning or Deployment,” on page 46.
n To customize a Windows guest operating system, see “Customize

Windows During Cloning or Deployment,” on page 44.

Customize using an existing
customization specification

Uses the settings in a saved customization specification to customize the
guest operating system.
a Select Customize using an existing customization specification.
b Select the customization specification that you want to use.
c (Optional) Select Use the Customization Wizard to temporarily adjust

the specification before deployment if you want to make changes to the
specification for this deployment only.

d Click Next.
 

8 Review your selections, and select whether to power on or edit the virtual machine.

Option Description

Power on this virtual machine after
creation

Select this option and click Finish.
The virtual machine powers on after the deployment task completes.

Edit virtual hardware a Select Edit virtual hardware and click Continue.
b In the Virtual Machine Properties dialog box, make any changes that you

want to make and click OK.
 

The cloned virtual machine is deployed. You cannot use or edit the virtual machine until the cloning is
complete. This might take several minutes if the cloning involves creating a virtual disk. You can cancel the
cloning at any point before the customization stage.

Create a Scheduled Task to Clone a Virtual Machine
This procedure creates a scheduled task to clone a virtual machine.

Procedure

1 Start the vSphere client, and log in to the vCenter Server system.

2 From the Home page, click Scheduled Tasks.
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3 Select File > New > Scheduled Task, or click New.

The Select a Task to Schedule dialog box appears.

4 Select Clone a virtual machine from the drop-down menu, and click OK.

The Clone Virtual Machine wizard appears.

5 Select the virtual machine to clone and click Next.

6 Follow the wizard through the same steps as those in the previous task in which you cloned a virtual
machine.

7 Enter a name and a task description in the text box.

8 Select the frequency of the task.

9 Select Now or Later. If later, enter the time and date when you want the virtual machine to be deployed,
and click Next.

To see the calendar, click Later, and click the drop-down arrow to select a date from the calendar. A red
circle indicates today’s date, and a dark circle indicates the scheduled date.

10 Review the information on the Ready to Complete New Virtual Machine page, and click Finish.

Optionally, you can select the check box to power on the new virtual machine after it is created.

vCenter Server adds the new task to the scheduled task list and completes it at the designated time. When
it is time to perform the task, vCenter Server first verifies that the user who created the task still has
permission to complete the task. If the permission levels are not acceptable, vCenter Server sends a
message to the log and the task is not performed.

Create a Template
Create a template to create a master image of a virtual machine from which you can deploy many virtual
machines.

You can create a template by converting a virtual machine to a template, cloning a virtual machine to a template,
or cloning another template.

Convert a Virtual Machine to a Template
You can convert a virtual machine directly to a template instead of making a copy by cloning.

When you convert a virtual machine to a template, you cannot edit or power on the template unless you convert
it back to a virtual machine.

Prerequisites

n You must be connected to vCenter Server to convert a virtual machine to a template. You cannot create
templates if you connect the vSphere Client directly to an ESX/ESXi host.

n Before you convert a virtual machine to a template, select it in the inventory and power it off.

Procedure

u Right-click the virtual machine and select Template > Convert to Template.

vCenter Server marks that virtual machine as a template and displays the task in the Recent Tasks pane.
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Clone Virtual Machine to Template
Cloning a virtual machine to a template creates a template copy of the virtual machine while leaving the original
virtual machine in place.

Prerequisites

You must be connected to vCenter Server to clone a virtual machine to a template. You cannot create templates
if you connect directly to an ESX/ESXi host.

Procedure

1 Right-click the virtual machine and select Template > Clone to Template.

2 Give the new template a name, select its inventory location, and click Next.

3 Pass through the target location page and click Next.

4 Specify in which format to store the template’s virtual disks and click Next.

Option Description

Same format as source Use the same format as the source virtual machine.

Thin provisioned format Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.
Only VMFS datastore version 3 and later support virtual disks in the thin
provisioned format.

Thick format The thick virtual disk does not change its size and from the very beginning
occupies the entire datastore space provisioned to it.

 
5 Click Finish.

vCenter Server displays the Tasks inventory panel for reference and adds the cloned template to the list
in the information panel.

Clone a Template
Clone a template to create a copy of it.

Prerequisites

You must be connected to vCenter Server to clone a template. You cannot create templates if you connect
directly to an ESX/ESXi host.

Procedure

1 Right-click the template and select Clone.

2 Give the new template a unique name and description and click Next.

3 Select the host or cluster and click Next.

4 Select a datastore for the template and click Next.
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5 Specify in which format to store the template’s virtual disks.

Option Description

Same format as source Use the same format as the source virtual machine.

Thin provisioned format Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.
Only VMFS datastore version 3 and later support virtual disks in the thin
provisioned format.

Thick format The thick virtual disk does not change its size and from the very beginning
occupies the entire datastore space provisioned to it.

 
6 Click Next.

7 Review the information for the template and click Finish.

You cannot use the new template until the cloning task completes.

vCenter Server adds the cloned template to the list in the Virtual Machines tab.

Deploy a Virtual Machine from a Template
Deploying a virtual machine from a template creates a new virtual machine that is a copy of the template. The
new virtual machine has the virtual hardware, installed software, and other properties configured for the
template.

Prerequisites

n You must be connected to vCenter Server to deploy a virtual machine from a template. You cannot deploy
from a template if you connect the vSphere Client directly to an ESX/ESXi host.

n To customize the guest operating system of the virtual machine, check that your guest operating system
meets the requirements for customization. See “Guest Operating System Customization Requirements,”
on page 42.

n To use a customization specification, you must first create or import the customization specification.

n To use a custom script to generate the host name or IP address for the new virtual machine, configure the
script. See “Configure a Script to Generate Computer Names and IP Addresses During Guest Operating
System Customization,” on page 43.

Procedure

1 Right-click the template, and select Deploy Virtual Machine from this Template.

2 Enter a virtual machine name, select a location, and click Next.

3 Select a host or cluster on which to run the new virtual machine.

Option Description

Run the virtual machine on a
standalone host.

Select the host and click Next.

Run the virtual machine in a cluster
with DRS automatic placement.

Select the cluster and click Next.

Run the virtual machine in a cluster
without DRS automatic placement.

a Select the cluster and click Next.
b Select a host within the cluster and click Next.

 
4 Select a resource pool in which to run the clone and click Next.
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5 Select the datastore location where you want to store the virtual machine files and click Next.

Option Description

Store all virtual machine files in the
same location.

Select a datastore and click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, select

a datastore from the drop-down list.
c Click Next.

 
6 Select the format for the virtual machine's disks and click Next.

Option Description

Same format as source Use the same format as the source virtual machine.

Thin provisioned format Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.
Only VMFS datastore version 3 and later support virtual disks in the thin
provisioned format.

Thick format The thick virtual disk does not change its size and from the very beginning
occupies the entire datastore space provisioned to it.

 
7 Select a guest operating system customization option.

Option Description

Do not customize Select Do not customize and click Next.
Does not customize any of the guest operating system settings. All settings
remain identical to those of the source virtual machine.

Customize using the Customization
Wizard

Opens the Customization Wizard so that you can select customization
options for the guest operating system.
Select this option and click Next to launch the Customization Wizard.
n To customize a Linux guest operating system, see “Customize Linux

During Cloning or Deployment,” on page 46.
n To customize a Windows guest operating system, see “Customize

Windows During Cloning or Deployment,” on page 44.

Customize using an existing
customization specification

Uses the settings in a saved customization specification to customize the
guest operating system.
a Select Customize using an existing customization specification.
b Select the customization specification that you want to use.
c (Optional) Select Use the Customization Wizard to temporarily adjust

the specification before deployment if you want to make changes to the
specification for this deployment only.

d Click Next.
 

8 Review your selections, and select whether to power on or edit the virtual machine.

Option Description

Power on this virtual machine after
creation

Select this option and click Finish.
The virtual machine powers on after the deployment task completes.

Edit virtual hardware a Select Edit virtual hardware and click Continue.
b In the Virtual Machine Properties dialog box, make any changes that you

want to make and click OK.
 

The virtual machine is deployed. You cannot use or edit the virtual machine until the deployment is complete.
This might take several minutes if the deployment involves creating a virtual disk.
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Change Template Software or Virtual Machine Configuration
To change the virtual hardware or virtual machine options in a template, or to upgrade an application, you
must convert the template to a virtual machine. After you have edited the virtual machine, convert it back to
a template.

Prerequisites

You must be connected to vCenter Server to edit a template. You cannot work with templates if you connect
the vSphere Client directly to an ESX/ESXi host.

Procedure

1 Convert the template to a virtual machine.

2 Edit the virtual machine.

3 Convert the virtual machine to a template.

Change Template Name
Unlike other changes to templates, you do not have to convert a template to a virtual machine to change the
name of a template.

Prerequisites

You must be connected to vCenter Server to edit a template. You cannot work with templates if you connect
the vSphere Client directly to an ESX/ESXi host.

Procedure

1 Right-click the template and select Rename.

2 Enter a new name and click outside the field to save your changes.

Deleting Templates
You can delete a template by removing it from the inventory or deleting the template from the disk. If you
remove the template from the inventory, it remains on the disk and can be reregistered with vCenter Server
to restore it to the inventory.

n Remove Templates from the Inventory on page 41
If you remove a template from the inventory, it is unregistered from the vCenter Server inventory, but
it is not removed from the datastore.

n Delete a Template from the Disk on page 41
Deleted templates are permanently removed from the system.

n Reregister Templates on page 41
Templates can become unregistered from the vCenter Server if they are removed from the inventory or
if the hosts with which they are associated are removed from the vCenter Server and then readded.
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Remove Templates from the Inventory
If you remove a template from the inventory, it is unregistered from the vCenter Server inventory, but it is not
removed from the datastore.

Prerequisites

You must be connected to vCenter Server to remove a template from the inventory. You cannot work with
templates if you connect directly to an ESX/ESXi host.

Procedure

1 Right-click the template, and select Remove from Inventory.

2 Click OK to confirm removing the template from the vCenter Server database.

The template is unregistered from the vCenter Server inventory.

Delete a Template from the Disk
Deleted templates are permanently removed from the system.

Prerequisites

You must be connected to vCenter Server to delete a template. You cannot work with templates if you connect
the vSphere Client directly to an ESX/ESXi host.

Procedure

1 Right-click the template, and select Delete from Disk.

2 Click OK to confirm removing the template from the datastore.

The template is deleted from the disk and cannot be recovered.

Reregister Templates
Templates can become unregistered from the vCenter Server if they are removed from the inventory or if the
hosts with which they are associated are removed from the vCenter Server and then readded.

Procedure

1 Start the vSphere client, and log in to the vCenter Server system.

2 From the Home page, click VMs and Templates.

3 Right-click the datastore that contains the template and select Browse Datastore.

4 Browse through the datastore folders to find the .vmtx file.

5 Right-click the .vmtx file and select Add to Inventory.

The Add to Inventory wizard appears.

6 Enter a template machine name, select a location, and click Next.

If you want the template to retain its original name, do not enter a name in the Add to Inventory wizard.
vCenter Server will use the original name if the field in the wizard is left blank.

7 Select a host or cluster on which to store the template, and click Next.

8 Review your selections, and click Finish.

The template is registered to the host. You can view the template from the host’s Virtual Machine tab.
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Convert a Template to a Virtual Machine
Converting a template to a virtual machine changes the template rather than makinga copy. You can convert
a template to a virtual machine to edit the template. You might also convert a template to a virtual machine if
you no longer need to preserve it as a master image for deploying virtual machines.

Prerequisites

You must be connected to vCenter Server to convert a template to a virtual machine. You cannot work with
templates if you connect directly to an ESX/ESXi host.

Procedure

1 Right-click the template and select Convert to Virtual Machine.

2 Select the host or cluster on which to run the virtual machine.

Option Description

Run the virtual machine on a
standalone host.

Select the host and click Next.

Run the virtual machine in a cluster
with DRS automatic placement.

Select the cluster and click Next.

Run the virtual machine in a cluster
without DRS automatic placement.

a Select the cluster and click Next.
b Select a host within the cluster and click Next.

 
If the template resides on a legacy VMFS2 datastore, you must select the host on which the template was
created as the destination for the virtual machine.

3 Select a resource pool in which to run the clone and click Next.

4 Review your selections and click Finish.

Customizing Guest Operating Systems
When you clone a virtual machine or deploy a virtual machine from a template, you can customize the guest
operating system of the virtual machine to change properties such as the computer name, network settings,
and license settings.

Customizing guest operating systems can help prevent conflicts that can result if virtual machines with
identical settings are deployed, such as conflicts due to duplicate computer names.

You can specify the customization settings by choosing to launch the Guest Customization wizard during the
cloning or deployment process. Alternatively, you can create customization specifications, which are
customization settings stored in the vCenter Server database. During the cloning or deployment process, you
can select a customization specification to apply to the new virtual machine.

Use the Customization Specification Manager to manage customization specifications you create with the
Guest Customization wizard.

Guest Operating System Customization Requirements
Guest operating system customization is supported only if a number of requirements are met.

VMware Tools Requirements
The most current version of VMware Tools must be installed on the virtual machine or template to customize
the guest operating system during cloning or deployment.
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Virtual Disk Requirements
The guest operating system being customized must be installed on a disk attached as SCSI node 0:0 in the
virtual machine configuration.

Virtual machines that reside on hosts running ESX Server 3.0.x or earlier have additional disk requirements:

n On a Windows guest operating system, the active partition (the partition containing boot.ini) and the
system partition (the partition containing the system directory, for example, \WINNT or WINDOWS) must be
on the same virtual disk. The active partition and the system partition do not need to be the same partition.

n On a Linux guest operating system, the virtual disk containing the system partition (the partition
containing the /etc directory) must reside on the SCSI 0:0 node.

Windows Requirements
Customization of Windows guest operating systems requires the following conditions:

n Microsoft Sysprep tools must be installed on the vCenter Server system. See Appendix A, “Installing the
Microsoft Sysprep Tools,” on page 153.

n The ESX/ESXi host that the virtual machine is running on must be 3.5 or later.

Guest operating system customization is supported on multiple Windows operating systems. To verify
customization support for Windows operating systems and compatible ESX/ESXi hosts, see VMware vSphere
Compatibility Matrixes.

Linux Requirements
Customization of Linux guest operating systems requires the following conditions:

n Perl must be installed in the Linux guest operating system.

n The clone or template must have a root volume formatted with an ext2, ext3, or ReiserFS file system.

Guest operating system customization is supported on multiple Linux distributions. To verify customization
support for Linux distributions and compatible ESX/ESXi hosts, see VMware vSphere Compatibility Matrixes.

Configure a Script to Generate Computer Names and IP Addresses During Guest
Operating System Customization

As an alternative to specifying the computer name or IP addresses for virtual NICs during customization, you
can create a script to generate these items.

The script is executed by the Windows command-line script host (cscript.exe). The script can be written in
any compatible scripting language, including JScript or VBScript. See the Microsoft documentation for
cscript.exe for more information on writing scripts.

Procedure

1 Create the script and save it on the vCenter Server system's local disk.

2 In the vSphere Client connected to vCenter Server, select Administration > vCenter Server Settings.

3 Select Advanced Settings.

Chapter 4 Working with Templates and Clones

VMware, Inc.  43



4 Specify the configuration parameters for the script.

a In the Key text box, type config.guestcust.name-ip-generator.arg1.

b In the Value text box, type //nologo and click Add.

c In the Key text box, type config.guestcust.name-ip-generator.arg2.

d In the Value text box, type the path to the script file on the vCenter Server system and click Add.

e In the Key text box, type config.guestcust.name-ip-generator.program.

f In the Value text box, type cscript and click Add.

5 Click OK.

You can now select the option to use an application to generate computer names or IP addresses during
customization.

Customize Windows During Cloning or Deployment
In the process of deploying a new virtual machine from a template or cloning an existing virtual machine, you
can customize Windows guest operating systems for the virtual machine.

Prerequisites

Ensure that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 42.

To perform this procedure, launch the Customization wizard when cloning a virtual machine or deploying
from a template. See “Clone a Virtual Machine,” on page 34 or “Deploy a Virtual Machine from a
Template,” on page 38.

Procedure

1 Type the virtual machine owner’s name and organization and click Next.

2 Specify how to determine the guest operating system's computer name and click Next.

The operating system uses this name to identify itself on the network. On Linux systems, it is called the
host name.

Option Description

Use a specific name a Type a name.

The name can contain alphanumeric characters and the hyphen (-)
character. It cannot contain periods (.) or blank spaces and cannot be
made up of digits only. Names are case-insensitive.

b (Optional) To ensure that the name is unique, select Append a numeric
value to ensure uniqueness. This appends a hyphen followed by a
numeric value to the virtual machine name.

Use the virtual machine’s name The computer name that vCenter Server creates is identical to the name of
the virtual machine on which the guest operating system is running.

Prompt the user for a name in the
Deploy wizard

The vSphere Client prompts you to enter a name after the cloning or
deployment is complete.

Use a custom application configured
with vCenter Server to generate a
name

Enter a parameter that can be passed to the custom application.
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3 Provide licensing information for the Windows operating system and click Next.

Option Description

For non-server operating systems Type the Windows product key for the new guest operating system.

For server operating systems a Type the Windows product key for the new guest operating system.
b Select Include Server License Information.
c Select either Per seat or Per server.
d (Optional) If you selected Per server, enter the maximum number of

simultaneous connections you want the server to accept.
 

4 Configure the administrator password for the virtual machine and click Next.

a Type a password for the administrator account, and confirm the password by typing it again.

NOTE   You can change the administrator password only if the administrator password on the source
Windows virtual machine is blank. If the source Windows virtual machine or template already has a
password, the administrator password does not change.

b (Optional) To log users into the guest operating system as Administrator, select the check box, and
select the number of times to log in automatically.

5 Select the time zone for the virtual machine and click Next.

6 (Optional) On the Run Once page, specify commands to be run the first time a user logs into the guest
operating system and click Next.

See the Microsoft Sysprep documentation for more information on Run Once commands.

7 Select the type of network settings to apply to the guest operating system.

Option Description

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click ....
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
8 Select how the virtual machine will participate in the network and click Next.

Option Description

Workgroup Type a workgroup name. (For example, MSHOME)

Windows Server Domain a Type the domain name.
b Type the user name and password for a user account that has permission

to add a computer to the specified domain.
 

9 (Optional) Select Generate New Security ID (SID) and click Next.

A Windows Security ID (SID) is used in some Windows operating systems to uniquely identify systems
and users. If you do not select this option, the new virtual machine has the same SID as the virtual machine
or template from which it was cloned or deployed.

Duplicate SIDs do not cause problems when the computers are part of a domain and only domain user
accounts are used. However, if the computers are part of a Workgroup or local user accounts are used,
duplicate SIDs can compromise file access controls. For more information, see the documentation for your
Microsoft Windows operating system.
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10 (Optional) Save the customized options as an .xml file:

a Select Save this customization specification for later use.

b Specify the filename for the specification and click Next.

11 Click Finish to save your changes and exit the Guest Customization wizard.

You return to the Deploy Template or Clone Virtual Machine wizard. The customization is carried out after
you complete the Deploy Template or Clone Virtual Machine wizard.

When the new virtual machine boots for the first time, the guest operating system runs finalization scripts to
complete the customization process. The virtual machine might reboot a number of times during this process.

If the guest operating system pauses when the new virtual machine boots, it might be waiting for you to correct
errors, such as an incorrect product key or invalid user name. Open the virtual machine’s console to determine
whether the system is waiting for information.

What to do next

After deploying and customizing non-volume-licensed versions of Windows XP or Windows 2003, you might
need to reactivate your operating system on the new machine.

If the new virtual machine encounters customization errors while it is booting, the errors are logged to %WINDIR
%\temp\vmware-imc. To view the error log, click the Windows Start button and select Programs >
Administrative Tools > Event Viewer.

Customize Linux During Cloning or Deployment
In the process of deploying a new virtual machine from a template or cloning an existing virtual machine, you
can customize Linux guest operating systems for the virtual machine.

Prerequisites

Ensure that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 42.

To perform this procedure, launch the Customization wizard when cloning a virtual machine or deploying
from a template. See “Clone a Virtual Machine,” on page 34 or “Deploy a Virtual Machine from a
Template,” on page 38.

Procedure

1 Specify how to determine the host name to identify the guest operating system on the network.

Option Description

Use a specific name a Type a name.

The name can contain alphanumeric characters and the hyphen (-)
character. It cannot contain periods (.) or blank spaces and cannot be
made up of digits only. Names are case-insensitive.

b (Optional) To ensure that the name is unique, select Append a numeric
value to ensure uniqueness. This appends a hyphen followed by a
numeric value to the virtual machine name.

Use the virtual machine’s name The computer name that vCenter Server creates is identical to the name of
the virtual machine on which the guest operating system is running.

Prompt the user for a name in the
Deploy wizard

The vSphere Client prompts you to enter a name after the cloning or
deployment is complete.

Use a custom application configured
with vCenter Server to generate a
name

Enter a parameter that can be passed to the custom application.

 
2 Enter the Domain Name for the computer and click Next.
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3 Select the time zone for the virtual machine and click Next.

4 Select the type of network settings to apply to the guest operating system.

Option Description

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click ....
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
5 Enter DNS and domain settings.

6 (Optional) Save the customized options as an .xml file:

a Select Save this customization specification for later use.

b Specify the filename for the specification and click Next.

7 Click Finish to save your changes.

You return to the Deploy Template or Clone Virtual Machine wizard. The customization is carried out after
you complete the Deploy Template or Clone Virtual Machine wizard.

When the new virtual machine boots for the first time, the guest operating system runs finalization scripts to
complete the customization process. The virtual machine might reboot a number of times during this process.

If the guest operating system pauses when the new virtual machine boots, it might be waiting for you to correct
errors, such as an incorrect product key or invalid user name. Open the virtual machine’s console to determine
whether the system is waiting for information.

What to do next

If the new virtual machine encounters customization errors while it is booting, the errors are reported using
the guest’s system logging mechanism. View the errors by opening /var/log/vmware-
imc/toolsDeployPkg.log.

Managing Customization Specifications
Customization specifications are XML files that contain guest operating system settings for virtual machines.
You create customization specifications with the Guest Customization wizard, and manage specifications
using the Customization Specification Manager.

vCenter Server saves the customized configuration parameters in the vCenter Server database. If the
customization settings are saved, the administrator, and domain administrator, passwords are stored in
encrypted format in the database. Because the certificate used to encrypt the passwords is unique to each
vCenter Server system, reinstalling vCenter Server, or attaching a new instance of the server the database,
invalidates the encrypted passwords. The passwords must be re-entered before they can be used.

Create a Customization Specification for Linux
Use the Guest Customization wizard to save guest operating system settings in a specification that you can
apply when cloning virtual machines or deploying from templates.

Prerequisites

Ensure that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 42.
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Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Click New.

3 Select Linux from the Target Virtual Machine OS menu.

4 Under Customization Specification Information, enter a name for the specification and an optional
description and click Next.

5 Specify how to determine the host name to identify the guest operating system on the network.

Option Description

Use a specific name a Type a name.

The name can contain alphanumeric characters and the hyphen (-)
character. It cannot contain periods (.) or blank spaces and cannot be
made up of digits only. Names are case-insensitive.

b (Optional) To ensure that the name is unique, select Append a numeric
value to ensure uniqueness. This appends a hyphen followed by a
numeric value to the virtual machine name.

Use the virtual machine’s name The computer name that vCenter Server creates is identical to the name of
the virtual machine on which the guest operating system is running.

Prompt the user for a name in the
Deploy wizard

The vSphere Client prompts you to enter a name after the cloning or
deployment is complete.

Use a custom application configured
with vCenter Server to generate a
name

Enter a parameter that can be passed to the custom application.

 
6 Enter the Domain Name for the computer and click Next.

7 Select the time zone for the virtual machine and click Next.

8 Select the type of network settings to apply to the guest operating system.

Option Description

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click ....
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
9 Enter DNS and domain settings.

10 Click Finish to save your changes.

The customization specification you created is listed in the Customization Specification Manager, and can be
used to customize virtual machine guest operating systems.

Create a Customization Specification for Windows
Use the Guest Customization wizard to save Windows guest operating system settings in a specification that
you can apply when cloning virtual machines or deploying from templates.

Prerequisites

Ensure that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 42.
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Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Click New.

3 In the Guest Customization wizard, select Windows from the Target Virtual Machine OS menu.

4 Under Customization Specification Information, enter a name for the specification and an optional
description and click Next.

5 Type the virtual machine owner’s name and organization and click Next.

6 Specify how to determine the guest operating system's computer name and click Next.

The operating system uses this name to identify itself on the network. On Linux systems, it is called the
host name.

Option Description

Use a specific name a Type a name.

The name can contain alphanumeric characters and the hyphen (-)
character. It cannot contain periods (.) or blank spaces and cannot be
made up of digits only. Names are case-insensitive.

b (Optional) To ensure that the name is unique, select Append a numeric
value to ensure uniqueness. This appends a hyphen followed by a
numeric value to the virtual machine name.

Use the virtual machine’s name The computer name that vCenter Server creates is identical to the name of
the virtual machine on which the guest operating system is running.

Prompt the user for a name in the
Deploy wizard

The vSphere Client prompts you to enter a name after the cloning or
deployment is complete.

Use a custom application configured
with vCenter Server to generate a
name

Enter a parameter that can be passed to the custom application.

 
7 Provide licensing information for the Windows operating system and click Next.

Option Description

For non-server operating systems Type the Windows product key for the new guest operating system.

For server operating systems a Type the Windows product key for the new guest operating system.
b Select Include Server License Information.
c Select either Per seat or Per server.
d (Optional) If you selected Per server, enter the maximum number of

simultaneous connections you want the server to accept.
 

8 Configure the administrator password for the virtual machine and click Next.

a Type a password for the administrator account, and confirm the password by typing it again.

NOTE   You can change the administrator password only if the administrator password on the source
Windows virtual machine is blank. If the source Windows virtual machine or template already has a
password, the administrator password does not change.

b (Optional) To log users into the guest operating system as Administrator, select the check box, and
select the number of times to log in automatically.

9 Select the time zone for the virtual machine and click Next.

10 (Optional) On the Run Once page, specify commands to be run the first time a user logs into the guest
operating system and click Next.

See the Microsoft Sysprep documentation for more information on Run Once commands.
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11 Select the type of network settings to apply to the guest operating system.

Option Description

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click ....
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
12 Select how the virtual machine will participate in the network and click Next.

Option Description

Workgroup Type a workgroup name. (For example, MSHOME)

Windows Server Domain a Type the domain name.
b Type the user name and password for a user account that has permission

to add a computer to the specified domain.
 

13 (Optional) Select Generate New Security ID (SID) and click Next.

A Windows Security ID (SID) is used in some Windows operating systems to uniquely identify systems
and users. If you do not select this option, the new virtual machine has the same SID as the virtual machine
or template from which it was cloned or deployed.

Duplicate SIDs do not cause problems when the computers are part of a domain and only domain user
accounts are used. However, if the computers are part of a Workgroup or local user accounts are used,
duplicate SIDs can compromise file access controls. For more information, see the documentation for your
Microsoft Windows operating system.

14 Click Finish to save your changes.

The customization specification you created is listed in the Customization Specification Manager, and can be
used to customize virtual machine guest operating systems.

Create a Customization Specification for Windows Using a Custom Sysprep Answer
File
A custom sysprep answer file is a file that stores a number of customization settings such as computer name,
licensing information, and workgroup or domain settings. You can supply a custom sysprep answer file as an
alternative to specifying many of the settings in the Guest Customization wizard.

Windows 2000, Windows Server 2003, and Windows XP use a text file called sysprep.inf. Windows Server
2008, Windows Vista, and Windows 7 use an XML file called sysprep.xml. You can create these files using a
text editor, or use the Microsoft Setup Manager utility to generate them. For more information about how to
create a custom sysprep answer file, see the documentation for the relevant operating system.

Prerequisites

Ensure that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 42.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Click New.

3 In the Guest Customization wizard, select Windows from the Target Virtual Machine OS menu.
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4 (Optional) Select Use Custom Sysprep Answer File.

5 Under Customization Specification Information, enter a name for the specification and an optional
description and click Next.

6 Select the option to import or create a sysprep answer file and click Next.

Option Description

Import a Sysprep answer file Click Browse and browse to the file.

Create a Sysprep answer file Type the contents of the file in the text box.
 

7 Select the type of network settings to apply to the guest operating system.

Option Description

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click ....
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
8 (Optional) Select Generate New Security ID (SID) and click Next.

A Windows Security ID (SID) is used in some Windows operating systems to uniquely identify systems
and users. If you do not select this option, the new virtual machine has the same SID as the virtual machine
or template from which it was cloned or deployed.

Duplicate SIDs do not cause problems when the computers are part of a domain and only domain user
accounts are used. However, if the computers are part of a Workgroup or local user accounts are used,
duplicate SIDs can compromise file access controls. For more information, see the documentation for your
Microsoft Windows operating system.

9 Click Finish to save your changes.

The customization specification you created is listed in the Customization Specification Manager, and can be
used to customize virtual machine guest operating systems.

Edit a Customization Specification
You can edit existing specifications using the Customization Specification Manager.

Prerequisites

You must have at least one customization specification.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Right-click a specification and select Edit.

3 Proceed through the Guest Customization wizard to change specification settings.

Remove a Customization Specification
You can remove customization specifications from the Customization Specification Manager.

Prerequisites

You must have at least one customization specification.
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Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Right-click a specification and select Remove.

3 In the confirmation dialog box, select Yes.

The specification is deleted from the disk.

Copy a Customization Specification
You can copy an existing customization specification using the Customization Specification Manager.

Prerequisites

You must have at least one customization specification.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Right-click a specification and select Copy.

A new specification is created, Copy of specification_name.

Export a Customization Specification
You can export customization specifications and save them as .xml files. To apply an exported specification to
a virtual machine, import the .xml file using the Customization Specification Manager.

Prerequisites

You must have at least one customization specification.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Right-click a specification and select Export.

3 In the Save As dialog, enter a file name and location.

4 Click Save.

The specification is saved as an .xml file to the location you specified.

Import a Customization Specification
You can import an existing specification using the Customization Specification Manager, and use the
specification to customize the guest operating system of a virtual machine.

Prerequisites

Before you begin, you must have at least one customization specification saved as an xml file located on a file
system accessible from the vSphere Client.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Click Import.

3 From the Open dialog, browse to the .xml to import and click Open.

The imported specification is added to the list of customization specifications.
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Deploying OVF Templates 5
The VMware vSphere Client (vSphere Client) allows you to deploy and export virtual machines, virtual
appliances, and vApps stored in Open Virtual Machine Format (OVF). An appliance is a pre-configured virtual
machine that typically includes a preinstalled guest operating system and other software.

Deploying an OVF template allows you to add pre-configured virtual machines to your vCenter Server or
ESX/ESXi inventory. Deploying an OVF template is similar to deploying a virtual machine from a template.
However, you can deploy an OVF template from any local file system accessible from the vSphere Client
machine, or from a remote web server. The local file systems can include local disks (such as C:), removable
media (such as CDs or USB keychain drives), and shared network drives.

Exporting OVF templates allows you to create virtual appliances that can be imported by other users. You can
use the export function to distribute pre-installed software as a virtual appliance, or as a means of distributing
template virtual machines to users, including users who cannot directly access and use the templates in your
vCenter Server inventory.

This chapter includes the following topics:

n “About OVF,” on page 53

n “Deploy an OVF Template,” on page 54

n “Browse VMware Virtual Appliance Marketplace,” on page 55

n “Export an OVF Template,” on page 55

About OVF
OVF is a file format that allows for exchange of virtual appliances across products and platforms.

The OVF format offers the following advantages:

n OVF files are compressed, allowing for faster downloads.

n The vSphere Client validates an OVF file before importing it, and ensures that it is compatible with the
intended destination server. If the appliance is incompatible with the selected host, it cannot be imported
and an error message appears.

n OVF can encapsulate multi-tiered applications and more than one virtual machine.
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Deploy an OVF Template
You can deploy an OVF template from a local file system accessible to the vSphere Client machine, or from a
web URL.

NOTE   To import a virtual machine that was created by another VMware product and is not in OVF format,
use the VMware vCenter Converter client plug-in. See the vCenter Converter Administration Guide for more
information.

Procedure

1 In the vSphere Client, select File > Deploy OVF Template.

The Deploy OVF Template wizard appears.

2 Specify the source location and click Next.

Option Action

Deploy from File Browse your file system for an OVF or OVA template.

Deploy from URL Specify a URL to an OVF template located on the internet. Example:
http://vmware.com/VMTN/appliance.ovf

 
3 View the OVF Template Details page and click Next.

4 If license agreements are packaged with the OVF template, the End User License Agreement page appears.
Agree to accept the terms of the licenses and click Next.

5 (Optional) Edit the name and select the folder location within the inventory where the vApp will reside,
and click Next.

NOTE   When the vSphere Client is connected directly to an ESX/ESXi host, the option to select the folder
location does not appear.

6 Select the deployment configuration from the drop-down menu and click Next.

The option selected typically controls the memory settings, number of CPUs and reservations, and
application-level configuration parameters.

NOTE   This page appears only if the OVF template contains deployment options.

7 Select the host or cluster on which you want to deploy the OVF template and click Next.

8 Select the host on which you want to run the deployed OVF template, and click Next.

NOTE   This page appears only if the destination is a resource pool associated with a cluster with DRS
disabled or in manual mode.

9 Navigate to, and select the resource pool where you want to run the OVF template and click Next.

NOTE   This page appears only if the cluster contains a resource pool.

10 Select a datastore to store the deployed OVF template, and click Next.

Datastores are a unifying abstraction for storage locations such as Fibre Channel, iSCSI LUNs, or NAS
volumes. On this page, you select from datastores already configured on the destination cluster or host.
The virtual machine configuration file and virtual disk files are stored on the datastore. Select a datastore
large enough to accommodate the virtual machine and all of its virtual disk files.
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11 Select the disk format to store the virtual machine virtual disks, and click Next.

Format Description

Thin Provisioned The storage is allocated on demand as data is written to the virtual disks.

Thick Provisioned All storage is immediately allocated.
 

12 For each network specified in the OVF template, select a network by right-clicking the Destination
Network column in your infrastructure to set up the network mapping and click Next.

13 On the IP Allocation page, configure how IP addresses are allocated for the virtual appliance and click
Next.

Option Description

Fixed You will be prompted to enter the IP addresses in the Appliance
Properties page.

Transient IP addresses are allocated from a specified range when the appliance is
powered on. The IP addresses are released when the appliance is powered
off.

DHCP A DHCP server is used to allocate the IP addresses.
 
This page does not appear if the deployed OVF template does not contain information about the IP scheme
it supports.

14 Set the user-configurable properties and click Next.

The set of properties that you are prompted to enter depend on the selected IP allocation scheme. For
example, you are prompted for IP related information for the deployed virtual machines only in the case
of a fixed IP allocation scheme.

15 Review your settings and click Finish.

The progress of the import task appears in the vSphere Client Status panel.

Browse VMware Virtual Appliance Marketplace
Available vApps appear in the main panel.

To get to the Virtual Appliance Marketplace page, select File > Browse VA Marketplace from the main menu.

Procedure

u Select an available vApp and click Download Now.

The OVF Template Details page appears.

Export an OVF Template
An OVF package captures the state of a virtual machine or vApp into a self-contained package. The disk files
are stored in a compressed, sparse format.

Required privilege:vApp.Export

Chapter 5 Deploying OVF Templates

VMware, Inc.  55



Procedure

1 Select the virtual machine or vApp and select File > Export > Export OVF Template.

2 In the Export OVF Template dialog, type the Name of the template.

For example, type MyVm

NOTE   When exporting an OVF template with a name that contains asterisk (*) characters, those characters
turn into underscore characters (_).

3 Enter the Directory location where the exported virtual machine template is saved, or click “...” to browse
for the location.

The C:\ drive is the default location where the template is stored.

For example, OvfLib

4 In the Format field, determine how you want to store the files.

n Select Folder of files (OVF) to store the OVF template as a set of files (.ovf, .vmdk, and .mf) This
format is optimal if you plan to publish the OVF files on a web server or image library. The package
can be imported, for example, into the vSphere client by publishing the URL to the .ovf file.

n Select Single file (OVA) to package the OVF template into a single .ova file. This might be convenient
to distribute the OVF package as a single file if it needs to be explicitly downloaded from a web site
or moved around using a USB key.

5 In Description, type a description for the virtual machine.

By default, the text from the Notes pane on the virtual machine’s Summary tab appears in this text box.

6 Select the checkbox if you want to include image files attached to floppy and CD/DVD devices in the OVF
package.

NOTE   This checkbox only shows if the virtual machine is connected to an ISO file or if the floppy drive
is connected to a floppy image.

7 Click OK.

The download process is shown in the Export window.

Example: Folder Locations for OVF and OVA Files
If you type OvfLib for a new OVF folder, the following files might be created:

n C:\OvfLib\MyVm\MyVm.ovI

n C:\OvfLib\MyVm.mf

n C:\OvfLib\MyVm-disk1.vmdk

If you type C:\NewFolder\OvfLib for a new OVF folder, the following files might be created:

n C:\NewFolder\OvfLib\MyVm\MyVm.ovI

n C:\NewFolder\OvfLib\MyVm.mf

n C:\NewFolder\OvfLib\MyVm-disk1.vmdk

If you choose to export into the OVA format, and type MyVm, the file C:\MyVm.ova is created.
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Converting Physical Systems to
Virtual Machines 6

VMware vCenter Guided Consolidation, recommended for smaller IT environments, enables you to convert
physical systems to virtual machines and import them into vSphere. Use the consolidation feature to start
transitioning your physical datacenter to a virtual one, or to further consolidate your physical datacenter as it
grows.

Consolidating your datacenter involves the following process:
Find You search for and select the physical systems in your datacenter that you want

analyzed.

Analyze Selected physical systems are analyzed and performance data on each selected
system is collected. Generally, the longer the duration of the analysis phase,
the higher the confidence in the vCenter Server’s recommendations.

Consolidate Performance data is compared to the resources available on the virtual machine
host systems. The selected physical systems are converted to virtual machines
and imported into vCenter Server on the recommended hosts where they are
managed along with other components of your virtual environment.

Access the Guided Consolidation feature by clicking the Consolidation button.

This chapter includes the following topics:
n “Consolidation First Time Use,” on page 58

n “Consolidation Prerequisites,” on page 58

n “About Consolidation Services,” on page 61

n “Configuring Consolidation Settings,” on page 62

n “Find and Analyze Physical Systems,” on page 63

n “Viewing Analysis Results,” on page 63

n “Converting Physical Systems to Virtual Machines,” on page 64

n “Viewing Consolidation Tasks,” on page 65

n “Troubleshooting Consolidation,” on page 65
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Consolidation First Time Use
The first time you use the Consolidation feature, VMware recommends that you specify consolidation settings.
These settings include default system credentials and active domains.

Default system credentials enable you to store a set of credentials so that you do not have to enter them each
time you add systems for analysis. You can override default credentials when necessary.

Active domains enable you to register domains with the Consolidation feature. Active domains are scanned
daily so that newly added systems are readily available.

Consolidation Prerequisites
Guided Consolidation requires that at least one host is managed through vSphere. It also requires that you
provide credentials to the target physical systems.

Guided Consolidation can convert systems that are configured to any locale. Before you use the feature, ensure
that the following prerequisites are met:

Guided Consolidation Server Host Requirements
Guided Consolidation server must be installed on a host that meets the following system requirements:

n Located within the company's network and have access to target systems for performance data collection.

n The Guided Consolidation host must have a name that can be resolved from any machine on the network

n The Guided Consolidation host must have a static IP address.

n Located in a domain and can access the Active Directory server.

n One of the following operating systems installed:

n Windows 2003 Server SP2

n Windows XP Professional SP3

n Windows Server 2008 (Ensure that Computer Browser Windows Service is enabled)

n Windows Vista (Ensure that Computer Browser Windows Service is enabled)

n .NET Framework 3.0 SP1 installed

n Windows Management Instrumentation (WMI) and Remote Registry installed, enabled, and running on
host and all target systems

n Minimum 1000MHz CPU

n Minimum 1.8GB available RAM

n 3GB free disk space

n Authorized and able to connect to all the servers to be analyzed and consolidated using the protocols and
ports listed in the section below, “Network Connections,” on page 59.

n Access to general purpose ports that Windows uses for most of its communications for file/print sharing
and authentication
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General Requirements
n The following operating systems on systems targeted for analysis are supported:

n Windows 2000 Professional/Server/Advanced

n Windows XP Professional (32 bit and 64 bit)

n Windows Server 2003 Standard/Web/Enterprise (32 bit and 64 bit)

n Windows Vista (32 bit and 64 bit)

n Windows Server 2008 (32 and 64 bit)

n Credentials with Log on as service privileges on the system where the Guided Consolidation server is
installed must be provided at the time of installation. If Active Directory is deployed on your network,
the provided credentials must also have sufficient privileges to query the Active Directory database.

n File and Printer Sharing must be enabled on the system where Guided Consolidation is installed and
enabled on all systems targeted for analysis. Windows XP Simple File Sharing is insufficient.

n Guided Consolidation extension must be installed, enabled, and running on the vSphere Client.

n At least one datacenter inventory object exists.

n At least one host is registered with vCenter Server.

n Guided Consolidation requires administrator access to the systems selected for analysis. Specifically, the
vCenter Collector Service uses these credentials to connect to and retrieve configuration and performance
data from the physical systems under analysis. Accounts must be fully-qualified and can be any of the
following:

n account of the target system.

n account of the target system domain.

n account of a trusted domain of the target system.

Network Connections
The Guided Consolidation server must have access to the ports listed in the Table 6-1.
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Table 6-1.  Network Connections

Port Protocol Service Description MS Windows

135 TCP/UDP Loc-srv/epmap Microsoft DCE
Locator service, also
known as End-point
Mapper.

DHCP Server
DNS Server
WINS Server

137 TCP/UDP Netbios-ns NetBIOS names
service.
Firewall
administrators
frequently see larger
numbers of incoming
packets to port 137.
This is because of
Windows servers that
use NetBIOS (as well
as DNS) to resolve IP
addresses to names
using the
gethostbyaddr()
function. As users
behind the firewalls
visit Windows-based
Web sites, those
servers frequently
respond with
NetBIOS lookups.

WINS Server
DNS Server

138 TCP/UDP Netbios-dgm NetBIOS datagram
Used by Windows, as
well as UNIX services
(such as SAMBA).
Port 138 is used
primarily by the SMB
browser service that
obtains Network
Neighborhood
information.
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Table 6-1.  Network Connections (Continued)

Port Protocol Service Description MS Windows

139 TCP/UDP Netbios-ssn NetBIOS Session
Windows File and
Printer sharing.

445 TCP/UDP DNS DNS Direct Hosting
port.
In Windows 2000 and
Windows XP,
redirector and server
components now
support direct
hosting for
communicating with
other computers
running Windows
2000 or Windows XP.
Direct hosting does
not use NetBIOS for
name resolution.
DNS is used for name
resolution, and the
Microsoft networking
communication is
sent directly over
TCP without a
NetBIOS header.
Direct hosting over
TCP/IP uses TCP and
UDP port 445 instead
of the NetBIOS
session TCP port 139.

Active Directory

About Consolidation Services
Guided Consolidation can be installed together with vCenter Server, or can be installed on a separate host. For
best performance, install Guided Consolidation on a separate host.

Guided Consolidation include the following services:

vCenter Collector
Service

Discovers domains and systems within domains. Collects performance data on
those systems.

vCenter Provider
Service

Helper service to vCenter Collector Service. Communicates with target systems
and passes the data back to vCenter Collector Service.

vCenter Guided
Consolidation

Coordinates all communication among Guided Consolidation components.
Saves the performance data collected by the vCenter Collector Service.
Analyzes the data and generates placement recommendations. Also
communicates with vCenter Server to perform conversion. Runs inside a
generic servlet container labeled VMware vCenter Management
Webservices. The services of other vCenter features and extensions might also
be present inside that servlet container.
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Configuring Consolidation Settings
It is recommended that you specify Consolidation settings before using the feature. Consolidation settings are
located in the Configuration tab of the Guided Consolidation section of the vSphere Client.

The Configuration tab displays name, location, and health of Consolidation services. It also enables you to
configure the following settings:

Default system
credentials

Used by Guided Consolidation to access target physical systems. If necessary,
the default credentials can be overridden.

Active Domains Guided Consolidation automatically scans active domains and caches
information about the systems in them. This information is updated daily. If
you intend to add systems for analysis by selecting them from a domain, you
must specify the domain as Active.

Specify Default Credentials
Default credentials are used to access systems selected for analysis when no other administrator credentials
are specified.

Procedure

1 Click Change in the Default System Credentials area of the Configuration tab.

2 Enter a domain-qualified user name and password.

For example: DOMAIN\username.

3 Confirm the password and click OK.

Specify Active Domains
Specifying a domain as Active populates the Add to Analysis dialog box with a list of systems on that domain.
That information is updated daily as long as the domain remains active.

VMware recommends that you leave domains where new systems are frequently added as Active and that
you remove domains that do not frequently change after their information has been cached. Because scanning
active domains is resource intensive, VMware also recommends that no more than 50 domains are
simultaneously active.

NOTE   In some cases it can take the system several hours to collect a domain's containment information.

Procedure

1 From the vSphere Client Home page, select Guided Consolidation > Configuration.

2 Click Add in the Active Domains section.

3 Select the domains you want to make active.

4 Click OK.
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Find and Analyze Physical Systems
The Add to Analysis dialog box enables you to find systems in your environment and add them for analysis,
to manually search for physical systems, or to select systems from the list of systems found in active domains.
You can select systems and add them for analysis.

You can add systems manually by entering a computer name, IP address or range of IP addresses, or file name.
Alternatively, you can select a domain - it must be active - and select systems found within that domain. You
can analyze up to 100 systems simultaneously.

NOTE   After adding a system for analysis, it can take up to one hour before the status of the newly added
system changes from Collecting System Information to Analyzing.

Procedure

1 In the Analysis tab, click Add to Analysis.

2 Specify the systems you want to analyze.

Option Description

Manually specify the computers Provide computer names, IP addresses, a range of IP addresses, or path to a
file that contains the computer names or IP addresses of the systems you
want according to the following rules:
n Separate multiple computer names, or IP address, with a comma.
n Multiple IP ranges are not permitted.
n If you chose to use a file, each computer name or IP address must be on

a separate line in the file. The file must be accessible to the vSphere Client.

Select the computers by domains Select the systems you want to analyze.
 

3 Click Add to Analysis.

4 Select whether you want to use the configured default credentials, or whether you want to supply a
different set of credentials.

If you chose to override the default credentials, ensure that you enter a domain-qualified user name (for
example, DOMAIN\username) and password.

5 Click OK.

Viewing Analysis Results
Analysis results are displayed in the Analysis tab.

When analysis is complete, the following information appears:

n Physical Computer– Displays the host name of the physical system being analyzed or imported.

n CPU Info– Displays the number of CPUs and their clock speed.

n Memory Info– Displays the amount of RAM on the system.

n Status – Displays the progress of the analysis.

n Confidence – Indicates the degree to which vCenter Server is able to gather performance data about the
system and how good a candidate the system is based on the available data.

n CPU Usage – Displays the system’s average CPU usage over time.

n Memory Usage – Displays the system’s average memory usage over time.
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About the Confidence Metric
One important metric displayed in the Analysis tab is the Confidence metric. During the analysis phase,
performance data about each selected system is collected. This data is used to find a host with resources that
match the collected data to determine a recommendation for each candidate.

The recommendation indicates how well suited, based on the collected data, a candidate is to a particular
virtual machine host system. Confidence refers to the reliability of the recommendation and it is a function of
the duration of the analysis. Recommendations based on longer periods of analysis – and therefore more
performance data – receive a higher level of confidence.

NOTE   After 24 hours of analysis, vCenter Server indicates a high level of confidence in its recommendations.
However, this can be misleading if a system’s workload varies significantly over weeks or months. To ensure
a high level of confidence in a recommendation, allow the duration of the analysis phase to encompass an
amount of time that includes representative peaks and troughs in the systems’ workload. Analysis can run up
to one month.

Converting Physical Systems to Virtual Machines
You can convert systems using auto-generated recommendations, or you can manually specify conversion
parameters.

About Disk Resizing
During the conversion process, physical disks are typically resized to conserve space on the datastore while
providing room for growth on the resultant virtual disk.

The following formula is used to resize converted disks:

amount of space used on physical disk * 1.25 = resultant virtual disk size

Virtual disks are set to a size of 4GB or larger.

Convert Systems Manually
You can convert systems manually if you want to specify values other than the default values for the resultant
virtual machine's properties.

The option to convert systems manually is available only if the vCenter Converter client plug-in is installed
and enabled on your vSphere Client. You can verify whether vCenter Converter client is installed and enabled
through the Plug-in Manager.

Procedure

1 In the Analysis tab, right-click on a system and select Convert to Virtual Machine > Manually.

2 Complete the wizard to manually specify virtual machine properties.

Convert Systems Using Recommendations
Guided Consolidation recommendations are based on collected performance data and the capacity of available
hosts.

Procedure

1 In the Analysis tab, select the systems you want to consolidate and click Plan Consolidation.

2 Select a system.
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3 (Optional) Change the name displayed in the Physical Computer column by double-clicking it and
entering a new name.

Your entry will be used as the name for the resultant virtual machine.

4 (Optional) Change destinations, if alternative destinations are available, by clicking in the Destinations
column and selecting a destination from the drop-down menu.

The number of stars displayed in the Destination Rating column indicate the degree to which the host
system can comfortably accommodate the estimated resource needs of the resultant virtual machine.

5 Click Consolidate.

A conversion task is instantiated.

What to do next

You can view task progress in the Recent Tasks pane. You view additional information about the task in the
Tasks tab.

Viewing Consolidation Tasks
A task is created for each system being converted.

Recent tasks are displayed in the Recent Tasks pane. The Tasks tab lists all consolidation tasks. You can view
detailed information about a task by selecting it. Information about events related to the selected task are
displayed in the Task Details pane.

You can filter the list of tasks by entering criteria in the search field and selecting any combination of the
following:

n Name

n Target

n Status

n Initiated by

n Start Time

n Complete Time

Troubleshooting Consolidation
The topics in this section contain information about identifying and solving problems with Guided
Consolidation.

Negative Impact on vCenter Server Performance
Analyzing many systems simultaneously can impact vCenter Server performance.

Problem
Although up to 100 systems can be simultaneously analyzed, you might notice performance issues on the
vCenter Server that are due to running Guided Consolidation.

Cause
Analysis is resource intensive and can negatively impact vCenter Server performance.
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Solution
Reduce the number of systems that are being analyzed. If necessary, you can either disable Guided
Consolidation or uninstall the Guided Consolidation Service. If you disable Guided Consolidation, collected
data is preserved and no further data is collected. If you uninstall the Guided Consolidation Service, the data
that has been collected will no longer be usable.

Windows Systems Not Discovered
Guided Consolidation does not discover some Windows systems.

Problem
Windows systems that match all of the following conditions will not be discovered by Guided Consolidation
and will not be listed as candidates for analysis:

n The system is not listed in Microsoft Windows Network. The following commands do not list the system:

NET VIEW

NET VIEW /DOMAIN:the Workgroup or Domain the system belongs to

n The system is listed in Active Directory but does not have the operatingSystem attribute defined. This can
happen if the system never synchronizes with the Active Directory to which it belongs or was improperly
configured.

Solution
n Enable the Computer Browser service on the machine where Guided Consolidation is installed and on

the systems that are not discovered.

n Ensure that the Log On As credentials for VMware vCenter Collector Provider Service met the
prerequisites as mentioned in “Consolidation Prerequisites,” on page 58.

n Manually enter the static IP address of the target system.

Windows Operating Systems Prevent Guided Consolidation from Collecting
Performance Data

The default settings for some configurations of Windows XP, Windows Vista, and Windows Server 2008
prevent Guided Consolidation from collecting performance data against systems with those operating systems.

Problem
n The system is not listed in Microsoft Windows Network. The following commands do not list the system:

NET VIEW

NET VIEW /DOMAIN:the Workgroup or Domain the system belongs to

n The system is listed in Active Directory but does not have the operatingSystem attribute defined. This can
happen if the system never synchronizes with the Active Directory to which it belongs or was improperly
configured.

Solution
1 Set the Guided Consolidation target systems' Network access: Sharing and security model for local

accounts option to Classic - local users authenticate as themselves

2 Select Start > Run.

3 Run either gpedit.msc or secpol.msc
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4 In the left pane, select one of the following depending on which command you ran in the previous step:

a (gpedit.msc)Local Computer Policy > Computer Configuration > Windows Settings > Security
Settings > Local Policies > Security Options

b (secpol.msc) Security Settings > Local Policies > Security Options > Double-click on Network
access: Sharing and security model for local accounts.

c Double-click on Network access: Sharing and security model for local accounts. Ensure that Classic
- local users authenticate as themselves is selected.

5 Ensure the changed settings are applied.

n Restart VMware vCenter Collector Provider Service.

n Run gpupdate /force.

n Reboot the Guided Consolidation host system.

Available Domains List Remains Empty
Analyzing many systems simultaneously can impact vCenter Server performance.

Problem
The list of available domains remains empty for Guided Consolidation installed on Windows Server 2008 and
Windows Vista.

Cause
Some configurations of Windows Vista and Windows Server 2008 prevent Guided Consolidation from
discovering LAN Manager Workgroups. The Link-layer discovery protocol (LLDP), introduced in Windows
2008 Server, is not backward compatible with LAN Manager-based protocols and can not discover machines
with earlier operating systems if those systems do not have the appropriate drivers installed. Additionally,
Guided Consolidation does not use LLDP to perform discovery and will not find systems that can only be
discovered through that protocol, or when the Computer Browser Windows Service is not running.

Solution
Ensure that the Computer Browser Windows Service is enabled on the Windows Vista or Windows Server
2008 system where Guided Consolidation is installed and that it is also enabled on all systems to be discovered.
Alternatively, manually enter the static IP address of the system to be analyzed.

Guided Consolidation Erroneously Reports Analysis Disabled
Under some conditions, temporary network errors can disable analysis on multiple systems.

Problem
Temporary network errors can sometimes cause Guided Consolidation to stop analysis on one or more systems,
even when the systems are reachable.

Solution
Right-click on the affected systems and select Resume Analysis.
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Disable Guided Consolidation
You can disable Guided Consolidation.

Procedure

1 On the Guided Consolidation host system, open the Services control panel.

2 Stop theVMware vCenter Management Webservices (applicable when Guided Consolidation and
vCenter Server are not collocated), the VMware Collector for vCenter, and the VMware Provider for
vCenter services.

Uninstall Guided Consolidation
Uninstall Guided Consolidation to completely remove the feature. All collected data is also removed.

Procedure

1 Open the Add or Remove Programs control panel.

2 Remove vCenter Guided Consolidation for vCenter Server.

All vCenter Guided Consolidation services are removed.

CAUTION   Do not uninstall the vCenter Collector Service alone. Doing so prevents Guided Consolidation from
operating and will require that you perform a clean installation of Guided Consolidation, which will delete
existing Guided Consolidation data.
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Configuring and Managing Virtual Machines
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Configuring Virtual Machines 7
You can add or configure most virtual machine properties during the virtual machine creation process or after
you create the virtual machine and install the guest operating system.

You configure virtual machines using the Virtual Machine Properties editor and the Add Hardware wizard,
which you access from the vSphere Client. You can change nearly every characteristic that you selected when
you created the virtual machine. You can upgrade the virtual hardware of a virtual machine or convert virtual
disks from thin to thick using these dialog boxes.

You can configure three types of virtual machine properties.

Hardware View existing hardware configuration and access the Add Hardware wizard
to add or remove hardware.

Options View and configure a number of virtual machine properties, such as power
management interaction between the guest operating system and virtual
machine, and VMware Tools settings.

Resources Configure CPUs, CPU hyperthreading resources, memory and disks.

This chapter includes the following topics:

n “Virtual Machine Hardware, Options, and Resources Available to vSphere Virtual Machines,” on
page 72

n “Virtual Machine Hardware Versions,” on page 74

n “Locate the Hardware Version of a Virtual Machine,” on page 75

n “Change the Virtual Machine Name,” on page 76

n “View the Virtual Machine Configuration File Location,” on page 76

n “Edit Configuration File Parameters,” on page 76

n “Change the Configured Guest Operating System,” on page 77

n “CPU Virtual Machine Configuration,” on page 77

n “Memory Virtual Machine Configuration,” on page 83

n “Virtual Disk Configuration,” on page 86

n “SCSI Controller Configuration,” on page 89

n “Network Virtual Machine Configuration,” on page 92

n “Parallel and Serial Port Configuration,” on page 94

n “Other Virtual Machine Device Configuration,” on page 99
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n “USB Device Passthrough Configuration from an ESX/ESXi Host to a Virtual Machine,” on page 104

n “Manage Power Management Settings for a Virtual Machine,” on page 112

n “Configure the Virtual Machine Power States,” on page 113

n “Configuring Troubleshooting Options,” on page 114

Virtual Machine Hardware, Options, and Resources Available to
vSphere Virtual Machines

VMware provides a wide range of devices, options, and resources that you can configure or add to your virtual
machine.

Virtual Machine Hardware
Table 7-1 lists the hardware devices available to a virtual machine.

Not all hardware devices are available to every virtual machine. The host the virtual machine runs on and the
guest operating system must support devices that you add or configurations that you make. You can add or
configure some virtual machine hardware, such as USB device passthrough from an ESX/ESXi host to a virtual
machine, only if the virtual machine uses hardware version 7 or later. The PCI, SIO, and PS2 controllers are
virtual hardware devices that are part of the virtual motherboard, but cannot be configured or removed.

Table 7-1.  Virtual Machine Hardware

Hardware Device Description

CPU You can configure a virtual machine that runs on an ESX/ESXi host to have one
or more virtual processors. A Virtual machine cannot have more virtual CPUs
than the actual number of logical CPUs on the host. You can change the number
of CPUs allocated to a virtual machine and configure advanced CPU features, such
as the CPU Identification Mask and hyperthreaded core sharing.

DVD/CD-ROM Drive Installed by default when you create a new vSPhere virtual machine. You can
configure DVD/CD-ROM devices to connect to client devices, host devices, or
Datastore ISO files. You can add, remove, or configure DVD/CD-ROM devices.

Floppy Drive Installed by default when you create a new vSPhere virtual machine. You can
connect to a floppy drive located on the ESX/ESXi host, a floppy (.flp) image, or
the floppy drive on your local system. You can add, remove, or configure floppy
devices.

Hard Disk Stores the virtual machine's operating system, program files, and other data
associated with its activities. A virtual disk is a large physical file, or a set of files,
that can be copied, moved, archived, and backed up as easily as any other file.

IDE 0, IDE 1 By default, two Integrated Drive Electronics (IDE) interfaces are presented to the
virtual machine. The IDE interface (controller and cable) is a standard way for a
storage devices (Floppy drives, hard drives and CD-ROM drives) to connect to
the virtual machine.

Keyboard Mirrors the keyboard that is connected to the virtual machine console when you
first connect to the console.

Memory The virtual hardware memory size determines how much memory applications
that are running inside the virtual machine have available to them. A virtual
machine cannot benefit from more memory resources than its configured virtual
hardware memory size.

Network Adapter ESX/ESXi networking features provide communication between virtual machines
on the same host, between virtual machines on different hosts, and between other
virtual and physical machines. When you configure a virtual machine, you can
add network adapters (NICs) and specify the adapter type.
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Table 7-1.  Virtual Machine Hardware (Continued)

Hardware Device Description

Parallel port Interface for connecting peripherals to the virtual machine. The virtual parallel
port can connect to a parallel port or a file on the host operating system. You can
add, remove, or configure virtual parallel ports.

PCI controller Bus on the virtual machine motherboard that communicates with components
such as hard disks and other devices. One PCI controller is presented to the virtual
machine. You cannot configure or remove this device.

PCI Device You can add up to six PCI VMDirectPath devices to a virtual machine. The devices
must be reserved for PCI passthrough on the host on which the virtual machine
runs.

Pointing device Mirrors the pointing device that is connected to the virtual machine console when
you first connect to the console.

PS2 controller Provides mouse virtualization. One PS2 controller is available to the virtual
machine. By default, when you power on a virtual machine, it uses a PS/2 mouse.
If the victual machine has a virtual mouse drive, or if you load a mouse driver,
vmouse absolute protocol is used. If a USB driver is loaded, the controller sends
a driver over USB protocol. If the USB mouse does not respond, the virtual
machine reverts to the vmouse or PS2 mouse.

Serial Port Interface for connecting peripherals to the virtual machine. The virtual serial port
can connect to a physical serial port, to a file on the host computer, or over the
network. You can also use it to establish a direct connection between two virtual
machines or a connection between a virtual machine and an application on the
host computer. A virtual machine can use up to four virtual serial ports. You can
add, remove, or configure virtual serial ports.

SCSI controller Provides access to virtual disks. The SCSI virtual controller appears to a virtual
machine as different types of controllers, including BusLogic Parallel, LSI Logic
Parallel, LSI Logic SAS, and VMware Paravirtual. You can change the SCSI
controller type, allocate bus sharing for a virtual machine, add a paravirtualized
SCSI controller, and enable or disable VMI paravirtualization.

SCSI device By default, a SCSI device interface is available to the virtual machine. The SCSI
interface is a typical way to connect storage devices (floppy drives, hard drives,
and DVD/CD-ROMs) to a virtual machine. You can add, remove, or configure
SCSI devices.

SIO controller Provides serial and parallel ports, floppy devices, and performs system
management activities. One SIO controller is available to the virtual machine. You
cannot configure or remove this device.

USB controller The USB hardware chip that provides USB function to the USB ports that it
manages. The virtual USB Controller is the software virtualization of the USB host
controller function in the virtual machine.

USB device You can add multiple USB devices, such as security dongles and mass storage
devices, to a virtual machine that runs on an ESX/ESXi host to which the devices
are physically attached.

VMCI Virtual Machine Communication Interface device. Provides a high-speed
communication channel between a virtual machine and the hypervisor. You can
also enable VMCI for communication between virtual machines. You cannot add
or remove VMCI devices.

Virtual Machine Options
The virtual machine options define a range of virtual machine properties, such as the virtual machine name
and the virtual machine behavior with the guest operating system and VMware Tools. In addition, the options
define vApp functionality and other options that you rarely need to change from their defaults.

Table 7-2 shows the virtual machine settings that you can change in the Options tab of the Virtual Machine
Properties Editor.
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Table 7-2.  Virtual Machine Options

Options Description

General Options Display name and type of guest operating system. Location of the virtual machine and its
configuration file.

Appliance Options Options for functionality, product information, properties, and OVF settings specific to
virtual appliances.

VMware Tools Power Controls behavior, VMware Tools scripts, and automatic updates.

Power Management Virtual machine Suspend behavior.

Table 7-3 shows the advanced virtual machine settings that you can change in the Options tab.

Table 7-3.  Advanced Virtual Machine Options

Advanced Options Description

General Acceleration, logging, debugging and statistics.

CPUID Mask NX flag and advanced identification mask options.

Memory/CPU Hotplug Hot add enablement for individual virtual machines.

Boot Options Virtual machine boot options. Add a delay before booting or force entry into the BIOS setup
screen.

Paravirtualization VMI paravirtualization enablement.

Fibre Channel NPIV Virtual node and port World Wide Names (WWNs).

CPU/MMU Virtualization Settings for enabling Hardware Page Table Virtualization. In some new processors, controls
the use of hardware support for virtual MMUs.

Swapfile Location Swapfile location.

Virtual Machine Resources
You can adjust the host resource allocation for the selected virtual machine in the Resources tab. You can
change the resources listed in Table 7-4.

Table 7-4.  Virtual Machine Resources

Virtual Machine Resource Go to

CPU “CPU Virtual Machine Configuration,” on page 77

Memory “Memory Virtual Machine Configuration,” on page 83

Disk “Virtual Disk Configuration,” on page 86

Advanced CPU (hyperthreaded
core sharing)

“CPU Virtual Machine Configuration,” on page 77

Virtual Machine Hardware Versions
The hardware version of a virtual machine reflects the virtual machine's supported virtual hardware features.
These features correspond to the physical hardware available on the ESX/ESXi host on which you create the
virtual machine. Virtual hardware features include BIOS, number of virtual PCI slots, maximum number of
CPUs, maximum memory configuration, and other characteristics typical to hardware.

When you create a virtual machine, you can accept the default hardware version, which always corresponds
to the host on which the virtual machine is created, or an earlier version.
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Selecting an earlier hardware version is useful when you want to maintain compatibility with older hosts. A
virtual machine can have an earlier hardware version than that of the host on which it runs in the following
cases:

n You migrate a virtual machine created on an ESX/ESXi 3.x or earlier host to an ESX/ESXi 4.x host.

n You create a new virtual machine on an ESX 4.x host using an existing virtual disk that was created on an
ESX/ESXi 3.x or earlier host.

n You add a virtual disk created on an ESX/ESXi 3.x or earlier host to a virtual machine created on an
ESX/ESXi 4.x host.

Virtual machines with hardware versions earlier than version 4 can run on ESX/ESXi 4.x hosts, but have reduced
performance and capabilities. In particular, you cannot add or remove virtual devices on virtual machines with
hardware versions earlier than version 4 when they run on an ESX/ESXi 4.x host. To make full use of these
virtual machines, upgrade the virtual hardware as described in the Upgrade Guide.

Table 7-5 lists virtual machine hardware versions; the ESX/ESXi versions on which they can be created, edited,
and run; the vCenter Server versions on which they are fully supported; and a brief description of the hardware
version’s capabilities.

Table 7-5.  Virtual Machine Hardware Versions

Version 7 Version 4 Version 3
Compatible with vCenter
Server Version

ESX/ESXi 4.x create, edit, run create, edit, run run vCenter Server 4.x

ESX Server 3.x – create, edit, run run VirtualCenter Server 2.x and
higher

ESX Server 2.x – – create, edit, run VirtualCenter Server 1.x and
higher

NOTE   Virtual machine hardware version 4 might be listed as VM3 in documentation for earlier versions of
ESX and ESXi. Virtual machine hardware version 3 might be listed as VM2 in documentation for earlier versions
of ESX.

Locate the Hardware Version of a Virtual Machine
You can locate the hardware version of a virtual machine by looking in the virtual machine Summary tab or
the Virtual Machine Properties dialog box.

Procedure

1 In the vSphere Client inventory, select the virtual machine.

2 Select a method for viewing the version information.

Option Description

Click the Summary tab. The virtual machine hardware version appears at the top right corner of the
Summary tab.

Right-click the virtual machine and
select Edit Settings.

The virtual machine hardware version appears at the top right corner of the
Virtual Machine Properties dialog box.
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Change the Virtual Machine Name
You can change the virtual machine name in the Virtual Machine Name panel in the Virtual Machine
Properties dialog box.

Changing the name does not change the name of any virtual machine files or the name of the directory that
the files are located in.

Prerequisites

n Verify that you are connected to the vCenter Server or ESX/ESXi host on which the virtual machine runs.

n Verify that you have access to the virtual machine in the vSphere Client inventory list.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select General Options.

3 Type a new name for the virtual machine.

4 Click OK to save your changes and close the dialog box.

View the Virtual Machine Configuration File Location
You can view the location of the virtual machine configuration and working files. This information is useful
when you are configuring backup systems.

Prerequisites

n Verify that you are connected to the vCenter Server or ESX/ESXi host on which the virtual machine runs.

n Verify that you have access to the virtual machine in the vSphere Client inventory list.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select General Options.

3 Record the location of the configuration and working files and click OK to close the dialog box.

Edit Configuration File Parameters
You can change or add virtual machine configuration parameters if you intend to use experimental features
or when instructed by a VMware technical support representative.

You also might see VMware documentation that instructs you to change or add a parameter. In such cases,
you can safely follow the recommended procedure.

The following conditions apply:

n To change a parameter, you change the existing value for the keyword/value pair. For example, if you
start with the keyword/value pair, keyword/value, and change it to keyword/value2, the result is
keyword=value2.

n You cannot delete a configuration parameter entry.

CAUTION   You must assign a value to configuration parameter keywords. If you don't assign a value, the
keyword can return a value of 0, false, or disable, which can result in a virtual machine that cannot power on.
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Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, click General.

3 Click Configuration Parameters.

4 (Optional) Change or add a parameter.

5 Click OK to exit the Configuration Parameters dialog box.

6 Click OK to save your changes and close the dialog box.

Change the Configured Guest Operating System
You can change the guest operating system configuration of the virtual machine on the General Options pane
in the Virtual Machine Properties dialog box.

Prerequisites

n Verify that you are connected to the vCenter Server or ESX/ESXi host on which the virtual machine runs.

n Verify that you have access to the virtual machine in the vSphere Client inventory list.

n You must power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select General Options.

3 Select a guest operating system type and version.

4 Click OK to save your changes and close the dialog box.

The virtual machine configuration parameters for the guest operating system are changed. You can now install
the guest operating system.

CPU Virtual Machine Configuration
You can add, change, or configure CPU resources to improve virtual machine performance. You can set most
of the CPU parameters during virtual machine creation or after the guest operating system is installed. Some
actions require you to power off the virtual machine before changing the settings.

Understanding the following concepts can help you plan your CPU resource allocation strategy.

CPU The CPU or processor is the portion of a computer system that carries out the
instructions of a computer program and is the primary element carrying out
the computer's functions.

Core Comprises a logical execution unit containing an L1 cache and functional units
needed to execute programs. Cores can independently execute programs or
threads.

Thread A process that does not have a full stack of memory associated for it. The thread
is tied to a parent process. typically thread processes must run on the same
computer, but can execute simultaneously on separate cores of the same node.

Socket A physical connector on a computer motherboard that accepts a single physical
chip. Many motherboards can have multiple sockets that can in turn accept
multicore chips.
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Resource sharing Shares specify the relative priority or importance of a virtual machine or
resource pool. If a virtual machine has twice as many shares of a resource as
another virtual machine, it is entitled to consume twice as much of that resource
when these two virtual machines are competing for resources.

Resource allocation You can dynamically change resource allocation policies. For example, if at
year end the workload on Accounting increases, you can increase the
Accounting resource pool reserve.

Change the CPU Configuration
You can configure more than one virtual processor or CPU for a virtual machine using VMware Virtual SMP
for ESX.

You can configure a virtual machine that runs on an ESX/ESXi host to have up to eight virtual CPUs. A Virtual
machine cannot have more virtual CPUs than the actual number of logical CPUs on the host. The number of
logical CPUs is the number of physical processor cores or two times that number if hyperthreading is enabled.
For example, if a host has eight logical CPUs, you can configure the virtual machine for 8 virtual CPUs.

Not all guest operating systems support SMP, and some that do require reinstallation if the number of CPUs
changes. For more information about using SMP, search the VMware Knowledge Base.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select CPUs.

3 Select the number of virtual processors for the virtual machine.

4 Click OK to save your changes and close the dialog box.

Allocate CPU Resources
You can change the amount of CPU resources allocated to a virtual machine by using the shares, reservations,
and limits settings.

A virtual machine has the following user-defined settings that affect its CPU resource allocation.

Limit Places a limit on the consumption of CPU time for a virtual machine. This value
is expressed in MHz.

Reservation Specifies the guaranteed minimum allocation for a virtual machine. The
reservation is expressed in MHz.

Shares Each virtual machine is granted a number of CPU shares. The more shares a
virtual machine has, the more often it gets a time slice of a CPU when there is
no CPU idle time. Shares represent a relative metric for allocating CPU
capacity.

Prerequisites

n Verify that you are connected to the vCenter Server or ESX/ESXi host on which the virtual machine runs.

n Verify that you have access to the virtual machine in the vSphere Client inventory list.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select CPU.
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3 Allocate the CPU capacity for this virtual machine.

Option Description

Shares The values Low, Normal, High, and Custom are compared to the sum of all
shares of all virtual machines on the server and, on ESX/ESXi hosts, the
service console. You can use share allocation symbolic values to configure
their conversion into numeric values.

Reservation Guaranteed CPU allocation for this virtual machine.

Limit Upper limit for this virtual machine’s CPU allocation. Select Unlimited to
specify no upper limit.

 
4 Click OK to save your changes and close the dialog box.

Configure Multicore Virtual CPUs
VMware multicore virtual CPU support lets you control the number of cores per virtual CPU in a virtual
machine. This capability lets operating systems with socket restrictions use more of the host CPU's cores, which
increases overall performance.

You can configure how the virtual CPUs are assigned in terms of sockets and cores. For example, you can
configure a virtual machine with four virtual CPUs in the following ways:

n Four sockets with one core per socket

n Two sockets with two cores per socket

n One socket with four cores per socket

Using multicore virtual CPUs can be useful when you run operating systems or applications that can take
advantage of only a limited number of CPU sockets. Previously, each virtual CPU was, by default, assigned
to a single-core socket, so that the virtual machine would have as many sockets as virtual CPUs.

When you configure multicore virtual CPUs for a virtual machine, CPU hot Add/remove is disabled.

For more information about multicore CPUs, see the vSphere Resource Management Guide. You can also search
the VMware KNOVA database for articles about multicore CPUs.

CAUTION   You must assign a value to configuration parameter keywords. If you don't assign a value, the
keyword can return a value of 0, false, or disable, which can result in a virtual machine that cannot power on.

Prerequisites

IMPORTANT   To use the VMware multicore virtual CPU feature, you must be in compliance with the
requirements of the operating system EULA.

n Verify that the virtual machine is powered off.

n Verify that you have virtual machine hardware version 7 or later.

n Verify that the total number of virtual CPUs for the virtual machine divided by the number of cores per
socket is a positive integer.

Required Privilege: Advanced

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Select the Hardware tab and select CPUs.

3 Select the number of virtual processors.

4 Select the Options tab and Click General in the Advanced options list.
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5 Click Configuration Parameters.

6 Click Add Row and type cpuid.coresPerSocket in the Name column.

You cannot make changes to the name (keyword) after you enter it.

7 Type a value (2, 4, or 8) in the Value column.

The number of virtual CPUs must be divisible by the number of cores per socket. The coresPerSocket
setting must be a power of two.

8 Click OK and power on the virtual machine.

You can verify the CPU settings for the virtual machine on the Resource Allocation tab.

Configuring Advanced CPU Scheduling Settings
You can select CPU options that involve scheduling the virtual machine processing to physical processor cores
and hyperthreads. ESX generally manages processor scheduling well, even when hyperthreading is enabled.
These settings are useful only for detailed tweaking of critical virtual machines.

Configure Hyperthreaded Core Sharing
You can select how the virtual CPUs of a virtual machine share physical cores on a hyperthreaded system.

Hyperthreading technology allows a single physical processor to behave like two logical processors. The
hyperthreaded core sharing option provides detailed control over whether to schedule a virtual machine to
share a physical processor core. The processor can run two independent applications at the same time.
Although hyperthreading does not double the performance of a system, it can increase performance by better
utilizing idle resources.

Prerequisites

n The hyperthreaded core sharing option must be enabled in your system's BIOS settings. For more
information, see the Resource Management Guide.

n Power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select Advanced CPU.

3 Select a mode from the Hyperthreading Sharing Mode drop-down menu.

Option Description

Any (default) The virtual CPUs of this virtual machine can share cores with other virtual
CPUs of this or other virtual machines.

None The virtual CPUs of this virtual machine have exclusive use of a processor
core whenever they are scheduled to it. The other hyperthread of the core is
halted while this virtual machine is using the core.

Internal On a virtual machine with exactly two virtual processors, the two virtual
processors are allowed to share one physical core (at the discretion of the
host scheduler), but this virtual machine never shares a core with any other
virtual machine. If this virtual machine has any other number of processors
other than two, this setting is the same as the None setting.

 
4 Click OK to save your changes and close the dialog box.
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Configure Processor Scheduling Affinity
The Scheduling Affinity option gives you detailed control over how virtual machine CPUs are distributed
across the host's physical cores (and hyperthreads if hyperthreading is enabled). This panel does not appear
for virtual machines in a DRS cluster or when the host has only one processor core and no hyperthreading.

Using CPU affinity, you can assign a virtual machine to a specific processor. This assignment allows you to
restrict the assignment of virtual machines to a specific available processor in multiprocessor systems.

For potential issues with CPU affinity, see the Resource Management Guide.

Prerequisites

Power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select Advanced CPU.

3 In the Scheduling Affinity panel, enter a comma-separated list of hyphenated processor ranges.

For example, "0,4-7" would indicate affinity with CPUs 0,4,5,6, and 7. Selecting all processors is identical
to selecting no affinity. You must provide at least as many processor affinities as you have virtual CPUs.

4 Click OK to save your changes and close the dialog box.

Change CPU Hot-Plug Settings
The CPU hot plug option lets you add or remove CPU resources for a virtual machine while the machine is
powered on.

When you configure multicore virtual CPUs for a virtual machine, CPU hot Plug is disabled.

Adding CPU resources to a running virtual machine (with CPU hot plug enabled) disconnects and reconnects
all USB passthrough devices connected to that virtual machine.

Prerequisites

Verify that the virtual machine is running under the following conditions:

n VMware Tools is installed (required for hot plug functionality with Linux guest operating systems).

n The virtual machine has a guest operating system that supports CPU hot plug.

n The virtual machine is using hardware version 7 or later.

n CPU hot plug is enabled on the Options tab of the Virtual Machine Properties dialog box.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, select Memory/CPU Hotplug.

3 Change the CPU Hot Plug setting.

n Disable CPU hot plug for this virtual machine

n Enable CPU hot add only for this virtual machine

n Enable CPU hot add and remove for this virtual machine

4 Click OK to save your changes and close the dialog box.
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Change CPU Identification Mask Settings
CPU identification (CPU ID) masks control the CPU features visible to the virtual machine's guest operating
system. Masking or hiding CPU features can make a virtual machine widely available to ESX/ESXi hosts for
migration. vCenter Server compares the CPU features available to a virtual machine with the CPU features of
the destination host to determine whether to allow or disallow migration with vMotion.

For example, masking the AMD No eXecute (NX) and the Intel eXecute Disable (XD) bits prevents the virtual
machine from using these features, but provides compatibility that allows you to migrate virtual machines to
ESX/ESXi hosts that do not include this capability. When the NX/XD bit is visible to the guest operating system,
the virtual machine can use this feature, but you can migrate the virtual machine only to hosts on which the
feature is enabled.

NOTE   You rarely need to change the CPU identification mask configuration settings. Almost all changes are
made only to the NX/XD bit.

See the vSphere Datacenter Administration Guide for detailed information about vMotion compatibility and CPU
masks.

Prerequisites

n Verify that you have access to the virtual machine in the vSphere Client inventory list.

n Power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, select CPUID Mask.

3 In the CPU Identification Mask panel, select an NX flag option.

Option Description

Hide the NX/XD flag from guest Increases vMotion compatibility.
Hiding the NX/XD flag increases vMotion compatibility between hosts, but
might disable certain CPU security features.

Expose the NX/XD flag to guest Keeps all CPU security features enabled.

Keep current Advanced setting
values for the NX/XD flag

Uses the NX/XD flag settings specified in the CPU Identification Mask dialog
box. Enabled only when current settings specify something other than what
is specified in the other NX/XD flag options, for example, if the NX/XD flag
bit setting varies with processor brand.

 
4 (Optional) To edit mask values other than the NX bit or to set NX mask values to states other than “0” or

“H”, click Advanced.

a Select the relevant tab.

b Click a row and edit the mask value.

To view an explanation of a values symbol, click Legend.

c Click OK to apply the changes and return to the Virtual Machine Properties dialog box.

5 Click OK to save your changes and close the dialog box.

vSphere Virtual Machine Administration Guide

82  VMware, Inc.



Change CPU/MMU Virtualization Settings
ESX can determine whether a virtual machine should use hardware support for virtualization. It makes this
determination based on the processor type and the virtual machine. Overriding the automatic selection can
provide better performance for some use cases.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, select CPU/MMU Virtualization.

3 Select an instruction set.

n Automatic

n Use only software virtualization

n Use hardware support for CPU virtualization (VT/AMD-V) only

n Use hardware support for both CPU and MMU virtualization (VT/AMD-V and EPT/RVI)

4 Click OK to save your changes and close the dialog box.

Memory Virtual Machine Configuration
You can add, change, or configure virtual machine memory resources or options to enhance virtual machine
performance. You can set most of the memory parameters during virtual machine creation or after the guest
operating system is installed. Some actions require that you power off the virtual machine before changing the
settings.

Memory resource configuration is distinct from the virtual hardware memory size, which you configure on
the Hardware tab. The memory resource setting determines how much of the host's memory is allocated to a
virtual machine. The virtual hardware memory size determines how much memory applications that are
running inside the virtual machine have available to them. A virtual machine cannot benefit from more
memory resources than its configured virtual hardware memory size. The ESX/ESXi host caps memory
resource use to the maximum useful for the virtual machine, so you can accept the default of Unlimited memory
resources.

Change the Memory Configuration
You can reconfigure the memory allocated to a virtual machine's hardware.

Minimum memory size is 4MB. Minimum and maximum memory size depends on the host and the guest
operating system type. The memory size must be a multiple of 4MB. The maximum for best performance
represents the threshold above which the host's physical memory is insufficient to run the virtual machine at
full speed. This value fluctuates as conditions on the host change (as virtual machines are powered on or off,
for example).

When you add memory to a virtual machine while it is powered on, the amount you add cannot exceed 16
times the amount of memory the virtual machine had when it was powered on.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select Memory.

3 Adjust the amount of memory allocated to the virtual machine.

4 Click OK to save your changes and close the dialog box.
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Allocate Memory Resources
You can allocate memory resources for a virtual machine and specify reservations, limits, and shares.

A virtual machine has three user-defined settings that affect its memory resource allocation.

Limit Places a limit on the consumption of memory for a virtual machine. This value
is expressed in megabytes.

Reservation Specifies the guaranteed minimum allocation for a virtual machine. The
reservation is expressed in megabytes.

Shares Each virtual machine is granted a number of memory shares. The more shares
a virtual machine has, the more often it gets a time slice of a memory when
there is no memory idle time. Shares represent a relative metric for allocating
memory capacity. For more information about share values, see the Resource
Management Guide.

Assigning a virtual machine a reservation larger than its configured memory is wasteful. The vSphere Client
does not allow you to make such an assignment on the Resources tab. If you give a virtual machine a large
reservation and then reduce its configured memory size on the Hardware tab, the reservation is reduced to
match the new configured memory size. You must power off the virtual machine before configuring memory
resources.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select Memory.

3 Allocated the memory capacity for this virtual machine.

Option Description

Shares The values Low, Normal, High, and Custom are compared to the sum of all
shares of all virtual machines on the server and, on ESX/ESXi hosts, the
service console. You can use share allocation symbolic values to configure
their conversion into numeric values.

Reservation Guaranteed memory allocation for this virtual machine.

Limit Upper limit for this virtual machine’s memory allocation.

Unlimited No upper limit is specified.
 

4 Click OK to save your changes and close the dialog box.

Change Memory Hot-Add Settings
Memory hot add lets you add memory resources for a virtual machine while the machine is powered on.

Prerequisites

n The virtual machine has a guest operating system that supports Memory hot add functionality.

n The virtual machine is using hardware version 7 or later.

n Memory hot add is enabled on the Options tab of the Virtual Machine Properties dialog box.

n VMware Tools is installed.
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Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, select Memory/CPU Hotplug.

3 Enable or disable memory hot add.

n Enable memory hot add for this virtual machine.

n Disable memory hot add for this virtual machine.

4 Click OK to save your changes and close the dialog box.

Associate Memory Allocations with a NUMA Node
You can specify that all future memory allocations on a virtual machine use pages associated with a single
NUMA node (also known as manual memory affinity). When the virtual machine uses local memory, the
performance improves on that virtual machine.

The following conditions apply to memory optimization with NUMA:

n The NUMA option is available on the Advanced Memory Resources page only if the host uses NUMA
memory architecture.

n Affinity settings are meaningful only when used to tweak the performance of a specific set of virtual
machines on one host. This option is not available when the virtual machine resides on a DRS cluster. All
affinity values are cleared when you move the virtual machine to a new host.

n You can specify nodes to use for future memory allocations only if you have also specified CPU affinity.
If you make manual changes only to the memory affinity settings, automatic NUMA rebalancing does not
work properly.

n Checking all the boxes is the same as applying no affinity.

For information about NUMA and advanced memory resources, including usage examples, see the Resource
Management Guide.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Select the Resources tab, and select Memory.

3 In the NUMA Memory Affinity panel, set the NUMA node affinity for the virtual machine.

n No affinity

n Use memory from nodes

4 Click OK to save your changes and close the dialog box.

Change the Swap File Location
When a virtual machine is powered on, the system creates a VMkernel swap file to serve as a backing store for
the virtual machine's RAM contents. You can accept the default swap file location or save the file to a different
location. By default, the swap file is stored in the same location as the virtual machine's configuration file.

For more information about host swap file settings, see the vSphere Datacenter Administration Guide. For more
information about cluster settings, see the Resource Management Guide.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Option tab and under Advanced, select Swapfile Location.
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3 Select an option.

Option Description

Default Stores the virtual machine swap file at the default location defined by the
host or cluster swap file settings.

Always store with the virtual
machine

Stores the virtual machine swap file in the same folder as the virtual machine
configuration file.

Store in the host's swapfile datastore Stores the virtual machine swap file in the swap file datastore defined by the
host or cluster swap file settings.

 
4 Click OK to save your changes and close the dialog box.

Virtual Disk Configuration
You can add virtual disks and add more space to existing disks, even when the virtual machine is running.
You can set most of the virtual disk parameters during virtual machine creation or after you install the guest
operating system.

You can store virtual machine data in a new virtual disk, an existing virtual disk, or a mapped SAN LUN. A
virtual disk, which appears as a single hard disk to the guest operating system, is composed of one or more
files on the host file system. You can easily copy or move virtual disks on the same hosts or between hosts.

For virtual machines running on an ESX/ESXi host, you can store the virtual machine data directly on a SAN
LUN instead of storing it in a virtual disk file. This is useful if you are running applications in your virtual
machines that must know the physical characteristics of the storage device. Additionally, mapping a SAN LUN
allows you to use existing SAN commands to manage storage for the disk.

When you map a LUN to a VMFS volume, vCenter Server creates a raw device mapping (RDM) file that points
to the raw LUN. Encapsulating disk information in a file allows vCenter Server to lock the LUN so that only
one virtual machine can write to it. This file has a .vmdk extension, but the file contains only disk information
that describes the mapping to the LUN on the ESX/ESXi system. The actual data is stored on the LUN. You
cannot deploy a virtual machine from a template and store its data on a LUN. You can store only its data in a
virtual disk file.

Change the Virtual Disk Configuration
You can change the virtual device node, the size of the disk, and the persistence mode for virtual disk
configuration for a virtual machine.

NOTE   The Manage Paths feature for RDM disks is not available for virtual machines on legacy hosts running
versions of ESX Server earlier than 3.0.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the hard disk to modify.

The name of the disk file and the disk type (thick or thin) appear in the upper-right pane.

3 Select a Virtual Device Node type from the drop-down menu.

4 To change the size of the disk, enter a new value in the Provisioned Size text box.
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5 (Optional) Select the virtual disk Independent mode and select an option.

Option Description

Persistent The disk operates normally except that changes to the disk are permanent
even if the virtual machine is reverted to a snapshot.

Nonpersistent The disk appears to operate normally, but whenever the virtual machine is
powered off or reverted to a snapshot, the contents of the disk return to their
original state. All later changes are discarded.

 
Independent disks are not affected by snapshots.

6 Click OK to save your changes and close the dialog box.

Add a Hard Disk to a Virtual Machine
When you add a hard disk to a virtual machine, you can create a new virtual disk, add an existing virtual disk,
or add a mapped SAN LUN.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful to
control the boot order or to have different SCSI controller types. For example, you might want to boot off an
LSI Logic controller and share a data disk with another virtual machine using a Buslogic controller with bus
sharing turned on.

NOTE   You cannot use migration with vMotion to migrate virtual machines that use raw disks for clustering
purposes.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select Hard Disk and click Next.

4 Select the type of disk to use.

Option Action

Create a new virtual disk a Enter the disk capacity.
b Select a thin disk format or a thick disk format to allow the disks to

support clustering features.
c Select a location to store the disk. Store with the virtual machine or

Specify a datastore.
d If you selected Specify a datastore, browse for the datastore location,

and click Next.

Use an Existing Virtual Disk Browse for the disk file path and click Next.

Raw Device Mappings Gives your virtual machine direct access to SAN.
a Select the LUN that you want to use for the raw disk, and click Next.
b Select to store the LUN mapping files on the same datastore as the virtual

machine files, or select a different a datastore, and click Next.
c Select the compatibility mode.

n Physical allows the guest operating system to access the hardware
directly.

n Virtual allows the virtual machine to use VMware snapshots and
other advanced functions.

d Click Next.
 

5 Accept the default or select a different virtual device node.
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6 (Optional) Select the virtual disk Independent mode and select an option.

Option Description

Persistent The disk operates normally except that changes to the disk are permanent
even if the virtual machine is reverted to a snapshot.

Nonpersistent The disk appears to operate normally, but whenever the virtual machine is
powered off or reverted to a snapshot, the contents of the disk return to their
original state. All later changes are discarded.

 
Independent disks are not affected by snapshots.

7 Click Next.

8 Review the information and click Finish.

9 Click OK to save your changes and close the dialog box.

Use Disk Shares to Prioritize Virtual Machines
You can change the disk resources for a virtual machine. If multiple virtual machines access the same VMFS
datastore and the same logical unit number (LUN), use disk shares to prioritize the disk accesses from the
virtual machines. Disk shares distinguish high-priority from low-priority virtual machines.

You can allocate the host disk's I/O bandwidth to the virtual hard disks of a virtual machine. Disk I/O is a host-
centric resource so you cannot pool it across a cluster.

Shares is a value that represents the relative metric for controlling disk bandwidth to all virtual machines. The
values are compared to the sum of all shares of all virtual machines on the server and, on an ESX host, the
service console.

Disk shares are relevant only within a given ESX/ESXi host. The shares assigned to virtual machines on one
host have no effect on virtual machines on other hosts.

You can select an IOP limit, which sets an upper bound for storage resources that are allocated to a virtual
machine. IOPs are the number of I/O operations per second.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select Disk.

3 In the Resource Allocation panel, select the virtual hard disk to change.

4 Click the Shares column and change the value to allocate a number of shares of its disk bandwidth to the
virtual machine.

n Low (500)

n Normal (1000)

n High (2000)

n Custom

When you select a shares symbolic value, the numeric value appears in the Shares Value column. You
can select Custom to enter a user-defined shares value.

5 Click the Limit - IOPS column and enter the upper limit of storage resources to allocate to the virtual
machine.

6 Click OK to save your changes and close the dialog box.
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SCSI Controller Configuration
To access virtual disks, a virtual machine uses virtual SCSI controllers. These virtual controllers appear to a
virtual machine as different types of controllers, including BusLogic Parallel, LSI Logic Parallel, LSI Logic SAS,
and VMware Paravirtual. You can change the SCSI controller type, allocate bus sharing for a virtual machine,
add a paravirtualized SCSI controller, and enable or disable VMI paravirtualization.

Change the SCSI Bus Sharing Configuration
You can set the type of SCSI bus sharing for a virtual machine and indicate whether the SCSI bus is shared.
Depending on the type of sharing, virtual machines can access the same virtual disk simultaneously on the
same server or on any server.

You can change the SCSI controller configuration for a virtual machine on an ESX/ESXi host only.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select a SCSI Controller in the hardware list.

3 Select the type of sharing in the SCSI Bus Sharing list.

Option Description

None Virtual disks cannot be shared by other virtual machines.

Virtual Virtual disks can be shared by virtual machines on the same server.

Physical Virtual disks can be shared by virtual machines on any server.
 

4 Click OK to save your changes and close the dialog box.

Change the SCSI Controller Type
You configure virtual SCSI controllers on your virtual machines to attach virtual disks and RDMs to.

The choice of SCSI controller does not affect whether your virtual disk is an IDE or SCSI disk. The IDE adapter
is always ATAPI. The default for your guest operating system is already selected. Older guest operating
systems default to the BusLogic adapter.

If you create an LSI Logic virtual machine and add a virtual disk that uses BusLogic adapters, the virtual
machine boots from the BusLogic adapters disk. LSI Logic SAS is available only for virtual machines with
hardware version 7. Disks with snapshots might not experience performance gains when used on LSI Logic
SAS, VMware Paravirtual, and LSI Logic Parallel adapters.

You can change the SCSI controller configuration for a virtual machine on an ESX/ESXi host only.

CAUTION   Changing the SCSI controller type might result in a virtual machine boot failure.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab, select a SCSI controller, and click Change Type.
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3 Select a SCSI controller type and click OK.

n BusLogic Parallel

n LSI Logic SAS

n LSI Logic Parallel

n VMware Paravirtual

4 Click OK to save your changes and close the dialog box.

About VMware Paravirtual SCSI Adapters
Paravirtual SCSI (PVSCSI) adapters are high performance storage adapters that can result in greater
throughput and lower CPU utilization. PVSCSI adapters are best suited for high performance storage
environments.

PVSCSI adapters are available for virtual machines running hardware version 7 and later. They are supported
on the following guest operating systems:

n Windows Server 2008 R2 (64bit)

n Windows Server 2008 (32bit and 64bit)

n Windows Server 2003 (32bit and 64bit)

n Windows XP (32bit and 64bit)

n Windows Vista (32bit and 64bit)

n Windows 7 (32bit and 64bit)

n Red Hat Linux 5 (32bit and 64bit)

PVSCSI adapters have the following limitations:

n Disks on PVSCSI adapters might not experience performance gains if they have snapshots or if memory
on the ESX host is over committed.

n If you upgrade from RHEL 5 to an unsupported kernel, you might not be able to access data on the disks
attached to a PVSCSI adapter. To regain access to such disks:

a Upgrade the guest kernel but do not restart the guest.

b Run the VMware Tools configuration with the kernel-version parameter and pass the kernel version
within the guest:

vmware-config-tools.pk --kernel-version kernel_version

Run name -r to determine the version of the running kernel.

c Restart the guest.

n MSCS clusters are not supported.

n PVSCSI adapters do not support boot disks (the disk that contains the system software) on Red Hat Linux
5 virtual machines. Attach the boot disk to the virtual machine by using any of the other supported adapter
types.
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Enable and Disable VMI Paravirtualization
VMI is a paravirtualization standard that enables improved performance for virtual machines capable of using
it. Currently, this feature is available only for those versions of the Linux guest operating system that support
VMI paravirtualization.

Enabling paravirtualization uses one of the virtual machine’s six virtual PCI slots. Enabling paravirtualization
can limit how and where the virtual machine can be migrated. Consider the following before enabling this
feature:

n These hosts support VMI paravirtualization: ESX/ESXi 3.5 and greater, and Workstation 6.0 and greater.
Hardware version 4 virtual machines with paravirtualization enabled that are created on ESX hosts can
be migrated to Workstation hosts without loss of functionality.

n A virtual machine with paravirtualization enabled and that is powered off can be moved manually to a
host that does not support paravirtualization. However, this can result in reduced performance.

n A virtual machine with paravirtualization enabled and that is powered on or in a suspended power state
can not be migrated to a host that does not support paravirtualization.

n Automated vCenter Server DRS migrations of virtual machines with paravirtualization enabled to hosts
that do not support paravirtualization are not allowed.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under advanced, select Paravirtualization.

3 Select Support VMI Paravirtualization to enable VMI Paravirtualization.

4 Click OK to save your changes and close the dialog box.

Add a Paravirtualized SCSI Adapter
You can add a paravirtual SCSI (PVSCSI) high performance storage adapter to provide greater throughput
and lower CPU utilization.

PVSCSI adapters are best suited for environments, especially SAN environments, running I/O-intensive
applications.

Windows 2003 and 2008 guest operating systems support boot disk devices attached to a PVSCSI adapter.

PVSCSI adapters do not support bootable disks on Red Hat Linux 5 virtual machines. You must configure such
virtual machines with a primary SCSI adapter other than PVSCSI to support a disk where the system software
is installed.

Prerequisites

An existing virtual machine with a guest operating system and VMware Tools installed.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select SCSI Device and click Next.

4 Select a SCSI device in the Connection panel.
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5 Select an unused Virtual Device Node and click Next.

For device node SCSI (0:2), 0 is the controller number and 2 is the number of the device that is attached to
the controller. If you select a node on which devices already exist (for example, SCSI 0:3) you will add a
SCSI device to the existing adapter. To add a new adapter, you must select an unused device node (for
example 1:0).

6 Review your selections and click Finish.

New SCSI Controller (adding) and New SCSI Device (adding) appear in the Hardware list.

7 Click OK to save your changes and exit the dialog box.

8 Reopen the Virtual Machine Properties Editor.

9 Select the new SCSI controller and click Change Type.

10 Select VMware Paravirtualand click OK.

11 Click OK to save your changes and close the dialog box.

Network Virtual Machine Configuration
ESX/ESXi networking features provide communication between virtual machines on the same host, between
virtual machines on different hosts, and between other virtual and physical machines. The networking features
also allow management of ESX/ESXi hosts and provide communication between VMkernel services (NFS,
iSCSI, or VMware vMotion) and the physical network. When you configure networking for a virtual machine,
you select or change an adapter type, a network connection, and whether to connect the network when the
virtual machine powers on.

Network Adapter Types
When you configure a virtual machine, you can add network adapters (NICs) and specify the adapter type.

The type of network adapters that are available depend on the following factors:

n The virtual machine version, which depends on what host created it or most recently updated it.

n Whether the virtual machine has been updated to the latest version for the current host.

n The guest operating system.
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The following NIC types are supported:

E1000 Emulated version of the Intel 82545EM Gigabit Ethernet NIC, with drivers
available in most newer guest operating systems, including Windows XP and
later and Linux versions 2.4.19 and later.

Flexible Identifies itself as a Vlance adapter when a virtual machine boots, but initializes
itself and functions as either a Vlance or a VMXNET adapter, depending on
which driver initializes it. With VMware Tools installed, the VMXNET driver
changes the Vlance adapter to the higher performance VMXNET adapter.

Vlance Emulated version of the AMD 79C970 PCnet32 LANCE NIC, an older 10 Mbps
NIC with drivers available in most 32bit guest operating systems except
Windows Vista and later. A virtual machine configured with this network
adapter can use its network immediately.

VMXNET Optimized for performance in a virtual machine and has no physical
counterpart. Because operating system vendors do not provide built-in drivers
for this card, you must install VMware Tools to have a driver for the VMXNET
network adapter available.

VMXNET 2 (Enhanced) Based on the VMXNET adapter but provides high-performance features
commonly used on modern networks, such as jumbo frames and hardware
offloads. VMXNET 2 (Enhanced) is available only for some guest operating
systems on ESX/ESXi 3.5 and later.

VMXNET 3 Next generation of a paravirtualized NIC designed for performance. VMXNET
3 offers all the features available in VMXNET 2 and adds several new features,
such as multiqueue support (also known as Receive Side Scaling in Windows),
IPv6 offloads, and MSI/MSI-X interrupt delivery. VMXNET 3 is not related to
VMXNET or VMXNET 2.

For network adapter compatibility considerations, see the VMware Compatibility Guide.

Network Adapters and Legacy Virtual Machines
Legacy virtual machines are virtual machines that are supported by the product in use, but are not current for
that product. The default network adapter types for all legacy virtual machines depend on the adapters
available and compatible to the guest operating system and the version of virtual hardware on which the virtual
machine was created.

If you do not upgrade a virtual machine to correspond with an upgrade to a newer version of an ESX/ESXi
host, your adapter settings remain unchanged. If you upgrade your virtual machine to take advantage of newer
virtual hardware, your default adapter settings will likely change to be compatible with the guest operating
system and upgraded host hardware.

To verify the network adapters that are available to your supported guest operating system for a particular
version of vSphere ESX/ESXi, see the VMware Compatibility Guide.

Change the Virtual Network Adapter (NIC) Configuration
You can change the power-on connection setting, the MAC address, and the network connection for the virtual
network adapter configuration for a virtual machine.

Manually assigned MAC addresses for virtual machines on ESX/ESXi hosts must begin with the OUI 00:50:56.
The address must have the form 00:50:56:XX:YY:ZZ, where XX is a hexadecimal number between 00 and 3F,
and YY and ZZ are hexadecimal numbers between 00 and FF.
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Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the appropriate NIC in the Hardware list.

3 To connect the virtual NIC when the virtual machine is powered on, select Connect at power on.

4 Select an option for MAC address configuration.

n Select Automatic to assign a MAC address automatically.

n Select Manual and enter a MAC address to use a manual MAC address assignment.

5 Under Network connection, use the drop-down menu to select the network label you want the virtual
machine to use.

6 Click OK to save your changes and close the dialog box.

Add a Network Adapter to a Virtual Machine
When you add a Network adapter (NIC) to a virtual machine, you select the adapter type, the network
connection, and whether the device should connect when the virtual machine is powered on.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select Ethernet Adapter, and click Next.

4 Select an adapter type from the drop-down menu.

5 In the Network connection panel, select either a named network with a specified label or a legacy network.

6 To connect the virtual NIC when the virtual machine is powered on, select Connect at power on.

7 Click Next.

8 Review your selections and click Finish.

9 Click OK to save your changes and close the dialog box.

Parallel and Serial Port Configuration
Parallel and serial ports are interfaces for connecting peripherals to the virtual machine. The virtual serial port
can connect to a physical serial port or to a file on the host computer. You can also use it to establish a direct
connection between two virtual machines or a connection between a virtual machine and an application on
the host computer. You can add parallel and serial ports, change the serial port configuration, and configure
Fibre Channel NPIV settings for the virtual machine.

Change the Serial Port Configuration
A virtual machine can use up to four virtual serial ports. The virtual serial port can connect to a physical serial
port or to a file on the host computer. It can also be used to set up a direct connection between two virtual
machines or a connection between a virtual machine and an application on the host computer by using a host-
side-named pipe.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab, and select a Serial port in the Hardware list.
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3 (Optional) Change the Device status settings.

Option Description

Connected To connect or disconnect the device while the virtual machine is running.

Connect at power on To connect the device whenever you power on the virtual machine. You can
change this setting when the virtual machine is either powered on or
powered off.

 
4 Select a connection type.

Option Action

Use physical serial port SelectUse physical serial port for the virtual machine to use a physical serial
port on the host computer.

Use output file Select Use output file to send output from the virtual serial port to a file on
the host computer. Use the drop-down menu to select a serial port to use.

Use named pipe a Select Use named pipe to set up a direct connection between two virtual
machines or a connection between a virtual machine and an application
on the host computer.

b Use the default pipe name or enter another pipe name in the Pipe
Name list.

For a serial pipe for a virtual machine on an ESX/ESXi host,
type /tmp/socket or another UNIX socket name.

c Select the Near end and Far end of the pipe from the drop-down menus.

Connect over the network a Select Use network to connect through a remote network.
b Enter a Port URI or select Use Virtual Serial Port Concentrator (vSPC)

and enter the vSPC URI location.

Select the vSPC option if vSPC is used as an intermediate step to access
all virtual machines through a single IP address. The URI is the remote
end of the serial port to which the virtual machine's serial port should
connect.

 
5 Select an I/O Mode.

n To maintain best performance for applications on the host, select Yield CPU on poll and click Next.

This option forces the affected virtual machine to use interrupt mode, which yields CPU time if the
only task it is trying to do is poll the virtual serial port.

n Deselect Yield CPU on Poll to configure this serial port to use interrupt mode as opposed to polled
mode and click Next.

Polled mode is of interest primarily to developers who are using debugging tools that communicate
over a serial connection. Polled mode causes the virtual machine to consume a disproportionate share
of CPU time. This makes the host and other guests run sluggishly.

6 Click OK to save your changes and close the dialog box.

Add a Serial Port to a Virtual Machine
When you add a serial port to a virtual machine, you can use a physical serial port on the host, an output file,
or a named pipe.

You can configure a virtual serial port in several ways.

Use physical serial port
on the host

Uses an external modem or a hand-held device in your virtual machine.

Output to file Captures the data that a program running in the virtual machine sends to the
virtual serial port.
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Connect to a named pipe Enables two virtual machines or a virtual machine and a process on the host to
communicate as if they were physical machines connected by a serial cable. For
example, this can be used for remote debugging on a virtual machine.

Connect via a remote
network

Enables a serial connection to and from a virtual machine's serial port over the
network.

Virtual Serial Port Concentrator (vSPC) aggregates traffic from multiple serial
ports onto one management console. It behaves similarly as physical serial port
concentrators. Using a vSPC also allows network connections to a virtual
machine's serial ports to migrate seamlessly when the virtual machine is
migrated using vMotion.

Prerequisites

Verify that the virtual machine is powered off.

Required privilege: Virtual Machine .Configuration.Add or Remove Device

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select Add.

3 Select Serial Port, and click Next.

4 On the Serial Port Type page, select the type of media for the port to access.

Option Action

Use physical serial port on the host Click Next and select the port on the host computer that you want to use for
this serial connection from the drop-down menu.

Output to file Click Next and browse to the location of the file on the host to store the output
of the virtual serial port.

Connect to named pipe a Click Next and in the Pipe Name and Attributes panel, use the default
pipe name or enter another pipe name.

b Select the Near end and Far end of the pipe from the drop-down menus.

Connect over the Network a Click Next and select Server or Client.
b Enter a Port URI or select Use Virtual Serial Port Concentrator (vSPC)

and enter the vSPC URI location.

Select the vSPC option if vSPC is used as an intermediate step to access
all virtual machines through a single IP address. The URI is the remote
end of the serial port to which the virtual machine's serial port should
connect.

 
5 (Optional) Change the Device status settings.

Option Description

Connected Connects or disconnects the device while the virtual machine is running.

Connect at power on Connects the device whenever you power on the virtual machine. You can
change this setting when the virtual machine is either powered on or
powered off.
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6 Select an I/O Mode.

n To maintain best performance for applications on the host, select Yield CPU on poll and click Next.

This option forces the affected virtual machine to use interrupt mode, which yields CPU time if the
only task it is trying to do is poll the virtual serial port.

n Deselect Yield CPU on Poll to configure this serial port to use interrupt mode as opposed to polled
mode and click Next.

Polled mode is of interest primarily to developers who are using debugging tools that communicate
over a serial connection. Polled mode causes the virtual machine to consume a disproportionate share
of CPU time. This makes the host and other guests run sluggishly.

7 Review the information on the Ready to Complete page, and click Finish.

Change the Parallel Port Configuration
You can use a physical parallel port or an output file to configure a parallel port for a virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the appropriate Parallel port in the Hardware list.

3 (Optional) Deselect Connect at power on if you do not want the parallel port device to be connected when
the virtual machine powers on.

4 Select the type of media you would like the parallel port to access.

n If you select Use physical parallel port on the host, select the port from the drop-down menu.

n If you select Output to file, browse to the location of the file.

5 Click OK to save your changes and close the dialog box.

Add a Parallel Port to a Virtual Machine
When you add a parallel port to a virtual machine, you can use a parallel port on the host or an output file.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select Add.

3 Select Parallel Port and click Next.

4 Select the type of media that you would like the parallel port to access.

Option Action

Use Physical parallel port on the host a Click Next.
b Select the port from the drop-down menu.

Output to file a Click Next.
b Browse to the location of the file.

 
5 (Optional) In the Device status panel, deselect Connect at power on if you do not want the parallel port

device to be connected when the virtual machine powers on.

6 Click Next.

7 Review the information on the Ready to Complete page, and click Finish.

8 Click OK to save your changes and close the dialog box.
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Configure Fibre Channel NPIV Settings
N-port ID virtualization (NPIV) provides the ability to share a single physical Fibre Channel HBA port among
multiple virtual ports, each with unique identifiers. This capability lets you control virtual machine access to
LUNs on a per-virtual machine basis.

Each virtual port is identified by a pair of world wide names (WWNs): a world wide port name (WWPN) and
a world wide node name (WWNN). These WWNs are assigned by vCenter Server.

For detailed information on how to configure NPIV for a virtual machine, see the Fibre Channel SAN
Configuration Guide.

NPIV support is subject to the following limitations:

n NPIV must be enabled on the SAN switch. Contact the switch vendor for information about enabling NPIV
on their devices.

n NPIV is supported only for virtual machines with RDM disks. Virtual machines with regular virtual disks
continue to use the WWNs of the host’s physical HBAs.

n The physical HBAs on the ESX host must have access to a LUN using its WWNs in order for any virtual
machines on that host to have access to that LUN using their NPIV WWNs. Ensure that access is provided
to both the host and the virtual machines.

n The physical HBAs on the ESX host must support NPIV. If the physical HBAs do not support NPIV, the
virtual machines running on that host will fall back to using the WWNs of the host’s physical HBAs for
LUN access.

n Each virtual machine can have up to 4 virtual ports. NPIV-enabled virtual machines are assigned exactly
4 NPIV-related WWNs, which are used to communicate with physical HBAs through virtual ports.
Therefore, virtual machines can utilize up to 4 physical HBAs for NPIV purposes.

You can view or edit the virtual machines WWNs on the Options tab.

Prerequisites

n To edit the virtual machine’s WWNs, power off the virtual machine.

n Verify that the virtual machine has a datastore containing a LUN that is available to the host.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced select Fibre Channel NPIV.

3 (Optional) Select the Temporarily Disable NPIV for this virtual machine check box.

4 Assigned WWNs appear in the WWN Assignments panel.

n To leave WWNs unchanged, select Leave unchanged.

n To have vCenter Server or the ESX host generate new WWNs, select Generate New WWNs.

n To remove the current WWN assignments, select Remove WWN assignment.

5 Click OK to save your changes and close the dialog box.

6 Provide the WWN assignments to your SAN administrator.

The administrator needs the assignments to configure virtual machine access to the LUN.

vSphere Virtual Machine Administration Guide

98  VMware, Inc.



Other Virtual Machine Device Configuration
In addition to configuring virtual machine CPU and Memory and adding a hard disk and virtual NICs, you
can also add and configure virtual hardware, such as DVD/CD-ROM drives, floppy drives, and SCSI devices.
Not all devices are available to add and configure. For example, you cannot add video devices, but you can
configure available video devices. video cards, and PCI devices.

Change the DVD/CD-ROM Drive Configuration
You can configure DVD/CD-ROM devices to connect to client devices, host devices, or Datastore ISO files.

Configure a Client Device Type for the DVD/CD-ROM Drive
You can connect the DVD/CD-ROM device to a physical DVD or CD-ROM device on the system running the
vSphere Client.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the DVD/CD-ROM drive.

3 Select or deselect the Connected check box to connect or disconnect the device.

4 If you do not want the CD-ROM drive connected when the virtual machine starts, deselect Connect at
power on.

5 Select the Client Device under Device Type.

6 Select the mode used for the connection.

n Passthrough IDE (raw). Use mode only for remote client device access.

n Emulate IDE. Use to access a host CD-ROM device.

The host CD-ROM device is accessed through emulation mode. Passthrough mode is not functional for
local host CD-ROM access. You can write or burn a remote CD only through pass-through mode access,
but in emulation mode you can only read a CD-ROM from a host CD-ROM device.

7 In the drop-down menu under Virtual Device Node, select the node the drive uses in the virtual machine.

8 Click OK to save your changes and close the dialog box.

What to do next

To connect this device, you must power on the virtual machine, then click the Connect CD/DVD button in the
toolbar.

Configure a Host Device Type for the DVD/CD-ROM Drive
You can connect the DVD/CD-ROM device to a physical DVD or CD-ROM device that resides on the host.

When you add a CD/DVD-ROM drive that is backed by USB CD/DVD drive on the host, you must add the
drive as a SCSI device. Hot adding and removing SCSI devices is not supported.

You cannot use vMotion to migrate virtual machines that have CD drives that are backed by the physical CD
drive on the host. You must disconnect these devices before you migrate the virtual machine.

Prerequisites

Verify that the host is powered off before you add USB CD/DVD-ROM devices.
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Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the DVD/CD-ROM drive.

3 Select or deselect the Connected check box to connect or disconnect the device.

4 If you do not want the CD-ROM drive connected when the virtual machine starts, deselect Connect at
power on.

5 Select Host Device under Device Typeand select a device from the drop-down menu.

6 In the drop-down menu under Virtual Device Node, select the node the drive uses in the virtual machine.

7 Click OK to save your changes and close the dialog box.

Configure a Datastore ISO File for the DVD/CD-ROM Drive
You can connect the DVD/CD-ROM device to an ISO file that is stored on a datastore accessible to the host.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the DVD/CD-ROM drive.

3 Select or deselect the Connected check box to connect or disconnect the device.

4 If you do not want the CD-ROM drive connected when the virtual machine starts, deselect Connect at
power on.

5 Select Datastore ISO File under Device Type and click Browse to navigate to the file.

6 In the drop-down menu under Virtual Device Node, select the node the drive uses in the virtual machine.

7 Click OK to save your changes and close the dialog box.

Add a DVD or CD-ROM Drive to a Virtual Machine
You can use a physical drive on a client or host or you can use an ISO image to add a DVD/CD-ROM drive to
a virtual machine.

If you are adding a CD/DVD-ROM drive that is backed by USB CD/DVD drive on the host, you must add the
drive as a SCSI device. Hot adding and removing SCSI devices is not supported.

You cannot use vMotion to migrate virtual machines that have CD drives that are backed by the physical CD
drive on the host. You must disconnect these devices before you migrate the virtual machine.

Prerequisites

Verify that the host is powered off before you add USB CD/DVD-ROM devices.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Select the Hardware tab and click Add.

3 Select DVD/CD-ROM Drive, and click Next.
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4 Select one option.

Option Description

Use physical drive a Select Client or Host as the location.
b Select the drive you want to use from the drop-down menu.
c Select aPass through (recommended) or ATAPI emulation connection

type.

Use ISO Image Enter the path and filename for the image file, or click Browse to navigate to
the file.

 
5 If you do not want the CD-ROM drive connected when the virtual machine starts, deselect Connect at

power on.

6 Click Next.

7 Select the virtual device node the drive uses in the virtual machine and click Next.

8 Review the information on the Ready to Complete window, and click Finish or clickBack to change the
settings.

9 Click OK to save your changes and close the dialog box.

Change the Floppy Drive Configuration
Use the Hardware tab in the Virtual Machine Properties dialog box to configure a floppy drive for a virtual
machine.

You cannot use vMotion to migrate virtual machines that have floppy drives that are backed by the physical
floppy drive on the host. You must disconnect these devices before you migrate the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the Floppy drive.

3 Under Device Status, select Connect at power on to connect this virtual machine to the floppy drive when
the virtual machine is powered on.

4 Select the device type to use for this virtual device.

Option Description

Client Device Select this option to connect the floppy device to a physical floppy device on
the system running the vSphere Client.
To connect the device, you must click the Connect Floppy button in the
toolbar when you power on the virtual machine.

Host Device a Select this option to connect the floppy device to a physical floppy device
on the host.

b Select the specific device from the drop-down list.

Use existing floppy image in
datastore

a Select this option to connect the virtual device to an existing floppy image
on a datastore accessible to the host.

b Click Browse and select the floppy image.

Create new floppy image in datastore a Select this option to create a new floppy image on a datastore accessible
to the host.

b Click Browse and browse to the location for the floppy image.
c Enter a name for the floppy image and click OK.

 
5 Click OK to save your changes and close the dialog box.
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Add a Floppy Drive to a Virtual Machine
Use a physical floppy drive or a floppy image to add a floppy drive to a virtual machine.

You cannot use vMotion to migrate virtual machines that have floppy drives that are backed by the physical
floppy drive on the host. You must disconnect these devices before you migrate the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Select the Hardware tab and click Add.

3 Select Floppy Drive, and click Next.

4 Select the type of floppy media to use:

n Use a physical floppy drive to give the guest access to the floppy on the host.

n Use a floppy image, which is a file on the host that stores data in the same format as a physical floppy
disk.

n Create a blank floppy image to use a blank floppy image.

5 Click Next.

6 Select the location of the floppy drive or image.

n Use a physical floppy drive. Select either client or host as the device location and select the drive
from the drop-down menu.

n Use a floppy image. Browse to the floppy image.

n Create a blank floppy image. Browse to the floppy image.

7 To have the floppy drive connected to the virtual machine when you power it on, select Connect at power
on.

8 Click Next.

9 Review the information on the Ready to Complete page, and click Finish.

10 Click OK to save your changes and close the dialog box.

Add a SCSI Device to a Virtual Machine
You can add a SCSI device to a virtual machine through the Add Hardware wizard.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select Add.

3 Select SCSI Device and click Next.

4 Under Connection, use the drop-down menu to select a physical device.

5 To connect this virtual machine to the server’s SCSI device when the virtual machine is powered on, select
Connect at power on.

6 Under Virtual device node, select the virtual device node where you want this device to appear in the
virtual machine.

You can also select the check box to indicate that the virtual device is set up in the same way as the physical
unit.
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7 Review the information in the Ready to Complete page, and click Finish.

8 Click OK to save your changes and close the dialog box.

Change the SCSI Device Configuration
You can change the physical device and the virtual device node of the SCSI device connection.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select a SCSI device in the Hardware list.

3 Under Connection, select the physical device you want to use.

Under Virtual device node, select the virtual device node where you want this device to appear in the
virtual machine.

4 Click OK to save your changes and close the dialog box.

Add a PCI Device
VMDirectPath I/O allows a guest operating system on a virtual machine to directly access physical PCI and
PCIe devices connected to a host. Each virtual machine can be connected to up to six PCI devices.

PCI devices connected to a host can be marked as available for passthrough from the Hardware Advanced
Settings in the Configuration tab for the host.

Prerequisites

n To use VMDirectPath, verify that the host has Intel® Virtualization Technology for Directed I/O (VT-d) or
AMD I/O Virtualization Technology (IOMMU) enabled in the BIOS.

n Verify that the PCI devices are connected to the host and marked as available for passthrough.

n Verify that the virtual machine is using hardware version 7.

Procedure

1 Select the virtual machine from the inventory panel and click Virtual Machine > Edit Settings.

2 On the Hardware tab, click Add.

3 In the Add Hardware wizard, select PCI Device and click Next.

4 Select the passthrough device to connect to the virtual machine from the drop-down list and click Next.

5 Click Finish.

Configure the Virtual Machine Communication Interface
The Virtual Machine Communication Interface (VMCI) provides a high-speed communication channel
between a virtual machine and the ESX/ESXi host that it runs on. You can also enable VMCI for communication
between virtual machines that run on the same host.

Prerequisites

Verify that the virtual machine is using hardware version 7.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 On the Hardware Tab, select VMCI device.
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3 Select the Enable VMCI Between VMs check box.

4 Click OK to save your changes and close the dialog box.

Virtual machine communication is no longer restricted to the host it runs on. Other virtual machines that run
on the same host can now communicate with the unrestricted virtual machine.

Configure Video Cards
You can change the virtual video card memory allocation. You cannot add or remove video cards or change
the number of displays.

Procedure

1 In the vSphere Client inventory, right-click a virtual machine and select Edit Settings.

2 Click the Hardware tab and select Video card.

3 Select the Memory required for virtual machine display.

Option Description

Auto-detect video settings Applies common video settings to the guest operating system.

Reserve memory n Display Resolution
n Color Depth

Enter Total video RAM The default setting for total video RAM is 4MB, which is sufficient for a
maximum screen resolution of 1176x885. For higher screen resolutions, set
this option to 16MB.

 
4 Click OK to save your changes and close the dialog box.

USB Device Passthrough Configuration from an ESX/ESXi Host to a
Virtual Machine

You can add multiple USB devices, such as security dongles and mass storage devices, to a virtual machine
that runs on an ESX/ESXi host to which the devices are physically attached. Knowledge of device components
and their behavior, virtual machine requirements, feature support, and ways to avoid data loss can help make
USB device passthrough from an ESX/ESXi host to a virtual machine successful.

How USB Device Passthrough Technology Works
When you attach a USB device to a physical host, the device is available only to virtual machines that run on
that host. The device cannot connect to virtual machines that run on another host in the datacenter

A USB device is available to only one virtual machine at a time. When a device is connected to a powered-on
virtual machine, it is not available to connect to other virtual machines that run on the host. When you remove
the active connection of a USB device from a virtual machine, it becomes available to connect to other virtual
machines that run on the host. host.

Connecting a USB passthrough device to a virtual machine that runs on the ESX/ESXi host to which the device
is physically attached requires an arbitrator, a controller, and a physical USB device or device hub.

USB Arbitrator Manages connection requests and routes USB device traffic. The arbitrator is
installed and enabled by default on ESX/ESXi hosts. It scans the host for USB
devices and manages device connection among virtual machines that runs on
the host. It routes device traffic to the correct virtual machine instance for
delivery to the guest operating system. The arbitrator monitors the USB device
and prevents other virtual machines from using it until you release it from the
virtual machine it is connected to.
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If vCenter Server polling is delayed, a device that is connected to one virtual
machine might appear as though it is available to add to another virtual
machine. In such cases, the arbitrator prevents the second virtual machine from
accessing the USB device.

USB Controller The USB hardware chip that provides USB function to the USB ports that it
manages. The virtual USB Controller is the software virtualization of the USB
host controller function in the virtual machine.

USB controller hardware and modules that support USB 2.0 and USB 1.1
devices must exist on the host. Only one virtual USB controller is available to
each virtual machine. The controller supports multiple USB 2.0 and USB 1.1
USB devices in the virtual computer. The controller must be present before you
can add USB devices to the virtual machine.

The USB arbitrator can monitor a maximum of 15 USB controllers. Devices
connected to controllers numbered 16 or greater are not available to the virtual
machine.

USB Devices You can add up to 20 USB devices to a virtual machine. This is the maximum
number of devices supported for simultaneous connection to one virtual
machine. The maximum number of USB devices supported on a single
ESX/ESXi host for simultaneous connection to one or more virtual machines is
also 20. VMware provides support for multiple USB devices.

For a list of supported USB devices for passthrough from an ESX/ESXi host to
a virtual machine, see the VMware knowledge base article at 
http://kb.vmware.com/kb/1021345.

USB Passthrough Device Autoconnect Feature
When you add a USB device connection to a virtual machine, the autoconnect feature is enabled for this device
connection. It is not disabled until you remove the device connection from the virtual machine.

With autoconnect enabled, the device connection automatically re-establishes in the following cases:

n The virtual machine is cycling through power operations, such as Power Off/Power On, Reset,
Pause/Resume.

n The device is unplugged from the host then plugged back in to the same USB port.

n The device is power cycled but has not changed its physical connection path.

n The device is mutating identity during a different stage of usage.

The USB passthrough autoconnect feature identifies the device by using the USB path of the device on the host.
That is, it uses the physical topology and port location, rather than the device identity. This feature can seem
confusing if you expect the autoconnect feature to match the connection target by device ID.

If the same device is plugged back in to the host through a different USB path (that is, a different port), it will
not be able to automatically re-establish connection with the virtual machine. If you unplug the device from
the host and plug in a different device to the same USB path, the new device appears and is connected to the
virtual machine by the autoconnect feature enabled by the previous device connection.

Autoconnect is useful in cases where devices mutate during usage. For example, for iPhones and other such
devices, the device VID:PID changes during software or firmware upgrades. The upgrade process disconnects
and reconnects the devices to the USB port.
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The USB port is speed-specific. The autoconnect feature assumes that devices do not transition from USB 1.1
(low/full speed) to USB 2.0 (high speed) or the reverse. You cannot interchange USB 2.0 high speed devices
with USB 1.1 devices. For example, you might connect a USB 2.0 high-speed device to a port and connect that
device to the virtual machine. If you unplug the device from the host and plug a USB 1.1 device into the same
port, the device does not connect to the virtual machine.

For a list of supported USB devices for passthrough from an ESX/ESXi host to a virtual machine, see the VMware
knowledge base article at  http://kb.vmware.com/kb/1021345.

VMware Features Available with USB Device Passthrough
Migration with vMotion and DRS are supported with USB device passthrough from an ESX/ESXi host to a
virtual machine.

The features listed in Table 7-6 are available with USB device passthrough.

Table 7-6.  VMware Features Available for USB Passthrough from an ESX/ESXi Host to a Virtual Machine

Feature Supported with USB Device Passthrough

Distributed power management No

DRS Yes

Fault Tolerance No

vMotion Yes

If all USB devices connected to a virtual machine have vMotion support enabled, you can migrate that virtual
machine with the connected USB devices. For details, see “Configuring USB Passthrough Devices for
vMotion,” on page 109.

If a host with connected USB devices resides in a DRS cluster with distributed power management (DPM)
enabled, you must disable DPM for that host. Otherwise DPM might turn off the host with the device, which
would disconnect the device from the virtual machine that is using it.

Virtual Machine Functions that Can Result in Data Loss with USB Devices
Virtual machine functions can affect USB device behavior. Before you start the following tasks, be aware of
how the operation affects USB device connections.

n Before you hot add memory, CPU, or PCI devices, you must remove any USB devices. Hot adding these
resources disconnects USB devices, which might result in data loss.

n Before you suspend a virtual machine, make sure that a data transfer is not in progress. During the
suspend/resume process, USB devices behave as if they have been disconnected, then reconnected. For
information about suspend and resume behavior after migration with vMotion, see “Configuring USB
Passthrough Devices for vMotion,” on page 109.

n Before you change the state of the arbitrator, make sure that USB devices residing on the host are not
attached to a virtual machine. If USB devices become unavailable to a virtual machine, it is possible that
a host administrator has disabled the arbitrator. When an administrator stops or disconnects the arbitrator
for troubleshooting or other purposes, USB devices attached to that host become unavailable to the virtual
machine. If a data transfer is taking place at this time, you might lose the data. To reestablish the arbitrator,
the administrator must reboot the host.
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Setting Up Physical USB Connections on an ESX/ESXi Host
You can connect and chain multiple USB hubs and devices to an ESX/ESXi host. Careful planning and
knowledge of hub behavior and limitations can help ensure that your devices work optimally.

USB physical bus topology defines how USB devices connect to the host. Support for USB device passthrough
to a virtual machine is available if the physical bus topology of the device on the host does not exceed tier
seven. The first tier is the USB host controller and root hub. The last tier is the target USB device. You can
cascade up to five tiers of external (or internal) hubs between the root hub and the target USB device. An
internal USB hub attached to the root hub or built into a compound device counts as one tier.

The quality of the physical cables, hubs, devices, and power conditions can affect USB device performance. To
ensure the best results, keep the host USB bus topology as simple as possible for the target USB device, and
use caution when you deploy new hubs and cables into the topology. The following conditions can affect USB
behavior:

n Communication delay between the host and virtual machine increases as the number of cascading hubs
increases.

n Connecting or chaining multiple external USB hubs increases device enumeration and response time,
which can introduce uncertainly to the power support to the connected USB devices.

n Chaining hubs together also increases the chance of port and hub error, which can cause the device to lose
connection to a virtual machine.

n Certain hubs can cause USB device connections to be unreliable, so use care when you add a new hub to
an existing setup. Connecting certain USB devices directly to the host rather than to a hub or extension
cable might resolve their connection or performance issues.

NOTE   To prevent additional problems, be aware of the physical constraints of long-term deployment in a
machine room environment. Small devices are easily damaged by being stepped on or knocked loose.

In some cases, you must hard reset the device and hub to restore the device to a working state.

For a list of supported USB devices for passthrough from an ESX/ESXi host to a virtual machine, see the VMware
knowledge base article at  http://kb.vmware.com/kb/1021345.

USB Compound Devices
For compound devices, the virtualization process filters out the USB hub so that it is not visible to the virtual
machine. The remaining USB devices in the compound appear to the virtual machine as separate devices. You
can add each device to the same virtual machine or to different virtual machines if they run on the same host.

For example, the Aladdin HASP HL Drive USB dongle package contains three devices (0529:0001 HASP dongle,
13fe:1a00 Hub, 13fe:1d00 Kingston Drive). The Virtualization process filters out the USB hub. The remaining
Aladdin HASP HL Drive USB dongle devices (one Aladdin HASP dongle and one Kingston Drive) appear to
the virtual machine as individual devices. You must add each device separately to make it accessible to the
virtual machine.

USB CD/DVD-ROM Devices
The host treats USB CD/DVD-ROM devices as SCSI devices. Hot adding and removing these devices is not
supported.
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Add USB Devices to an ESX/ESXi Host
You can add multiple USB devices to ESX/ESXi hosts so that virtual machines that run on the hosts can access
the devices. The number of devices that you can add depends on several factors, such as how the devices and
hubs connect (chain) together and the device type.

Each ESX/ESXi host has several USB ports. The number of ports on each host depends on the physical setup
of the host. When you calculate the depth of hub chaining, remember that on a typical server the front ports
connect to an internal hub.

The USB arbitrator can monitor a maximum of 15 USB controllers. If your system includes controllers that
exceed the 15 controller limit and you connect USB devices to them, the devices are not available to the virtual
machine.

The host treats USB CD/DVD-ROM devices as SCSI devices. Hot adding and removing these devices is not
supported.

Prerequisites

n If a host has attached USB devices and resides in a DRS cluster with DPM enabled, disable DPM for that
host. See the Resource Management Guide for instructions about overriding the default DPM setting for an
individual host.

n Make sure that you know the virtual machine requirements for USB devices. See “Setting Up Physical
USB Connections on an ESX/ESXi Host,” on page 107.

n Verify that the host is powered off before you add USB CD/DVD-ROM devices.

Procedure

u To add a USB device to an ESX/ESXi host, connect the device to an available port or hub.

Allow several minutes for vCenter Server to capture the state of the USB device. vCenter Server polling
delays can cause a lag between the time the physical USB device is attached to the host and when it appears
in the virtual machine Add Hardware wizard.

The USB device appears in the virtual machine Add Hardware wizard device list.

What to do next

You can now add the device to the virtual machine.

Add a USB Controller to a Virtual Machine
By default, a USB controller is available to a virtual machine if the host supports USB passthrough from an
ESX/ESXi host to a virtual machine. You can add only one virtual USB controller to each virtual machine.

The USB arbitrator can monitor a maximum of 15 USB controllers. If your system includes controllers that
exceed the 15 controller limit and you connect USB devices to them, the devices are not available to the virtual
machine.

Prerequisites

n The controller must be present. Add a USB controller, if needed.

n ESX/ESXi hosts must have USB controller hardware and modules that support USB 2.0 and USB 1.1 devices
present.

Required Privilege: Virtual Machine.Configuration.Add or Remove Device
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Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select USB Controller and click Next.

4 Review the device information and click Next.

5 ClickFinish.

New USB Controller (adding) appears in the hardware list as Present.

6 Click OK to save your changes and close the dialog box.

When you reopen the Properties Editor, the controller appears on the Hardware tab.

What to do next

Add one or more USB devices to the virtual machine.

Configuring USB Passthrough Devices for vMotion
You can migrate a virtual machine to another ESX/ESXi host in the same datacenter and maintain the USB
passthrough device connections to the original host.

If a virtual machine has USB devices attached that pass through to an ESX/ESXi host, you can migrate that
virtual machine with the devices attached.

For a successful migration, review the following conditions:

n You must configure all USB passthrough devices connected to a virtual machine for vMotion. If one or
more devices is not configured for vMotion, the migration cannot proceed. For troubleshooting details,
see “Error Message When You Try to Migrate Virtual Machine with USB Devices Attached,” on
page 111.

n When you migrate a virtual machine with attached USB devices away from the host to which the devices
are connected, the devices remain connected to the virtual machine. However, if you suspend or power
off the virtual machine, the USB devices are disconnected and cannot reconnect when the virtual machine
is resumed. The device connections can be restored only if you move the virtual machine back to the host
to which the devices are attached.

n If you resume a suspended virtual machine that has a Linux guest operating system, the resume process
might mount the USB devices at a different location on the file system.

n If a host with attached USB devices resides in a DRS cluster with distributed power management (DPM)
enabled, disable DPM for that host. Otherwise DPM might turn off the host with the attached device,
which would disconnect the device from the virtual machine.

For additional vMotion configuration parameters and limitations for virtual machine migration, see the
Datacenter Administration Guide.

Add a USB Passthrough Device to a Virtual Machine
You can add one or more USB passthrough devices to a virtual machine. The physical devices must be
connected to the ESX/ESXi host on which the virtual machine runs.

Prerequisites

n Verify that the virtual machine is using hardware version 7 or later.

n If a USB device is connected to another virtual machine, you cannot add it until that machine releases it.

Chapter 7 Configuring Virtual Machines

VMware, Inc.  109



n The USB controller must be present. Add a USB controller, if needed. See “Add a USB Controller to a
Virtual Machine,” on page 108.

n Make sure that you know the virtual machine requirements for USB devices. See “USB Device Passthrough
Configuration from an ESX/ESXi Host to a Virtual Machine,” on page 104.

To use vMotion to migrate a virtual machine with multiple USB devices, you must enable all attached USB
devices for vMotion. You cannot migrate individual USB devices. For vMotion limitations, see “Configuring
USB Passthrough Devices for vMotion,” on page 109.

If you do not plan to migrate a virtual machine with USB devices attached, deselect the Support vMotion
option when you add the USB device. This reduces migration complexity, which results in better performance
and stability.

Required privileges: Virtual Machine.Configuration.HostUSBDevice

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select USB Device and click Next.

4 (Optional) Select Support vMotion while device is connected.

5 Select the device that you want to add.

You can add multiple USB devices, but only one device at a time.

6 Click Finish.

New USB Device (adding) appears in the hardware list as Present.

7 Click OK to save your changes and close the dialog box.

When you reopen the Properties editor, the USB device appears on the Properties Editor Hardware tab. The
device type and ID appear in the right pane.

Remove a USB Device from a Virtual Machine
When you remove a USB device from a virtual machine, it reverts to the host and becomes available to other
virtual machines that run on that host.

To minimize the risk of data loss, follow the instructions to safely unmount or eject hardware for your operating
system. Safely removing hardware allows accumulated data to be transmitted to a file. Windows operating
systems typically include a "Remove Hardware" icon located in the System Tray. Linux operating systems use
the umount command.

NOTE   It might be necessary to use the sync command instead of or in addition to the umount command, for
example after you issue a dd command on Linux or other UNIX operating systems.

Procedure

1 Unmount or eject the USB device from the guest operating system.

2 Right-click the virtual machine and select Edit Settings.

3 Click the Hardware tab and select the USB device.

4 Click Remove and click OK to save your changes and close the dialog box.
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Remove a USB Controller from a Virtual Machine
You can remove the USB controller from the virtual machine if you do not want to connect to USB passthrough
devices on the ESX/ESXi host.

Prerequisites

Verify that all USB devices are removed from the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select USB controller.

3 Click Remove.

4 Click OK to save your changes and close the dialog box.

The controller is no longer connected to the virtual machine, but remains available to add at a later time.

Remove USB Devices from an ESX/ESXi Host
You can remove USB devices from the host if you must shut down the host for maintenance or if you do not
want those devices to be available to virtual machines that run on the host. When you detach a USB device
from the host, the device disconnects from the virtual machine.

Use caution when you remove USB devices from a host, for example, when you plan to do maintenance on
the host. The device might still be connected to a virtual machine that migrated to another host. If data transfer
is taking place, you can lose data. Also use caution when you stop or disconnect the USB arbitrator. When you
disable the arbitrator, devices connected to the virtual machine become unavailable.

Prerequisites

Make sure that the USB devices are not in use.

Procedure

u Follow the device manufacturers instructions to safely remove the device.

When you remove the device from the host, it is no longer available to the virtual machines that run on
the host.

Troubleshooting USB Passthrough Devices
Information about feature behavior can help you troubleshoot or avoid potential problems when USB devices
are connected to a virtual machine.

Error Message When You Try to Migrate Virtual Machine with USB Devices Attached
Migration with vMotion cannot proceed and issues a confusing error message when multiple USB passthrough
devices are connected to the virtual machine and one or more devices are not enabled for vMotion.

Problem

The Migrate Virtual Machine wizard runs a compatibility check before a migration operation begins. If
unsupported USB devices are detected, the compatibility check fails and an error message similar to the
following appears: Currently connected device 'USB 1' uses backing 'path:1/7/1', which is not
accessible.

Chapter 7 Configuring Virtual Machines

VMware, Inc.  111



Cause

You must select all USB devices on a virtual machine for migration for vMotion to be successful. If one or more
devices are not enabled for vMotion, migration will fail.

Solution

1 Make sure that the devices are not in the process of transferring data before removing them.

2 Re-add and enable vMotion for each affected USB device.

USB Passthrough Device Is Nonresponsive
USB devices can become nonresponsive for several reasons, including unsafely interrupting a data transfer or
if a guest operating system driver sends an unsupported command to the device.

Problem

The USB device is nonresponsive.

Cause

A data transfer was interrupted or nonsupported devices are being used. For example, if a guest driver sends
a SCSI REPORT LUNS command to some unsupported USB flash drives, the device stops responding to all
commands.

Solution

1 Physically detach the USB device from the ESX/ESXi host and reattach it.

2 Fully shut down the host (not reset) and leave it powered off for at least 30 seconds to ensure that the host
USB bus power is fully powered down.

Manage Power Management Settings for a Virtual Machine
You can set the power options so that a virtual machine is suspended or remains powered on when the guest
operating system is placed on standby.

Power Management options are not available on every guest operating system. Wake on LAN supports only
Windows guest operating systems and is not available on Vlance NICs, or when a Flexible NIC is operating
in Vlance mode (that is, the current VMware Tools are not installed on the guest operating system).

Wake on LAN can resume virtual machines that are in an S1 sleep state only. It cannot resume suspended,
hibernated, or powered off virtual machines.

The following NICs support Wake on LAN:

n Flexible (VMware Tools required).

n vmxnet

n Enhanced vmxnet

n vmxnet 3

Prerequisites

You must power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select Power Management.
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3 In the Guest Power Management panel, select a power option.

n Suspend the virtual machine

n Put the guest operating system in standby mode and leave the virtual machine powered on

4 (Optional) Select Wake on LAN for virtual machine traffic on and select the virtual NICs to trigger this
action.

Unsupported NICs might be listed, but are unavailable to connect.

5 Click OK to save your changes and close the dialog box.

Configure the Virtual Machine Power States
Changing virtual machine power states is useful when you do maintenance on the host. You can use the system
default settings for the toolbar power controls or you can configure the controls to interact with the guest
operating system. For example, you can configure the stop button on the toolbar to power off the virtual
machine or shut down the guest operating system.

You can modify many virtual machine configurations while the virtual machine is running, but you might
need to change the virtual machine power state for some configurations.

Table 7-7 lists available power buttons and describes their behavior.

Table 7-7.  Virtual Machine Power Button Settings

Power Button Description

Shuts down the guest operating system or powers off the virtual machine. A
power off operation displays a confirmation dialog box indicating that the guest
operating system might not shut down properly. Use this power off option only
when necessary.

Suspends the virtual machine without running a script when VMware Tools is
not installed. When VMware Tools is installed and available, a suspend action
runs a script, and suspends the virtual machine.

Powers on a virtual machine when a virtual machine is stopped, or resumes the
virtual machine and runs a script when it is suspended and VMware Tools is
installed and available. Resumes the virtual machine and does not run a script
when VMware Tools is not installed.

Resets the virtual machine when VMware Tools is not installed. Restarts the guest
operating system when VMware Tools is installed and available. A reset
operation displays a confirmation dialog box indicating that the guest operating
system is not shut down properly.

Prerequisites

n Verify that the vSphere Client is logged in to a vCenter Server.

n Verify that you have access to at least one virtual machine in the inventory.

n Verify that you have privileges to perform the intended power operation on the virtual machine.

n To set optional power functions, you must install VMWare Tools in the virtual machine.

n Power off the virtual machine before editing the VMware Tools options.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select VMware Tools.

3 In the right panel, select the Power Controls for the virtual machine.
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4 Select an option for the Power Off button.

Option Description

Shut Down Guest Uses VMware Tools to initiate an orderly system shut down of the virtual
machine. This type of powering off is known as a "soft" power operation. Soft
power operations are possible only if the tools are installed in the guest
operating system.

Power Off Immediately stops the virtual machine. This type of powering off is known
as a "hard" power operation.

System Default Follows system settings. The current value of the system settings is shown
in parentheses.

 
5 Select an option for the Suspend button.

Option Description

Suspend Pauses all virtual machine activity.

System Default Follows system settings. The current value of the system setting is shown in
parentheses.

 
6 Select an option for the Reset button.

Option Description

Restart Guest Uses VMware Tools to initiate an orderly reboot. (This type of reset is known
as a "soft" power operation. Soft power operations are possible only if the
tools are installed in the guest operating system.)

Reset Shuts down and restarts the guest operating system without powering off
the virtual machine. (This type of reset is known as a "hard" power
operation.)

System Default Follows system settings; the current value of the system setting is shown in
parentheses.

 
7 Click OK to save your changes and close the dialog box.

What to do next

Configure VMware Tools scripts to run before or after power operations.

Configuring Troubleshooting Options
You can configure acceleration, logging, and debugging and statistics options to help with virtual machine
troubleshooting.

Configure the Boot Options
The time between when you power on the virtual machine and when it exits the BIOS and launches the guest
operating system software can be short. You can edit boot delay options to change that amount of time or to
force the virtual machine to enter the BIOS setup screen after power on.

Delaying the boot operation is useful for changing BIOS settings such as the boot order. For example, you can
change the BIOS settings to force a virtual machine to boot from a CD-ROM.

Prerequisites

n vSphere Client logged in to a vCenter Server

n Access to at least one virtual machine in the inventory

n Privileges to edit boot options for the virtual machine
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Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Select the Options tab and under Advanced select Boot Options.

3 In the Power on Boot Delay panel, select the time in milliseconds to delay the boot operation.

4 (Optional) Select whether to force entry into the BIOS setup screen the next time the virtual machine boots.

5 (Optional) Select whether to try to reboot after a boot failure.

You can select the time to reboot in seconds.

6 Click OK to save your changes and close the dialog box.

Enable Logging
You can enable logging to collect log files to help troubleshoot issues with your virtual machine.

Required privilege: Virtual machine.Configuration.Settings

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select AdvancedGeneral.

3 In the Settings pane, select Enable logging.

4 Click OK.

Disable Acceleration
You can temporarily disable acceleration to allow a virtual machine to successfully run or install software.

In rare instances, you might find that when you install or run software in a virtual machine, the virtual machine
appears to stop responding. Generally, the problem occurs early in the program’s execution. Often, you can
get past the problem by temporarily disabling acceleration in the virtual machine.

This setting slows down virtual machine performance, so only use it for getting past the problem with running
the program. After the program stops encountering problems, deselect Disable acceleration. Then you might
be able to run the program with acceleration.

You can enable and disable acceleration when the virtual machine is running.

Procedure

1 Click the Options tab.

2 Select Advanced > General in the Settings list.

3 To disable acceleration, select the Disable acceleration check box.
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Configure Debugging and Statistics
You can run a virtual machine so that it collects debugging information and statistics that are helpful to VMware
technical support in resolving issues.

Procedure

1 Click the Options tab and click Advanced > General.

2 To enable debugging mode, select an option from the Debugging and Statistics section.

Option Description

Run normally Collects debugging information.

Record debugging information Collects debugging and performance information. Use this option to aid
troubleshooting when the guest operating system crashes or is not behaving
properly.
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Installing and Upgrading VMware
Tools 8

VMware Tools is a suite of utilities that enhances the performance of the virtual machine’s guest operating
system and improves management of the virtual machine.

This chapter includes the following topics:

n “VMware Tools Components,” on page 117

n “Install VMware Tools on a Windows Guest,” on page 118

n “Install VMware Tools on a Linux Guest from the X Window System,” on page 119

n “Install VMware Tools on a Linux Guest with the Tar Installer,” on page 120

n “Install VMware Tools on a Solaris Guest,” on page 121

n “Install VMware Tools on a NetWare Guest,” on page 122

n “Open the VMware Tools Properties Dialog Box,” on page 123

n “VMware Tools Upgrades,” on page 124

n “Upgrade VMware Tools Manually,” on page 124

n “Configure Virtual Machines to Automatically Upgrade VMware Tools,” on page 125

n “Custom VMware Tools Installation,” on page 125

n “Change the VMware Tools Options for a Virtual Machine,” on page 126

n “WYSE Multimedia Support,” on page 126

VMware Tools Components
Installing VMware Tools in the guest operating system is vital. Although the guest operating system can run
without VMware Tools, you lose important functionality and convenience.

When you install VMware Tools, you install the following components:

n The VMware Tools service (vmtoolsd.exe on Windows guests or vmtoolsd on Linux and Solaris guests).
This service synchronizes the time in the guest operating system with the time in the host operating system.
On Windows guests, it also controls grabbing and releasing the mouse cursor.

n A set of VMware device drivers, including an SVGA display driver, the vmxnet networking driver for some
guest operating systems, the BusLogic SCSI driver for some guest operating systems, the memory control
driver for efficient memory allocation between virtual machines, the sync driver to quiesce I/O for
Consolidated Backup, and the VMware mouse driver.
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n The VMware Tools control panel, which lets you modify settings, shrink virtual disks, and connect and
disconnect virtual devices.

You can also use the command-line interface of the VMware Tools configuration utility in the guest
operating system to perform these tasks. See the VMware Tools Configuration Utility User's Guide.

n A set of scripts that helps you to automate guest operating system operations. The scripts run when the
virtual machine’s power state changes if you configure them to do so.

n The VMware user process (VMwareUser.exe on Windows guests or vmware-user on Linux and Solaris
guests), which enables you to copy and paste text between the guest and managed host operating systems.

On Linux and Solaris guests, this process controls grabbing and releasing the mouse cursor when the
SVGA driver is not installed.

The VMware Tools user process is not installed on NetWare operating systems. Instead, the vmwtool
program is installed. It controls the grabbing and releasing of the mouse cursor. It also allows you to copy
and paste text.

You can optionally install WYSE Multimedia Redirector, which improves streaming video performance in
Windows guest operating systems running on WYSE thin client devices.

The installers for VMware Tools for Windows, Linux, Solaris, and NetWare guest operating systems are built
into ESX/ESXi as ISO image files. An ISO image file looks like a CD-ROM to your guest operating system and
even appears as a CD-ROM disc in Windows Explorer. You do not use an actual CD-ROM disc to install
VMware Tools, nor do you need to download the CD-ROM image or burn a physical CD-ROM of this image
file.

When you choose to install VMware Tools, vCenter Server temporarily connects the virtual machine’s first
virtual CD-ROM disk drive to the ISO image file that contains the VMware Tools installer for your guest
operating system. You are ready to begin the installation process.

Limitations
VMware Tools has the following limitations:

n Shrink disk is not supported.

n For Microsoft Windows NT, the default scripts for suspend and resume do not work.

n The mouse driver installation fails in X windows versions earlier than 4.2.0.

NOTE   If you do not have VMware Tools installed in your virtual machine, you cannot use the shutdown or
restart options. You can use only the Power options. If you want to shut down the guest operating system,
shut it down from within the virtual machine console before you power off the virtual machine.

Install VMware Tools on a Windows Guest
Install the most recent version of VMware Tools to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

To determine the status of VMware Tools, select the virtual machine and click the Summary tab. The
VMware Tools label indicates whether VMware Tools is installed and current, installed and not current, or not
installed.

For Windows 2000 and above, VMware Tools installs the VmUpgradeHelper tool to restore the network
configuration.

NOTE   During VMware Tools installation, a Windows guest operating system might display a message
indicating that the package has not been signed. If this message appears, click Install Anyway to continue the
installation.
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Prerequisites

n Verify that a supported guest operating system is installed on the virtual machine.

n Verify that you have an ESX/ESXi license or are using evaluation mode.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Power > Power On.

2 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

3 Right-click the virtual machine and select Guest > Install/Upgrade VMware Tools.

4 Select Interactive Tools Installation and click OK.

This step initiates the installation process by mounting the VMware Tools bundle on the guest operating
system.

5 If the New Hardware wizard appears go through the wizard and accept the defaults.

6 In the virtual machine console, do one of the following:

n If autorun is enabled, click OK to confirm that you want to install VMware Tools and launch the
InstallShield wizard.

n If autorun is not enabled, manually launch the VMware Tools installer by clicking Start > Run and
entering D:\setup.exe, where D: is your first virtual CD-ROM drive.

7 Follow the onscreen instructions.

8 Reboot for the changes take effect.

What to do next

Verify the status of VMware Tools by checking the VMware Tools label on the virtual machine Summary tab.
OK should appear in the VMware Tools label.

Install VMware Tools on a Linux Guest from the X Window System
Install the latest version of VMware Tools to enhance the performance of the virtual machine’s guest operating
system and improve virtual machine management.

Before you install or upgrade VMware Tools on a virtual machine, determine the status of VMware Tools. To
do this, select the virtual machine and click the Summary tab. The VMware Tools label indicates whether
VMware Tools is installed and current, installed and not current, or not installed.

Prerequisites

n Verify that a supported guest operating system is installed on the virtual machine.

n Verify that you have an ESX/ESXi license or are using evaluation mode.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Power > Power On.

2 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

3 Right-click the virtual machine and select Guest > Install/Upgrade VMware Tools.

4 Select Interactive Tools Installation and click OK.

This step initiates the installation process by mounting the VMware Tools bundle on the guest operating
system.
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5 Do one of the following:

n From the desktop, double-click the VMware Tools CD icon or the file manager window and double-
click the RPM installer.

n If the VMware Tools CD icon or file manager window does not appear, install VMware Tools from
the command line.

6 When prompted, enter the root password and click OK.

The installer prepares the packages.

7 Click Continue when a Completed System Preparation message appears.

When the installer is done, VMware Tools is installed. There is no confirmation or finish button.

8 In a terminal window, such as root (su -), run the vmware-config-tools.pl command to configure
VMware Tools.

Respond to the questions that appear on the screen. Press Enter to accept the default values if appropriate
for your configuration.

9 Exit from the root account by issuing the exit command.

What to do next

Verify the status of VMware Tools by checking the VMware Tools label on the virtual machine Summary tab.
OK should appear in the VMware Tools label.

Install VMware Tools on a Linux Guest with the Tar Installer
Install the latest version of VMware Tools to enhance the performance of the virtual machine’s guest operating
system and improve virtual machine management.

Prerequisites

n Verify that a supported guest operating system is installed on the virtual machine.

n Verify that you have an ESX/ESXi license or are using evaluation mode.

Before you install or upgrade VMware Tools on a virtual machine, determine the status of VMware Tools.
Select the virtual machine and click the Summary tab. The VMware Tools label indicates whether VMware
Tools is installed and current, installed and not current, or not installed.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Power > Power On.

2 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

3 Right-click the virtual machine and select Guest > Install/Upgrade VMware Tools.

4 Select Interactive Tools Installation and click OK.

This step initiates the installation process by mounting the VMware Tools bundle on the guest operating
system.

5 In the virtual machine console, log in as root (su -) and, if necessary, create the /mnt/cdrom directory:

mkdir /mnt/cdrom
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6 Mount the VMware Tools virtual CD-ROM image.

Some Linux distributions automatically mount CD-ROMs. If your distribution uses automounting, do not
use the mount and umount commands in this procedure.

Some Linux distributions use different device names or organize the /dev directory differently. Modify
the following commands to reflect the conventions used by your distribution:

mount /dev/cdrom /mnt/cdrom

cd /tmp

7 Change to a working directory (for example, /tmp).

cd /tmp

8 If you have a previous installation, delete the previous vmware-tools-distrib directory.

rm -rf /tmp/vmware-tools-distrib

The default location of this directory is: /tmp/vmware-tools-distrib.

9 List the contents of the /mnt/cdrom/ directory, and note the filename of the VMware Tools tar installer.

ls /mnt/cdrom

10 Uncompress the tar installer.

tar zxpf /mnt/cdrom/VMwareTools-4.0.0-xxxxxx.tar.gz

Where xxxxxx is the build/revision number of the ESX/ESXi release.

If you attempt to install a tar installation over an rpm installation, the installer detects the previous
installation and must convert the installer database format before continuing.

11 Unmount the CD-ROM image:

umount /dev/cdrom

12 Run the VMware Tools tar installer.

cd vmware-tools-distrib

./vmware-install.pl

For each configuration question, press Enter to accept the default value.

13 Log off the root account.

exit

What to do next

Verify the status of VMware Tools by checking the VMware Tools label on the virtual machine Summary tab.
OK should appear in the VMware Tools label.

Install VMware Tools on a Solaris Guest
Install the latest version of VMware Tools to enhance the performance of the virtual machine’s guest operating
system and improve virtual machine management.

Before you install or upgrade VMware Tools on a virtual machine, determine the status of VMware Tools. To
do this, select the virtual machine and click the Summary tab. The VMware Tools label indicates whether
VMware Tools is installed and current, installed and not current, or not installed.
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Prerequisites

n Verify that a supported guest operating system is installed on the virtual machine.

n Verify that you have an ESX/ESXi license or are using evaluation mode.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Power > Power On.

2 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

3 Right-click the virtual machine and select Guest > Install/Upgrade VMware Tools.

4 Select Interactive Tools Installation and click OK.

This step initiates the installation process by mounting the VMware Tools bundle on the guest operating
system.

5 In the virtual machine console, log in as root (su -) and, if necessary, mount the VMware Tools virtual
CD-ROM image, as follows.

Usually, the Solaris volume manager mounts the CD-ROM under /cdrom/vmwaretools. If the CD-ROM is
not mounted, restart the volume manager using the following commands.

/etc/init.d/volmgt stop

/etc/init.d/volmgt start

6 After the CD-ROM is mounted, change to a working directory (for example, /tmp) and extract
VMware Tools.

cd /tmp

gunzip -c /cdrom/vmwaretools/vmware-solaris-tools.tar.gz | tar xf -

7 Run the VMware Tools tar installer.

cd vmware-tools-distrib

./vmware-install.pl

Respond to the configuration questions on the screen. Press Enter to accept the default values.

8 Log off of the root account.

exit

What to do next

Verify the status of VMware Tools by checking the VMware Tools label on the virtual machine Summary tab.
OK should appear in the VMware Tools label.

Install VMware Tools on a NetWare Guest
Install or upgrade VMware Tools to the latest version to enhance the performance of the virtual machine’s
guest operating system and improve virtual machine management.

Before you upgrade VMware Tools on a virtual machine, determine the status of VMware Tools. To do this,
select the virtual machine and click the Summary tab. The VMware Tools label indicates whether
VMware Tools is installed and current, installed and not current, or not installed.

Prerequisites

n Verify that a supported guest operating system is installed on the virtual machine.

n Verify that you have an ESX/ESXi license or are using evaluation mode.
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Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Power > Power On.

2 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

3 Right-click the virtual machine and select Guest > Install/Upgrade VMware Tools.

4 Select Interactive Tools Installation and click OK.

This step initiates the installation process by mounting the VMware Tools bundle on the guest operating
system.

5 In the virtual machine console, load the CD-ROM driver so the CD-ROM device mounts the ISO image
as a volume. To open the Netware Server Console, select Novell > Utilities > Server Console.

6 Do one of the following:

n In the NetWare 6.5 Server Console, enter: LOAD CDDVD.

n In the NetWare 6.0 or NetWare 5.1 Server Console, enter: LOAD CD9660.NSS.

7 In the Server Console, enter the following command.

vmwtools:\setup.ncf

When the installation finishes, the message VMware Tools for NetWare are now running appears in the Logger
Screen (NetWare 6.5 and NetWare 6.0 guests) or the Console Screen (NetWare 5.1 guests).

What to do next

Verify the status of VMware Tools by checking the VMware Tools label on the virtual machine Summary tab.
OK should appear in the VMware Tools label.

Open the VMware Tools Properties Dialog Box
Use the VMware Tools Properties dialog box to configure VMware Tools in your virtual machine. Instructions
for displaying this dialog box vary, depending on the guest operating system.

Use this dialog box to configure time synchronization between host and guest, notifications of VMware Tools
updates (for Windows and Linux guests only), and specifying which scripts to run when the virtual machine’s
power state changes.

Procedure

u Select an option for your guest operating system.

Option Action

Windows a Open a console to the virtual machine.
b Double-click the VMware Tools icon in the system tray from inside the

guest operating system.

Linux or Solaris Open the virtual machine console and open a terminal window and enter the
following command: /usr/bin/vmware-toolbox &

NetWare Select Novell > Settings > VMware Tools for NetWare.
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VMware Tools Upgrades
You can upgrade VMware Tools manually, or you can configure virtual machines to check for and install newer
versions of VMware Tools

The following conditions are required for automatic upgrades:

n Virtual machines must have a version of VMware Tools shipped with ESX Server 3.0.1 or greater installed.

n Virtual machines must be hosted on an ESX Server 3.0.1 or greater, and the vCenter Server must be version
2.0.1 or greater.

n Virtual machines must be running a Linux or Windows guest OS that is supported by ESX Server 3.0.1 or
greater and vCenter Server 2.0.1 or greater.

n Virtual machines must be powered on.

Upgrade VMware Tools Manually
You can upgrade VMware Tools on multiple virtual machines by using menu items or a command line
interface.

Prerequisites

If you use a command-line interface to upgrade VMware Tools, verify that you have the command-line options
for your operating system handy. Command-line options for Linux are documented in the Linux Installer for
Linux Tools. Command-line options for Windows are documented in the MSI for Windows Tools and at the
following Wikipedia entry: http://en.wikipedia.org/wiki/Windows_Installer .

NOTE   You can also manually upgrade VMware Tools from within the virtual machine’s operating system by
opening the VMware Tools Properties dialog box (double-click the icon in the system tray) and clicking
Upgrade in the Options tab.

Procedure

1 Start the vSphere client and log in to vCenter Server.

2 Select the Inventory > Hosts and Clusters view.

3 Select the host or cluster that contains the virtual machines you want to upgrade.

4 Click the Virtual Machines tab.

5 Select the virtual machines that you want to upgrade and power them on.

6 Select an upgrade option.

Option Description

Use menu items Right-click the virtual machines to upgrade and select Guest >
Install/Upgrade Tools.

Use a command-line interface Enter the command-line options for your operating system in the Advanced
Options field.

 
7 Click OK to mount the installer.

What to do next

You can track the upgrade progress on the Tasks & Events tab.
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Configure Virtual Machines to Automatically Upgrade VMware Tools
You can configure virtual Machines to automatically update VMware Tools.

NOTE   Automatic VMware Tools upgrade is not supported for virtual machines with Solaris or NetWare guest
operating systems.

Prerequisites

n Verify that the virtual machines have a version of VMware Tools shipped with ESX Server 3.0.1 or greater
installed.

n Verify that the virtual machines are hosted on ESX Server 3.0.1 or later and vCenter Server 2.0.1 or later.

n Verify that the virtual machines are running a Linux or Windows guest OS that is supported by ESX Server
3.0.1 or later and vCenter Server 2.0.1 or later.

n Verify that the virtual machine is powered on.

Procedure

1 Right-click the virtual machine and click Edit Settings.

2 Click the Options tab and select VMware Tools.

3 Select Check and upgrade Tools during power cycling in the Advanced pane.

4 Click OK to save your changes and close the dialog box.

The next time the virtual machine is powered on, it checks the ESX/ESXi host for a newer version of VMware
Tools. If one is available, it is installed and the guest operating system is restarted (if required).

Custom VMware Tools Installation
You can use a custom VMware Tools installation path to install optional drivers or other software that might
improve the performance of particular virtual machines, such as WYSE Multimedia Support.

Procedure

1 Open a console to the virtual machine.

2 Power on the virtual machine.

3 After the guest operating system starts, right-click the virtual machine and select Install VMware Tools.

4 From inside the virtual machine, click OKto confirm that you want to install VMware Tools and open the
InstallShield wizard.

n If you have autorun enabled in your guest operating system (the default setting for Windows
operating systems), a dialog box appears.

n If autorun is not enabled, run the VMware Tools installer. Click Start > Run and enter D:\setup.exe,
where D: is your first virtual CD-ROM drive.

5 Click Next.

6 Select Custom, and click Next.

7 Click the red X next to each optional feature you want to install, and select This feature will be installed
on local hard drive.

8 Click Next.

9 Click Finish.
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Change the VMware Tools Options for a Virtual Machine
You can change the power controls, the time VMware Tools scripts run, the upgrade check option, and the
time synchronization option with the VMware Tools settings for a virtual machine.

Prerequisites

Verify that the virtual machine is powered off.

Procedure

1 Right-click the virtual machine and click Edit Settings.

2 Click the Options tab and select VMware Tools.

3 Select the actions you want from the drop-down menus under Power Controls.

You can accept the system defaults for the toolbar buttons or configure them as follows:

n Configure the stop button on the toolbar to power off the virtual machine or shut down the guest
operating system.

n Configure the pause button on the toolbar to suspend the virtual machine.

n Configure the reset button on the toolbar to reset the virtual machine or restart the guest operating
system.

4 (Optional) Configure VMware Tools scripts to run when you change the virtual machine’s power state by
selecting options under Run VMware Tools scripts.

NOTE   For ESX host virtual machines, there are no scripts for resuming and suspending virtual machines.

5 (Optional) Configure VMware Tools to check for and install updates before each power on by selecting
the Check and upgrade Tools before each power on option under Automatic VMware Tools Upgrade.

6 (Optional) Configure the guest operating system to synchronize time with the host by selecting the
Synchronize guest time with host option.

7 Click OK to save your changes and close the dialog box.

WYSE Multimedia Support
If you are using a WYSE thin client device to conduct remote desktop sessions using VMware VDI, installing
WYSE Multimedia Support in the guest operating system improves the performance of streaming video. WYSE
Multimedia Support allows streaming video to be decoded on the client rather than on the host, thereby
conserving network bandwidth.

WYSE Multimedia Support is supported on the Windows 2003 and Windows XP guest operating systems only.
WYSE Multimedia Support is installed as part of a VMware Tools installation or upgrade.

Install WYSE Multimedia Support with VMware Tools
When you install VMware Tools in a Windows 2003 or Windows XP guest operating system for the first time,
you can install WYSE Multimedia Support at the same time by choosing a custom installation path.

Procedure

u Follow the instructions for the custom installation path as described in “Custom VMware Tools
Installation,” on page 125. On the Custom Setup page, select WYSE Multimedia Redirector for
installation.
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Install WYSE Multimedia Support Using Add or Remove Programs
For virtual machines that already have VMware Tools installed, WYSE Multimedia Support can be installed
as part of a VMware Tools upgrade using the Windows Add or Remove Programs feature.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Power > Power On.

2 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

3 In the virtual machine, select Start > Settings > Control Panel > Add or Remove Programs.

4 In the list of programs, select VMware Tools and click Change.

5 Click Next.

6 Select Modify and click Next.

7 Click the red X next to WYSE Multimedia Redirector and select This feature will be installed on local
hard drive.

8 Click Next.

9 Click Modify to begin the installation.

10 Click Finish.

Install WYSE Multimedia Support as Part of a VMware Tools Upgrade
You can install WYSE Multimedia Support as part of a VMware Tools upgrade started from the vSphere Client.

Prerequisites

Verify that the virtual machine is running on ESX Server 3.0.1 or later and vCenter Server 2.0.1 or later.

Procedure

1 Right-click a powered-on virtual machine and select Guest > Upgrade VMware Tools.

2 In the Advanced field, type setup.exe /s /v”INSTALL_WYSE=1”.

3 Click OK.
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Managing Multi-Tiered Applications
with VMware vApp 9

You can use VMware vSphere as a platform for running applications, in addition to using it as a platform for
running virtual machines. The applications can be packaged to run directly on top of VMware vSphere. The
format of how the applications are packaged and managed is called VMware® vApp.

A vApp is a container, like a resource pool and can contain one or more virtual machines. A vApp also shares
some functionality with virtual machines. A vApp can power on and power off, and can also be cloned.

In the vSphere Client, a vApp is represented in both the Host and Clusters view and the VM and Template
view. Each view has a specific summary page with the current status of the service and relevant summary
information, as well as operations on the service.

The distribution format for vApp is OVF.

NOTE   The vApp metadata resides in the vCenter Server's database, so a vApp can be distributed across multiple
ESX/ESXi hosts. This information can be lost if the vCenter Server database is cleared or if a standalone
ESX/ESXi host that contains a vApp is removed from vCenter Server. You should back up vApps to an OVF
package to avoid losing any metadata.

vApp metadata for virtual machines within vApps do not follow the snapshots semantics for virtual machine
configuration. So, vApp properties that are deleted, modified, or defined after a snapshot is taken remain intact
(deleted, modified, or defined) after the virtual machine reverts to that snapshot or any prior snapshots.

You can use VMware Studio to automate the creation of ready-to-deploy vApps with pre-populated
application software and operating systems. VMware Studio adds a network agent to the guest so that vApps
bootstrap with minimal effort. Configuration parameters specified for vApps appear as OVF properties in the
vCenter Server deployment wizard. For information about VMware Studio and for download, see the VMware
Studio developer page on the VMware web site.

This chapter includes the following topics:

n “Create a vApp,” on page 130

n “Populate the vApp,” on page 131

n “Edit vApp Settings,” on page 132

n “Configuring IP Pools,” on page 136

n “Clone a vApp,” on page 138

n “Power On a vApp,” on page 138

n “Power Off a vApp,” on page 139

n “Suspend a vApp,” on page 139
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n “Resume a vApp,” on page 139

n “Edit vApp Annotation,” on page 139

Create a vApp
After you create a datacenter and add a clustered DRS-enabled host or a standalone host to your vCenter Server
system, you can create a vApp.

You can create a vApp under the following conditions.

n A standalone host is selected in the inventory that is running ESX 3.0 or greater.

n A DRS-enabled cluster is selected in the inventory.

You can create vApps on folders, standalone hosts, resource pools, DRS-enabled clusters, and within other
vApps.

Procedure

1 Start the New vApp Wizard on page 130
The New vApp wizard allows you to create a vApp.

2 Name the vApp on page 130
The name that you enter is the vApp display name that appears in the inventory.

3 Select the vApp Destination on page 131
The destination is the standalone host, cluster, resource pool, or another vApp on which the vApp will
run.

4 Allocate vApp Resources on page 131
Determine how CPU and memory should be allocated for the vApp.

5 Complete the vApp Creation on page 131
The Ready to Complete page lets you review the vApp configuration.

Start the New vApp Wizard
The New vApp wizard allows you to create a vApp.

Procedure

u Select File > New > vApp to open the New vApp wizard.

Name the vApp
The name that you enter is the vApp display name that appears in the inventory.

The vApp name can be up to 80 characters long. This name must be unique within the folder.

Procedure

1 On the Name and Folder page, enter a name for the vApp.

2 Select a folder location in the inventory for the vApp.

If you are creating a vApp from within another vApp, the vApp Inventory Location selection is
unavailable.

3 Click Next.
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Select the vApp Destination
The destination is the standalone host, cluster, resource pool, or another vApp on which the vApp will run.

NOTE   This step, selecting a vApp destination, does not appear if you create a vApp from a standalone host,
cluster, resource pool, or another vApp within the inventory.

Procedure

1 On the Destination page, select a standalone host, cluster, or resource pool where this vApp will run and
click Next.

If you selected a DRS-enabled cluster and the cluster is in DRS manual mode, select the host as the
destination for the vApp.

The message in the Compatibility panel indicates whether the validation for this destination succeeded
or whether a specific requirement was not met.

2 Click Next.

Allocate vApp Resources
Determine how CPU and memory should be allocated for the vApp.

Procedure

1 In the Resource Allocation page, allocate CPU and memory resources for this vApp.

2 Click Next.

Complete the vApp Creation
The Ready to Complete page lets you review the vApp configuration.

Procedure

1 Review the new vApp settings on the Ready to Complete page.

2 (Optional) Click Back to edit or change any settings.

3 Click Finish to create the vApp.

Populate the vApp
Virtual machines and other vApps can be added to and removed from a vApp.

After you create a vApp, you can populate it with virtual machines or other vApps.
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Create an Object Inside the vApp
Within a vApp, you can create a new virtual machine, resource pool, or another vApp.

Procedure

1 In the inventory, select the vApp in which you want to create the object machine.

2 Select the menu option to create a specific object.

Menu Option Description

Inventory > vApp > New Virtual
Machine

Creates a new virtual machine inside the vApp. Complete the Create New
Virtual Machine wizard. See Chapter 3, “Creating a Virtual Machine,” on
page 19 for instructions on creating a new virtual machine.

Inventory > vApp > New Resource
Pool

Adds a resource pool inside the vApp. Complete the Create Resource Pool
window.

Inventory > vApp > New vApp Creates a new vApp inside the currently selected vApp. Complete the New
vApp wizard. See “Create a vApp,” on page 130 for instructions on creating
a new vApp.

 
The new object appears as part of the vApp in the inventory.

Add an Object to a vApp
You can add an object, such as a virtual machine or another vApp, to an existing vApp.

An existing virtual machine or another vApp that is not already contained inside the vApp can be moved into
the currently selected vApp.

Procedure

1 Display the object in the inventory.

2 Click and drag the object to the target object.

n If the move is permitted, a box appears around the target-object, indicating it is selected.

n If move is not permitted, a naught sign (zero with a slash) appears, and the object is not moved.

3 Release the mouse button.

Either the object moves to the new location or an error message indicates what needs to be done to permit
the move.

Edit vApp Settings
You can edit and configure several vApp settings, including startup order, resources, and custom properties.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click the Options tab to edit or view vApp properties.

NOTE   The deployer typically edits the IP allocation policy and properties. The vApp author typically edits
the other, more advanced settings.

3 Click the Start Order tab to edit vApp startup and shutdown options.

4 Click OK.
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Edit vApp Startup and Shutdown Options
You can change the order in which virtual machines and nested vApps within a vApp start up and shut down.
You can also specify delays and actions performed at startup and shutdown.

Required privilege:vApp.vApp application configuration

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 In the Start Order tab of the Edit vApp Settings window, select a virtual machine and use the arrow keys
to change the startup order.

Virtual Machines and vApps with the same start order (or within the same grouping) will start
concurrently with each other.

The reverse order will be used for shutdown.

3 Select the startup and shutdown action for each virtual machine.

4 (Optional) Use the arrow keys to change the time delay for startup and shutdown for each virtual machine.

5 Click OK.

Edit vApp Resources
You can edit the CPU and memory resource allocation for the vApp.

Required privilege:vApp.vApp application configuration

Reservations on vApps and all their child resource pools, child vApps, and child virtual machines count against
the parent resources only when they are powered on.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Resources in the Options list.

3 Edit the CPU and memory resource allocation.

4 Click OK.

Edit vApp Properties
You can edit any vApp property that is defined in Advanced Property Configuration.

Required privilege:vApp.vApp application configuration

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Properties in the Options list.

3 Edit the vApp properties.

4 Click OK.

View vApp License Agreement
You can view the license agreement for the vApp that you are editing.

NOTE   This option is available only if the vApp was imported and contains a license agreement.
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Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click View License Agreement in the Options list.

3 Click OK.

Edit IP Allocation Policy
You can edit how IP addresses are allocated for the vApp.

Required privilege: vApp.vApp instance configuration

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click IP Allocation Policy in the Options list.

3 Select an IP allocation option.

Option Description

Fixed IP addresses are manually configured. No automatic allocation is performed.

Transient IP addresses are automatically allocated using IP pools from a specified
range when the vApp is powered on. The IP addresses are released when the
appliance is powered off.

DHCP A DHCP server is used to allocate the IP addresses. The addresses assigned
by the DHCP server are visible in the OVF environments of virtual machines
started in the vApp.

 
4 Click OK.

View Additional OVF Sections
View OVF sections that are not recognized by vCenter Server.

These additional OVF sections originate from the OVF deployment process that created this vApp. Most of
the OVF sections that vCenter Server did not recognize during deployment are accessible here for reference.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click View Additional OVF Sections in the Options list.

3 Click OK.

Configure Advanced vApp Properties
You can edit and configure advanced settings, such as product and vendor information, custom properties,
and IP allocation.

Required privilege:vApp.vApp application configuration

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Advanced in the Options list.

vSphere Virtual Machine Administration Guide

134  VMware, Inc.



3 Set and configure the settings that appear on the summary page of the virtual machine.

vApp Setting Description

Product Name Product Name.

Version vApp version.

Full Version Full version of the vApp.

Product URL If you enter a product URL, a user can click the product name on the virtual
machine summary page and go to the product's web page.

Vendor URL If you enter a vendor URL, a user can click the vendor name on the virtual
machine summary page and go to the vendor's web page.

Application URL If you use properties to specify the virtual machine IP address, you can enter
a dynamic application URL that points to a web page exposed by running
the virtual machine. If you enter a valid application URL, the state of the
virtual machine changes to the Available link when the virtual machine
begins running.

 
If you configure the virtual machine to use the property called webserver_ip and the virtual machine has a
web server, you can enter http://${webserver_ip}/ as the Application URL.

4 (Optional) Click View to test the Product URL and Vendor URL.

5 Click Properties to edit the custom vApp properties.

6 Click IP Allocation to edit the supported IP allocation schemes of this vApp.

7 Click OK.

Define OVF Environment Properties
You can view or modify the OVF environment properties for the vApp.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Advanced in the Options list.

3 Click Properties.

4 In Advanced Property Configuration, you can perform the following actions.

n ClickNew to add a new custom property.

n Select the property and click Edit to edit a property.

n Click Delete to delete a property.

5 Click OK.

Edit Advanced IP Allocation Properties
You can edit the IP allocation scheme for the vApp.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Advanced in the Options list.

3 Click IP Allocation.
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4 In the Advanced IP Allocation dialog box, you can perform the following actions.

n Select an IP allocation scheme.

n Select the IP protocols supported by the vApp: IPv4, IPv6, or both.

5 Click OK.

Configuring IP Pools
IP pools provide a network identity to vApps. An IP pool is a network configuration that is assigned to a
network used by a vApp. The vApp can then leverage vCenter Server to automatically provide an IP
configuration to its virtual machines.

Specify an IP Address Range
You can set up an IP address range by specifying a host address range within a network.

IP pool ranges are configured with IPv4 and IPv6. vCenter Server uses these ranges to dynamically allocate IP
addresses to virtual machines when a vApp is set up to use transient IP allocation.

Procedure

1 In the inventory, select the datacenter that contains the vApp.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select the IPv4 or the IPv6 tab, depending on your IP protocol.

4 Enter the IP Subnet and Gateway in their respective fields.

5 (Optional) Select the Enable IP Pool check box.

Enable this setting to specify an IP address range.

6 (Optional) Enter a comma-separated list of host address ranges in the Ranges field.

A range consists of an IP address, a pound sign (#), and a number indicating the length of the range.

The gateway and the ranges must be within the subnet, but must exclude the gateway address.

For example, 10.20.60.4#10, 10.20.61.0#2 indicates that the IPv4 addresses can range from 10.20.60.4 to
10.209.60.13 and 10.20.61.0 to 10.20.61.1.

7 Click OK.

Select DHCP
You can specify that an IPv4 or IPv6 DHCP server is available on the network.

Procedure

1 In the inventory, select the datacenter that contains the vApp you are configuring.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select theDHCP tab.

4 Select either the IPv4 DHCP Present or IPv6 DHCP Present check box to indicate that one of the DHCP
servers is available on this network.

5 Click OK.
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Specify DNS Settings
Enter the DNS settings for the vApp.

Procedure

1 In the inventory, select the datacenter that contains the vApp you are configuring.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select the DNS tab.

4 Enter the DNS server information.

Specify the servers by IP addresses separated by a comma, semicolon, or space.

You can enter the following types of DNS information:

n DNS Domain

n Host Prefix

n DNS Search Path

n IPv4 DNS Servers

n IPv6 DNS Servers

5 Click OK.

Specify a Proxy Server
Specify a HTTP proxy server for the vApp.

Procedure

1 In the inventory, select the datacenter that contains the vApp.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select the Proxy tab.

4 Enter the server name and port number for the proxy server.

The server name can optionally include a colon and a port number.

For example, web-proxy:3912 is a valid proxy server.

5 Click OK.

Select Network Associations
You can associate one or more networks with an IP pool.

Procedure

1 In the inventory, select the datacenter that contains the vApp.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select the Associationstab.
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4 Select the networks that use this IP pool.

A network can be associated with one IP pool at a time.

5 Click OK.

Clone a vApp
Cloning a vApp is similar to cloning a virtual machine.

Prerequisites

To clone a vApp, the vSphere Client must be connected to the vCenter Server system.

A host must be selected in the inventory that is running ESX 3.0 or greater, or a DRS-enabled cluster.

Procedure

1 Select the vApp in the inventory.

2 Select Inventory > vApp > Clone.

Complete each page in Clone vApp the wizard.

3 Select the vApp destination and click Next.

4 Specify a Host and click Next.

NOTE   This step is available only if you select a cluster that is in DRS manual mode.

5 Name the vApp and click Next.

6 Select a datastore and click Next.

7 (Optional) Select a network and click Next.

8 Complete the vApp clone.

Power On a vApp
Each virtual machine within the vApp is powered on according to the startup order configuration.

When powering on a vApp within a DRS cluster in manual mode, no DRS recommendations are generated
for virtual machine placements. The power-on operation performs as if DRS is run in a semiautomatic or
automatic mode for the initial placements of the virtual machines. This does not affect vMotion
recommendations. Recommendations for individual powering on and powering off of virtual machines are
also generated for vApps that are running.

Procedure

u In the Summary page for the service, click Power On.

If a delay is set in the startup settings, the vApp waits for the set length of time before powering up that
virtual machine.

In the Summary tab, the status indicates when the vApp has started and is available. Links to the product and
vendor Web sites are also found under the General section.
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Power Off a vApp
Each virtual machine within the vApp is powered off in reverse order to how they are configured for startup.

Procedure

u In the Summary page for the service, click Power Off.

If a delay is set in the shutdown settings, the vApp waits for the set length of time before powering down
that virtual machine.

Suspend a vApp
A suspended vApp pauses all its running virtual machines until you resume the vApp.

The virtual machines within a vApp are suspended based on their stop order. All virtual machines are
suspended regardless of stop action.

Procedure

1 From the vSphere Client, select the vApp you want to place in suspended state.

2 Right-click the vApp and select Suspend.

Resume a vApp
You can continue the activity of the virtual machines within a vApp that is in a suspended state.

The suspended virtual machines within the vApp are resumed in reverse order to the order in which they were
suspended.

Procedure

1 From the vSphere Client, select the vApp.

2 Right-click the vApp and select Power On.

Edit vApp Annotation
You can add or edit notes for a particular vApp.

Procedure

1 Select the vApp in the inventory.

2 Click the Summary tab for the vApp.

3 In the Annotation section, click Edit.

4 Type your comments in the Edit Service Annotation window.

5 Click OK.

Your comments appear under Annotation.
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Managing Virtual Machines 10
You use the vSphere Client to manage virtual machines. With the vSphere Client, you can open a console to
the desktop of managed virtual machines. From the console, you can change operating system settings, use
applications, browse the file system, monitor system performance, and so on, as if you were operating a
physical system. You can also use snapshots to capture the entire state of the virtual machine at the time you
take the snapshot.

You can connect the vSphere Client directly to an ESX/ESXi host and work with only the virtual machines and
the physical resources available on that host. Connect your vSphere Client to a vCenter Server to manage
virtual machines and pooled physical resources across multiple hosts. Multiple vCenter Server systems can be
joined together in a vCenter Server Connected Group to allow them to be managed with a single vSphere Client
connection.

This chapter includes the following topics:

n “Edit Virtual Machine Startup and Shutdown Settings,” on page 141

n “Open a Console to a Virtual Machine,” on page 142

n “Adding and Removing Virtual Machines,” on page 142

n “Using Snapshots To Manage Virtual Machines,” on page 144

n “Managing Existing Snapshots,” on page 147

n “Restoring Snapshots,” on page 148

n “Converting Virtual Disks from Thin to Thick,” on page 149

Edit Virtual Machine Startup and Shutdown Settings
You can configure virtual machines running on an ESX/ESXi host to start up and shut down with the host. You
can also set the default timing and startup order for selected virtual machines. This ability allows the operating
system to save data when the host enters maintenance mode or is being powered off for another reason.

NOTE   You can also create a scheduled task to change the power settings of a virtual machine. Information
about scheduling tasks is included in the Datacenter Administration Guide.

Procedure

1 In the vSphere Client inventory, select the host where the virtual machine is located and click the
Configuration tab.

2 Under Software, click Virtual Machine Startup/Shutdown and click Properties.

The Virtual Machine Startup and Shutdown dialog box opens.

3 Select Allow virtual machines to start and stop automatically with the system.
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4 (Optional) Configure the startup and shutdown behavior.

Option Action

Default Startup Delay Select the amount of time to delay starting the operating system.
This delay allows time for VMware Tools or the booting system to run scripts.

Continue immediately if the VMware
Tools starts

Select to start the operating system immediately after VMware Tools starts.

Default Shutdown Delay Select the amount of time to delay shutdown for each virtual machine.
The shutdown delay applies only if the virtual machine does not shut down
before the delay period elapses. If the virtual machine shuts down before the
delay time is reached, the next virtual machine starts shutting down.

Shutdown Action Select a shutdown option from the drop-down menu.
n Power Off
n Suspend
n Guest Shutdown

Move Up and Move Down Select a virtual machine in the Manual Startup category and use the Move
Up button to move it up to Automatic Startup or Any Oder.
When virtual machines are in the Automatic Startup category, you can use
Move Up and Move Down to order them so that they start in a preferred
sequence. During shutdown, the virtual machines are stopped in the
opposite order.

Edit Click Edit to configure user-specified autostartup and shutdown behavior
for virtual machines in the Automatic Startup or Any Order category.

 
5 Click OK to close the dialog box and save your settings.

Open a Console to a Virtual Machine
With the vSphere Client, you can access a virtual machine's desktop by launching a console to the virtual
machine. From the console, you can perform activities within the virtual machine such as configure operating
system settings, run applications, monitor performance, and so on.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Open Console .

2 Click anywhere inside the console window to enable your mouse, keyboard, and other input devices to
work in the console.

Adding and Removing Virtual Machines
You add virtual machines to the vCenter Server inventory through their managed hosts. You can remove
virtual machines from vCenter Server, from their managed host’s storage, or from both.

Adding Existing Virtual Machines to vCenter Server
When you add a host to vCenter Server, it discovers all the virtual machines on that managed host and adds
them to the vCenter Server inventory.

If a managed host is disconnected, the already discovered virtual machines continue to be listed in the
inventory.

If a managed host is disconnected and reconnected, any changes to the virtual machines on that managed host
are identified, and the vSphere Client updates the list of virtual machines. For example, if node3 is removed
and node4 is added, the new list of virtual machines adds node4 and shows node3 as orphaned.
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Remove Virtual Machines from vCenter Server
Removing a virtual machine from the inventory unregisters it from the host and vCenter Server, but does not
delete it from the datastore. Virtual machine files remain at the same storage location and the virtual machine
can be re-registered by using the datastore browser.

Prerequisites

Power off the virtual machine.

Procedure

1 Display the virtual machine in the inventory.

2 Right-click the virtual machine and select Remove from Inventory.

3 To confirm that you want to remove the virtual machine from the inventory, click OK.

vCenter Server removes references to the virtual machine and no longer tracks its condition.

Remove Virtual Machines from the Datastore
You use the Delete from Disk option to remove a virtual machine from vCenter Server and delete all virtual
machine files, including the configuration file and virtual disk files, from the datastore.

Prerequisites

Power off the virtual machine.

Procedure

1 Display the virtual machine in the inventory.

2 Right-click the virtual machine and select Delete from Disk.

3 Click OK in the confirmation dialog box.

vCenter Server deletes the virtual machine from its datastore. Disks that are shared with other virtual machines
are not deleted.

Return a Virtual Machine or Template to vCenter Server
If you remove a virtual machine or template from vCenter Server, but do not remove it from the managed
host’s datastore, you can return it to vCenter Server by using the Datastore Browser.

Procedure

1 Display the datastore in the inventory.

2 Right-click the datastore and select Browse Datastore.

3 Navigate to the virtual machine or template to add to the inventory.

4 Right-click the virtual machine or template and select Add to Inventory.

5 Complete the Add to Inventory wizard to add the virtual machine or template.
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Using Snapshots To Manage Virtual Machines
Snapshots are useful when you need to revert repeatedly to the same state but you do not want to create
multiple virtual machines. With snapshots, you create restore positions in a linear process. You can also
preserve a baseline before diverging a virtual machine in a process tree.

You can use a snapshot as a restoration point during a linear or iterative process, such as installing update
packages, or during a branching process, such as installing different versions of a program. Taking snapshots
ensures that each installation begins from an identical baseline.

Understanding Snapshots
A snapshot captures the entire state of the virtual machine at the time you take the snapshot.

Snapshots are useful when you need to revert repeatedly to the same state but you don't want to create multiple
virtual machines.

A snapshot includes the following information:

n Contents of the virtual machine’s memory

n Virtual machine settings

n State of all the virtual machine’s virtual disks

NOTE   VMware does not support snapshots of raw disks, RDM physical mode disks, independent disks, or of
virtual machines configured with bus-sharing.

If you require bus-sharing, consider running backup software within your guest operating system as an
alternative solution. If your virtual machine currently has snapshots and it is preventing you from configuring
bus-sharing, delete the snapshots.

Snapshots operate on individual virtual machines. In a team of virtual machines, taking a snapshot preserves
the state only of the active virtual machine.When you revert to a snapshot, you return all these items to the
state they were in at the time you took that snapshot. If you want the virtual machine to be suspended, powered
on, or powered off when you launch it, make sure that it is in the correct state when you take that snapshot.

While snapshots provide a point-in-time image of the disk that backup solutions can use, do not use snapshots
for your own virtual machine backups. Large numbers of snapshots are difficult to manage, take up large
amounts of disk space, and are not protected in the case of hardware failure.

Because you cannot revert to a snapshot with dynamic disks, quiesced snapshots are not used when backing
up dynamic disks.

Backup solutions, like VMware Data Recovery, use the snapshot mechanism to freeze the state of a virtual
machine. However, the Data Recovery backup method has additional capabilities that mitigate the limitations
of snapshots.

Multiple snapshots refers to the ability to create more than one snapshot of the same virtual machine.

Multiple snapshots are not simply a way of saving your virtual machines. With multiple snapshots, you can
save many positions to accommodate many kinds of work processes.

When taking a snapshot, the state of the virtual disk at the time the snapshot is taken will be preserved. When
this occurs, the guest cannot write to the vmdk file. The delta disk is an additional vmdk file to which the guest
is allowed to write. The delta disk represents the difference between the current state of the virtual disk and
the state that existed at the time the previous snapshot was taken. If more than one snapshot exists, delta disks
can represent the difference (or delta) between each snapshot. For example, a snapshot can be taken, and then
the guest could write to every single block of the virtual disk, causing the delta disk to grow as large as the
entire virtual disk.
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When a snapshot is deleted, the changes between snapshots and previous disk states are merged, and all the
data from the delta disk that contains the information about the deleted snapshot is written to the parent disk
and merges with the base disk only when you choose to do so. This can involve a large amount of disk input
and output. This may reduce the virtual machine performance until consolidation is complete.

The amount of time it takes to commit or delete snapshots depends on how much data the guest operating
system has written to the virtual disks since the last snapshot was taken. The required time is directly
proportional to the amount of data (committed or deleted) and the amount of RAM allocated to the virtual
machine.

For additional information about snapshot behavior, see the Knowledge Base article at 
http://kb.vmware.com/kb/1015180.

Relationship Between Snapshots
The relationship between snapshots is like that of a parent to a child. In the linear process, each snapshot has
one parent snapshot and one child snapshot, except for the last snapshot, which has no children snapshots.

The snapshots taken form a tree. Each time you revert and take another, a branch (child snapshot) is formed.

In the snapshot tree, each snapshot has one parent, but one snapshot might have more than one child. Many
snapshots have no children.

You can revert to a parent snapshot or a child snapshot.

Snapshots and Other Activity in the Virtual Machine
When you take a snapshot, other activity going on in the virtual machine might affect the snapshot process
when you revert to that snapshot.

The best time to take a snapshot is when no applications in the virtual machine are communicating with other
computers. The potential for problems is greatest if the virtual machine is communicating with another
computer, especially in a production environment.

For example, if you take a snapshot while the virtual machine is downloading a file from a server on the
network, the virtual machine continues downloading the file and communicating its progress to the server. If
you revert to the snapshot, communications between the virtual machine and the server are confused and the
file transfer fails.

Take a Snapshot
You can take a snapshot while a virtual machine is powered on, powered off, or suspended. If you are
suspending a virtual machine, wait until the suspend operation finishes before you take a snapshot.

Prerequisites

If the virtual machine has multiple disks in different disk modes, power off the virtual machine before you
take a snapshot. For example, if you have a special purpose configuration that requires you to use an
independent disk, you must power off the virtual machine before taking a snapshot. This applies only to
snapshots taken with memory.

Procedure

1 Select Inventory > Virtual Machine > Snapshot > Take Snapshot.

2 Type a name for your snapshot.

3 (Optional) Type a description for your snapshot.
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4 (Optional) Select the Snapshot the virtual machine’s memory check box to capture the memory of the
virtual machine.

NOTE   Capturing the virtual machine's memory results in a powered off snapshot, even if the virtual
machine is powered on.

5 (Optional) Select the Quiesce guest file system (Needs VMware Tools installed) check box to pause
running processes on the guest operating system so that file system contents are in a known consistent
state when you take the snapshot.

This step applies only to virtual machines that are powered on.

6 Click OK.

When you take the snapshot it is listed in the Recent Tasks field at the bottom of the vSphere Client.

7 Click the target virtual machine to display tasks and events for this machine or, while the virtual machine
is selected, click the Tasks & Events tab.

Exclude Virtual Disks from Snapshots
Deleting a snapshot involves committing the existing data on the snapshot disk to the parent disk. To exclude
a virtual disk, you change the disk mode to Independent.

Prerequisites

Power off and delete any existing snapshots before you attempt to change the disk mode.

Procedure

1 Select Inventory > Virtual Machine > Edit Settings.

2 Click the Hardware tab and select the hard disk you want to exclude.

3 Under Mode, select Independent.

The state of an independent disk is not affected by snapshots.

NOTE   Any disk, regardless of its type, that is created after you take a snapshot does not appear if you
revert to that snapshot.

You have the following persistence options for an independent disk.

Option Description

Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
4 Click OK.
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Managing Existing Snapshots
You can review all snapshots for the active virtual machine and act on them directly by using the Snapshot
Manager.

The Snapshot Manager window contains the following areas: Snapshot tree, Details region, command buttons,
Navigation region, and a You are here icon.

n Snapshot tree displays all snapshots for the virtual machine.

n You are here icon represents the current and active state of the virtual machine. The You are here icon is
always selected and visible when you open the Snapshot Manager.

You cannot go to or select the You are here state.

n Three command buttons, Go to, Delete, and Delete All present snapshot options.

n Details displays the name and description of the selected snapshot. These text boxes are blank if you do
not select a snapshot.

n Navigation region contains buttons for navigating out of the dialog box:

n Close the Snapshot Manager.

n Help opens the help system.

Restore a Snapshot
You can restore or revert to the state of any snapshot.

Procedure

1 Select Inventory > Virtual Machine > Snapshot > Snapshot Manager.

2 In the Snapshot Manager, click a snapshot to select it.

3 Click the Go to button to restore the virtual machine to any snapshot.

NOTE   Virtual machines running certain kinds of workloads might take several minutes to resume
responsiveness after reverting from a snapshot. This delay can be improved by increasing the guest
memory.

4 Click Yes in the confirmation dialog box.

Delete a Snapshot
You can permanently remove a snapshot from vCenter Server.

Procedure

1 Select Inventory > Virtual Machine > Snapshot > Snapshot Manager.

2 In the Snapshot Manager, select a snapshot by clicking it.

3 Click Delete to permanently remove a snapshot from vCenter Server.

Clicking Delete Allpermanently removes all snapshots from the virtual machine.

NOTE   Delete commits the snapshot data to the parent and removes the selected snapshot. Delete All
commits all the immediate snapshots before the You are here current state to the base disk and removes
all existing snapshots for that virtual machine.

4 Click Yes in the confirmation dialog box.
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Restoring Snapshots
To return a virtual machine to its original state, you can restore a snapshot.

Do one of the following:

Procedure

n The Inventory > Virtual Machine > Snapshot menu contains the command Revert to Snapshot.

n The Snapshot Manager has a Go to button.

Parent Snapshot
The parent snapshot is always the snapshot appearing immediately above the You are here icon in the Snapshot
Manager. The parent snapshot is also the most recently saved version of the current state of the virtual machine.

If you have just taken a snapshot, that stored state is the parent snapshot of the current state (You are here). If
you revert or go to a snapshot, that snapshot becomes the parent of the current state (You are here).

NOTE   The parent snapshot is not always the snapshot you took most recently.

Reverting Snapshots
Reverting snapshots immediately activates the parent snapshot of the current state of the virtual machine.

The current disk and memory states are discarded and restored as they were when you took that snapshot. If
your parent snapshot was taken when the virtual machine was powered off, choosing Snapshot > Revert to
Snapshot moves the powered-on virtual machine to that parent state, that is, to a powered-off state.

If the snapshot was taken while the virtual machine was powered on and the virtual machine settings are set
to revert to snapshot when powering off, the virtual machine moves to a suspended state when it reverts to
the parent snapshot. If the no memory option is set, the virtual machine moves to a suspended state, even if
the revert operation is performed, but not through the powered-off action. If the memory option is set, the
power-off revert action puts VM is suspended state. This process is illustrated in Figure 10-1.

NOTE   Virtual machines running certain kinds of workloads might take several minutes to resume
responsiveness after reverting from a snapshot. This delay may be improved by increasing the guest memory.
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Figure 10-1.  Revert to Snapshot

Virtual machine 
with no snapshots

take a
snapshot

The new snapshot (snapshot_a)
is now the parent snapshot of the 
You are here state. The parent 
snapshot of the You are here state 
is the parent snapshot of the 
virtual machine.

When you take a snapshot from 
the snapshot_a state, snapshot_a 
becomes the parent of the new 
snapshot (snapshot_b) and 
snapshot_b is the parent snapshot 
of the You are here state. 
If you take a snapshot now, the 
new snapshot will be based on 
the snapshot_b state, whose
parent snapshot is the 
snapshot_b state.

When you go to snapshot_a,
snapshot_a becomes the parent 
of the You are here state. 
If you take a snapshot now, the 
new snapshot will be based on 
the snapshot_a state. 

When you revert a virtual machine, the virtual machine returns to the parent snapshot 
of the virtual machine (that is, the parent of the current You are here state).

take a
snapshot

go to
snapshot_a

VM

   You are here

VM

   snapshot_a

      snapshot_b

      You are here

VM

   snapshot_a

      snapshot_b

         You are here

VM

   snapshot_a

      You are here

Revert to Snapshot is a shortcut to the parent snapshot of You are here

NOTE   vApp metadata for virtual machines within vApps does not follow the snapshot semantics for virtual
machine configuration. vApp properties that are deleted, modified, or defined after a snapshot is taken remain
intact (deleted, modified, or defined) after the virtual machine reverts to that snapshot or any prior snapshots.

Revert to Parent Snapshot
You can revert any snapshot to the parent snapshot state.

Procedure

u Select Inventory > Virtual Machine > Snapshot > Revert to Snapshot.

Converting Virtual Disks from Thin to Thick
You can determine whether your virtual disk is in the thin format and, if required, convert it to thick.

For more information on thin provisioning and disk formats, see ESX Configuration Guide or ESXi Configuration
Guide.
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Determine the Disk Format of a Virtual Machine
You can determine whether your virtual disk is in thick or thin format.

Procedure

1 Select the virtual machine in the inventory.

2 Click Edit Settings to display the Virtual Machine Properties dialog box.

3 Click the Hardware tab and select the appropriate hard disk in the Hardware list.

The Disk Provisioning section on the right shows the type of your virtual disk, either Thin or Thick.

4 Click OK.

What to do next

If your virtual disk is in the thin format, you can inflate it to its full size.

Convert a Virtual Disk from Thin to Thick
If you created a virtual disk in the thin format, you can convert it to thick.

The thin provisioned disk starts small and at first, uses just as much storage space as it needs for its initial
operations. After having been converted, the virtual disk grows to its full capacity and occupies the entire
datastore space provisioned to it during the disk’s creation.

Procedure

1 Select the virtual machine in the inventory.

2 Click the Summary tab and, under Resources, double-click the datastore for the virtual machine to open
the Datastore Browser dialog box.

3 Click the virtual machine folder to find the virtual disk file you want to convert. The file has the .vmdk
extension.

4 Right-click the virtual disk file and select Inflate.

The virtual disk in thick format occupies the entire datastore space originally provisioned to it.
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Installing the Microsoft Sysprep Tools A
The Microsoft System Preparation tools enable you to customize Windows guest operating systems.

Using System Preparation tools is especially useful when you clone virtual machines. The guest operating
system customization feature in vCenter Server leverages the functionality of the System Preparation tools.
Ensure that your vCenter Server system meets the following requirements before you customize your virtual
machine’s Windows guest operating systems:

n Install Microsoft System Preparation tools. Microsoft includes the system tool set on the installation CD-
ROM discs for Windows 2000, Windows XP, and Windows 2003. System Preparation tools are built into
the Windows Vista and Windows 2008 operating systems.

n Ensure that the correct versions of the System Preparation tools are installed for each guest operating
system you want to customize.

n Ensure that the password for the local administrator account on the virtual machines is set to blank (““).

NOTE   Customization operations will fail if the correct version of sysprep tools is not found.

This appendix includes the following topics:

n “Install the Microsoft System Preparation Tools from a Microsoft Web Site Download,” on page 153

n “Install the Microsoft Sysprep Tools from the Windows Operating System CD,” on page 154

Install the Microsoft System Preparation Tools from a Microsoft Web
Site Download

You can download and install Microsoft System Preparation tools from the Microsoft Web site.

Ensure you download the correct version for the guest operating system to customize. Microsoft has a different
version of Sysprep for each release and service pack of Windows. You must use the version of Sysprep specific
to the operating system that you are deploying.

Procedure

1 Open a browser window and navigate to the Microsoft Download Center.

2 Navigate to the page that contains the download link to the version of the tools you want.

3 Click Download and save the file to your local disk.

4 Open and expand the .cab file, using a tool such as Winzip.exe or another tool capable of reading Microsoft
CAB files.
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5 Extract the files to the provided directory.

The following System Preparation tools support directories were created during vCenter Server
installation:

C:\ALLUSERSPROFILE\Application Data\Vmware\VMware VirtualCenter\sysprep

...\1.1\

...\2k\

...\xp\ 

...\svr2003\

...\xp-64\

...\svr2003-64\

The ALLUSERSPROFILE is usually \Documents And Settings\All Users\. This is also the location of the
vpxd.cfg file.

Select the subdirectory that corresponds to your operating system.

6 Click OK to expand the files.

After you extract the files from the .cab file, you should see the following files:

...\guest\deptool.chm 

...\guest\readme.txt 

...\guest\setupcl.exe 

...\guest\setupmgr.exe 

...\guest\setupmgx.dll 

...\guest\sysprep.exe 

...\guest\unattend.doc

The guest is 2k, xp, svr2003, xp-64, or svr2003-64.

What to do next

You are now ready to customize a new virtual machine with a supported Windows guest operating system
when you clone an existing virtual machine.

Install the Microsoft Sysprep Tools from the Windows Operating
System CD

You can install the Microsoft Sysprep tools from a CD.

Procedure

1 Insert the Windows operating system CD into the CD-ROM drive (often the D: drive).

2 Locate the DEPLOY.CAB file in the CD directory, \Support\Tools.

3 Open and expand the DEPLOY.CAB file, using a tool such as Winzip.exe or another tool capable of reading
Microsoft CAB files.
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4 Extract the files to the directory appropriate to your Sysprep guest operating system.

The following Sysprep support directories were created during vCenter Server installation:

C:\ALLUSERSPROFILE\Application Data\Vmware\VMware VirtualCenter\sysprep

...\1.1\ 

...\2k\ 

...\xp\ 

...\svr2003\

...\xp-64\

...\svr2003-64\

The ALLUSERSPROFILE is usually \Documents And Settings\All Users\. This is also the location of the
vpxd.cfg file.

Select the subdirectory that corresponds to your operating system.

5 Click OK to expand the files.

After you extract the files from the .cab file, you should see the following files:

...\guest\deptool.chm 

...\guest\readme.txt 

...\guest\setupcl.exe 

...\guest\setupmgr.exe 

...\guest\setupmgx.dll 

...\guest\sysprep.exe 

...\guest\unattend.doc

The guest is 2k, xp, svr2003, xp-64, or svr2003-64.

6 Repeat this procedure to extract Sysprep files for each of the Windows guest operating systems that you
plan to customize using vCenter Server.

What to do next

You are now ready to customize a new virtual machine with a supported Windows guest operating system
when you clone an existing virtual machine.
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Required Privileges for Common
Tasks B

Many tasks require permissions on more than one object in the inventory. You can review the privileges
required to perform the tasks and, where applicable, the appropriate sample roles.

Table B-1 lists common tasks that require more than one privilege. You can use the Applicable Roles on the
inventory objects to grant permission to perform these tasks, or you can create your own roles with the
equivalent required privileges.

Table B-1.  Required Privileges for Common Tasks

Task Required Privileges Applicable Role

Create a virtual machine On the destination folder or datacenter:
n Virtual Machine.Inventory.Create
n Virtual Machine.Configuration.Add New Disk (if

creating a new virtual disk)
n Virtual Machine .Configuration.Add Existing Disk

(if using an existing virtual disk)
n Virtual Machine.Configuration.Raw Device (if using

a RDM or SCSI pass-through device)

Virtual Machine
Administrator

On the destination host, cluster, or resource pool:
Resource.Assign Virtual Machine to Resource Pool

Virtual Machine
Administrator

On the destination datastore or folder containing a
datastore:
Datastore.Allocate Space

Datastore Consumer or
Virtual Machine
Administrator

On the network that the virtual machine will be assigned
to:
Network.Assign Network

Network Consumer or
Virtual Machine
Administrator

Deploy a virtual machine
from a template

On the destination folder or datacenter:
n Virtual Machine.Inventory.Create
n Virtual Machine.Configuration.Add New Disk

Virtual Machine
Administrator

On a template or folder of templates:
Virtual Machine.Provisioning.Deploy Template

Virtual Machine
Administrator

On the destination host, cluster or resource pool:
Resource.Assign Virtual.Machine to Resource Pool

Virtual Machine
Administrator

On the destination datastore or folder of datastores:
Datastore.Allocate Space

Datastore Consumer or
Virtual Machine
Administrator

On the network that the virtual machine will be assigned
to:
Network.Assign Network

Network Consumer or
Virtual Machine
Administrator
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Table B-1.  Required Privileges for Common Tasks (Continued)

Task Required Privileges Applicable Role

Take a virtual machine
snapshot

On the virtual machine or a folder of virtual machines:
Virtual Machine.State.Create Snapshot

Virtual Machine Power User
or Virtual Machine
Administrator

On the destination datastore or folder of datastores:
Datastore.Allocate Space

Datastore Consumer or
Virtual Machine
Administrator

Move a virtual machine into a
resource pool

On the virtual machine or folder of virtual machines:
n Resource.Assign Virtual Machine to Resource Pool
n Virtual Machine.Inventory.Move

Virtual Machine
Administrator

On the destination resource pool:
Resource.Assign Virtual Machine to Resource Pool

Virtual Machine
Administrator

Install a guest operating
system on a virtual machine

On the virtual machine or folder of virtual machines:
n Virtual Machine.Interaction.Answer Question
n Virtual Machine.Interaction.Console Interaction
n Virtual Machine.Interaction.Device Connection
n Virtual Machine.Interaction.Power Off
n Virtual Machine.Interaction.Power On
n Virtual Machine.Interaction.Reset
n Virtual Machine.Interaction.Configure CD Media (if

installing from a CD)
n Virtual Machine.Interaction.Configure Floppy

Media (if installing from a floppy disk)
n Virtual Machine.Interaction.Tools Install

Virtual Machine Power User
or Virtual Machine
Administrator

On a datastore containing the installation media ISO
image:
Datastore.Browse Datastore (if installing from an ISO
image on a datastore)

Virtual Machine Power User
or Virtual Machine
Administrator

Migrate a virtual machine
with vMotion

On the virtual machine or folder of virtual machines:
n Resource.Migrate
n Resource.Assign Virtual Machine to Resource Pool

(if destination is a different resource pool from the
source)

Datacenter Administrator or
Resource Pool Administrator
or Virtual Machine
Administrator

On the destination host, cluster, or resource pool (if
different from the source):
Resource.Assign Virtual Machine to Resource Pool

Datacenter Administrator or
Resource Pool Administrator
or Virtual Machine
Administrator

Cold migrate (relocate) a
virtual machine

On the virtual machine or folder of virtual machines:
n Resource.Relocate
n Resource.Assign Virtual Machine to Resource Pool

(if destination is a different resource pool from the
source)

Datacenter Administrator or
Resource Pool Administrator
or Virtual Machine
Administrator

On the destination host, cluster, or resource pool (if
different from the source):
Resource.Assign Virtual Machine to Resource Pool

Datacenter Administrator or
Resource Pool Administrator
or Virtual Machine
Administrator

On the destination datastore (if different from the source):
Datastore.Allocate Space

Datastore Consumer or
Virtual Machine
Administrator

Migrate a Virtual Machine
with Storage vMotion

On the virtual machine or folder of virtual machines:
Resource.Migrate

Datacenter Administrator or
Resource Pool Administrator
or Virtual Machine
Administrator
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Table B-1.  Required Privileges for Common Tasks (Continued)

Task Required Privileges Applicable Role

On the destination datastore:
Datastore.Allocate Space

Datastore Consumer or
Virtual Machine
Administrator

Move a host into a cluster On the host:
Host.Inventory.Add Host to Cluster

Datacenter Administrator or
Virtual Machine
Administrator

On the destination cluster:
Host.Inventory.Add Host to Cluster

Datacenter Administrator or
Virtual Machine
Administrator
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